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QC-4000 LICENSE AGREEMENT
READ THIS DOCUMENT PRIOR TO OPENING ANY PACKAGES

This is a legal agreement between you, the end user, and METRONICS.
By opening this package, you are bound by this agreement.

SOFTWARE LICENSE

1. GRANT OF LICENSE.  METRONICS grants you the right to use one
copy of the QC-4000 with the computer hardware supplied by
METRONICS as one functioning measuring system. Additional
copies of the SOFTWARE may be made and utilized only as training
and off-line programming tool provided, however, that any such copy
is never utilized as software in a measuring system.  The use of any
copy of the software for any purpose other than training of off-line
programming is unlawful and strictly prohibited.

2. COPYRIGHT.  The software and accompanying written material is
owned by METRONICS, and is protected by United States copyright
laws and international treaty provisions.  Therefore, you must treat
the SOFTWARE like any other copyrighted material except that you
may either (a) make one copy of the SOFTWARE solely for backup
or archival purposes, or (b) transfer the SOFTWARE to a single hard
disk provided you keep the original solely for backup or archival
purposes.  You may not copy the written materials accompanying the
SOFTWARE.

3. OTHER RESTRICTIONS.  You may not reverse engineer,
disassemble, decompile, or in any way attempt to circumvent the
protection system incorporated in the SOFTWARE.

4. LIMITATION OF LIABILITY.  In no event shall METRONICS or its
suppliers be liable for any special, incidental, or consequential
damages whatsoever (including without limitation, damages for loss
of business information) arising out of the use or inability to use this
software.
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GETTING STARTED
Welcome to the QC-4000, a powerful PC based measuring tool. It is an
easy to use system, incorporating pull down menus, mouse, and
movable, sizable windows which can be opened and closed as needed.

This manual is divided into several sections and is written to cover basic
QC-4000 functions. Along the way, you might need to know a little more
about DOS or Windows than we can provide you with, so you may be
asked to refer to one of the other User Guides that was shipped with your
system.

CONVENTIONS
The Keyboard

• The keys on your keyboard may not be labeled exactly as
they are in this manual. All key names are shown using
small capital letters. For example, the Control key is
shown as CTRL; the Escape key is shown as ESC.

• Keys are frequently used in combinations or sequences.
For example, SHIFT+ F1 means hold down the SHIFT key
while pressing F1, and  ALT, F, A means to press and
release each of these keys in order: first ALT, then F, and
then A.

• Arrow keys is the collective name for the UP ARROW,
DOWN ARROW, LEFT ARROW, and RIGHT ARROW keys.

• To choose a command from a menu, you can use the
mouse or press a key combination. In procedures, key
sequences follow the menu and command names. For
example: From the File menu, choose Open (ALT, F, O).
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STARTING THE QC-4000
The QC-4000 is installed at the factory. However, there are several ways
to start the QC-4000 to the system. Your system may be set up so that
the QC-4000 will automatically appear on your screen as soon as you
turn your system on. If it is, you may skip this section and continue to
"Getting Around the QC-4000".

The following is the most recommended way to boot the QC-4000.

From DOS:

* Your DOS prompt will look like this: C:\>_

* Type: win after the DOS prompt, then press ENTER.

(Typing win after the DOS will bring up Microsoft Windows.)

From Microsoft Windows:

* Once in Windows you will see the QC-4000 Icon.

* Start the QC-4000 simply by double-clicking on the Icon, or click on
the icon one time to select it and choose "Open" from the FILE menu.
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GETTING AROUND THE QC-4000
There are different methods to give commands or move around in the
QC-4000. One method is with the mouse. Another is with the keyboard.
After becoming familiar with the QC-4000 you might want to use a
combination of both the mouse and keyboard commands.

Using the Mouse
The mouse is a tool used for pointing to parts of the screen. Moving the
mouse around on your desk, moves the pointer, but does not execute a
command until you depress one of the mouse buttons.

To give the QC-4000 a command, you must point the mouse at the
information and click, double-click, or drag the pointer.

* Clicking - Press the LEFT mouse button once.

* Double-Clicking - Press the LEFT mouse button twice quickly.

* Dragging - Hold down the LEFT mouse button while
moving the Mouse.

Using the keyboard
Commands may also be executed via the keyboard. Notice that the
menus have one letter in each word underlined.

* Holding down the ALT key on the keyboard and pressing the
underlined letter will open up a pull down menu.

* Once the menu is opened, depress the letter that is underlined in
the pull down menu. You do not have to hold the ALT key in the pull
down menu.

* You can also use the down arrow key to highlight the command you
wish to open, then press ENTER.

Note: The keyboard command keys will appear inside parentheses ( ) at
the end of a mouse command.
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QC-4000 BASICS
If you are familiar with Windows, feel free to go on to Chapter 2.

When the screen appears, most of the windows in the QC-4000 will be
opened. See Figure below. Your window setup may look somewhat
different from the following picture. This will be due to the options that you
might have. For example, if your QC-4000 does not have the Edge
Detector Option, your menu bar will not have PROBE as one of the Menu
Titles in the menu Bar.

QC-4000 Screen - Figure 1 - 1



Chapter 1 Getting Started

1-5

The following section will introduce the parts and features of the QC-4000
screen. You can also customize your windows setup using these
elements, which will be explained later in the manual.

* The Control-menu box resides in the upper-left corner of each
window. The Control menu (also called the System Menu) is generally
used if you prefer to use your keyboard to move, resize, maximize,
minimize, and close windows. Since you can accomplish all these
functions by clicking and dragging your mouse, we suggest you use the
Control menu box only as a fast way to close any window by double-
clicking on it.

You may notice that the Control Menu bars are two different sizes. This
is for the keyboard users to differentiate between them. The larger of
the bars can be opened by holding down the ALT key and pressing the
spacebar. The smaller bar is opened by holding down the ALT key and
pressing the (-) minus key.

* The Title Bar is always located on the top of the window. It's not only
where the QC-4000 name resides, it is also where the name of your
session will be placed. When you Save and name your session it will
appear in the Title Bar after the QC-4000 heading.

* The Maximize and Minimize buttons are the small up and down
arrows at the right hand corner of the title bar. They enlarge the active
application window to fill the entire desktop or shrink the window to an
icon. The application icon will appear on the lower portion of your
desktop. It can be reopened by double-clicking on the icon or by
clicking on the icon once, and choosing Restore or Maximize. After you
enlarge a window, the Maximize button changes to a Restore button.
You can use the Restore button to return the window to its previous
size.

* The Menu bar lists the available menus. Most applications have a File,
Edit and Help menu. Because the QC-4000 is capable of having
several options, you will also have unique menus that will apply to the
options you have in your system.
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* Scroll bars let you view unseen portions of lists and other information
that is too large to fit in the allotted space. (The Results Window will
only have scroll bars when more that one feature from the Feature List
is selected.)

* The window border is the outside edge of a window. You can lengthen
or shorten each side of a window by dragging a border.

* The window corner can be used to shorten or lengthen two sides of a
window at the same time by dragging the corner.

Opening a QC-4000 Window
Opening a window is accomplished through the Windows Menu. There is
an exception of course; this being the Results Window. The Results
Window will open automatically after a measurement or by Double-
Clicking on an existing feature in the feature list.

1. Select Windows from menu bar by left 
clicking on WINDOWS. (ALT, W) Notice 
that the pull-down menu does not have a 
check mark on the closed windows.

2. Left mouse click on the window name 
you wish to open. (D,T,S,P,F,R, or G)

Once the menu is open, you can also use the
arrow keys to highlight the window you wish
to open, then press ENTER.

This will place a check mark next to the word
and open that window.

Note: Features must appear on the feature list to open the Results
Window via the Double-clicking method.
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Closing a Window
When you are working with the QC-4000, there may be times that you will
not need all the windows appearing at one time. The QC-4000 allows you
to close all or selected windows to give you more work space.

Like most elements in the QC-4000 or Windows for that matter, there are
several methods for doing the same thing. In this section, we'll walk you
through the different methods for closing a window. These same
"Methods" can be used for all the windows within the QC-4000.

1. Select WINDOWS from menu bar (ALT, W).
Notice that the pull-down menu has a 
check mark on all open windows.

2. Left mouse click on the window name you 
wish to close (D, T, S, P, F, R, or G).

This will remove the check mark next to the
word and close that window.

Using the Control-menu box in the window

1a. Click on the Control-menu box which 
resides in the upper-left corner of a 
window (ALT, -). This will open a pull-
down menu.

1b. Move the mouse pointer down to 
CLOSE in the menu and left click on 
the mouse button. (C)

============================
2a. Choose ALT, F4

==========================

3a Last but not least Double-click on the
Control-Menu Bar. (You might find 
this the fastest and easiest way).



Chapter 1 Getting Started

1-8

SIZING THE QC-4000 WINDOWS
The windows within the QC-4000 default to a certain position. Sometimes
you might want to change the size and shape of the windows to suit your
needs. For example, you may want to enlarge your part view and make
your feature list smaller. You also might want to make these changes
only temporary or change the default so that the windows will open in the
same position whenever you turn the QC-4000 on.

Note: Some windows are limited in the ways their size can be changed.
For example, the Results Window will shrink down to approximately 1.5
inches by 4 inches. The toolbox cannot be enlarged or sized, it can only
rearrange its shape depending on how many tools are in it.

To change to size of a window

1. Left-click once to select the window you wish to resize.

2. Point to a border or corner that you want to move. The
pointer will change to a two-headed arrow.

3. Hold down the left mouse button and drag the corner or
border until the window is the size you want.

If you drag a border, the window size will only change the side you drag.
If you drag a corner, the two adjoining sides that form the corner will
change size at the same time.
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Repositioning a Window
When you first open the QC-4000, you will notice that the windows have
been defaulted to a certain position. If these position do not suit your
needs, you can easily customize the QC-4000 by moving and resizing the
individual windows to best suit your needs.

Repositioning a window is just as easy as sizing.

1. Place the mouse arrow over the "Title Bar".

2. Hold down the left mouse button.

3. While still holding the mouse button down, drag the window to
the desired position.

4. Release the mouse button.

Note: When repositioning a window, only the frame of the window will
appear to move. After the mouse button is released, the window will
move into the same position as the frame. ( See figure 1-2)

Figure 1 - 2

When you are finished sizing and repositioning your windows, you can
save this as the default by choosing "Save Session" from the FILE menu.
Choosing YES while exiting the QC-4000 will also save the appearance.
Refer to "Quitting the QC-4000" for more information.
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Shrinking the QC-4000 to an Icon
You can shrink the QC-4000 to an icon when have completed a session,
but want it available for later use. When you shrink the QC-4000 to an
icon, the application is still running in memory, but its window will not take
up space of your desktop.

Note:  Only one copy of the QC-4000 can be run at a time. If you try to
open another QC-4000, a message will appear indicating that a QC-4000
program is already running.

To shrink the QC-4000 to an Icon (Mouse)

1. Click the Minimize button in the upper-right corner of the 
window.

Minimize button

To shrink the QC-4000 to an Icon (Keyboard)

1. Press ALT, SPACEBAR. This will open up a pull-down menu.

2. Using the down arrow. select Minimize and press ENTER, or 
press the N on the keyboard.
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Enlarging a window
Enlarging the windows will fill a large portion of the screen, and cover all
other windows. Don't be alarmed however, when you restore your window
to it's original size, your other windows will still be there.

To enlarge a window (Maximize) (Mouse)

1. Select the window you wish to enlarge.

2. Click the Maximize button (up arrow) in the upper-right corner 
of the window.

Maximize Button

To enlarge a window (Maximize) (Keyboard)

1. Press ALT, SPACEBAR. This will open up a pull-down menu.

2. Using the down arrow. select Maximize and press ENTER, or 
press the x on the keyboard.
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Restoring an Icon or Window

To Restore the QC-4000 Icon (Mouse)

1. Double-click on the QC-4000 Icon. Or click on the Icon one 
time, then select Restore.

To Restore the QC-4000 Icon (Keyboard)

1. Press CTRL, ESC. This will bring up a "Task List".

2. Using the down arrow, Select the QC-4000.

3. Use the TAB key until "Switch to" is highlighted.

4. Press ENTER or ALT S. This will "Restore" the QC-4000 to
its previous size.

To Restore the QC-4000 to its previous size 

Once the window is enlarged or maximized, the single up arrow will
change to a double arrow. The double arrow is now called the "Restore"
button. When the Restore button is displayed, you cannot move or size
the QC-4000 Window.

1. Click on the "Restore" button. This will restore the window
back to a previous sizable window.

Note: The procedure for sizing, moving and closing windows within the
QC-4000 is the same as the procedure for Windows itself. If you feel you
need more information on sizing, moving, or closing, please refer to the
"Windows" manual.
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QUITTING THE QC-4000
When you are finished working with the QC-4000, the user has the
choice of "Exiting to Windows", or "Shut Down".

EXIT TO WINDOWS - will bring the user to the Windows 
Program Manager.

SHUT DOWN - will close the QC-4000 and Windows and will
place you in DOS.

No matter which one you choose, you will always be asked to confirm
your request to quit. It also asks if you would like to "Save Session". If
you press "Yes" the QC-4000 will save any changes made to the session
before switching to the Windows Program Manager. If you choose "Shut
Down", it will also ask if you want to "Save" any other windows
applications that might be running in addition to the QC-4000.

To QUIT the QC-4000 (Mouse)

1. Left click on the FILE menu.

2. Left click on Exit to Windows or Shut Down.

To QUIT the QC-4000 (Keyboard)

1. Press ALT F to open the pull-down menu.

2. Select (x) to Exit to Windows or (h) to Shut Down. You can
also use the down arrow key to highlight Exit to Windows or
Shut down, then press ENTER.

Choosing YES will save any changes in your session and all locations
and sizes of your QC-4000 Windows. Choose NO if you do not want to
save changes. If you choose "Shut Down" you will be asked to "Save
Changes to session" then you will be asked to "Save changes" to any
other Windows applications you may have opened.
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THE QC-4000 SCREEN
This section is probably the most important one in this manual since it
explains the basic concepts and skills you need to work with the QC-4000
successfully. This chapter teaches the essentials of Operating the QC-
4000 and what each item means. You can return to it later as a
reference.

When the screen appears, most of the windows in the QC-4000 will be
opened. Your window setup may look somewhat different from the
picture. This will be due to the options that you might have. For example,
if your QC-4000 has the Edge Detector Option, your menu bar will have
PROBE as one of the selections in your menu.

Note: The Program View window, will only open if selected.

Figure 2 - 1
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STATUS BAR
When visible, the Status Bar will always appear at the top of the screen
under the Title Bar. The information on the status bar will always include
the time, date, unit of measure (in/mm), and coordinates
(Polar/Cartesian)

The Unit of measure and Coordinates are toggles. Each time these
commands are selected, they will toggle between Inch and Millimeter or
Cartesian and Polar.

Figure 2 - 2

Other commands that may appear on the Status Bar are associated with
QC-4000 Options. Since these buttons are menu shortcuts, please feel
free to click and play.

The Title Bar

Figure 2 - 3

The Title Bar is always located on the top of the window. This is where
the QC-4000 name resides. When you perform a "Save Session As"
command the name of your session will be placed after "QC-4000."



Chapter 2 The QC-4000 Screen

2-3

To perform a Save Session As Command

1. Using the Keyboard or mouse, select FILE from the menu.
2. Choose the "Save Session As" command. The following screen

appears.
 

Figure 2 - 4

3. Select a drive if necessary, then type the name you wish to call the
session. For example, this one will be named (DEMO).

4. Press OK or ENTER.  DEMO is now placed in the Title Bar.
 

Figure 2 - 5
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The MENU Bar
The QC-4000 Menu Bar consists of several different menu names. File,
Edit, Measure, Datum, Windows and View are some examples of what
you might find in your menu bar. Different menu items will appear if you
have purchased a separate option such as the Edge Detection option.

As you operate the QC-4000, you will get to know these quite well. The
menus can be opened by clicking on the left mouse button, or by holding
the ALT key and depressing the Underlined letter from the keyboard.

If you look at the pull down menus, you will notice that some commands
are dimmed, some have ellipses(...), and others have check marks,
arrows or key combinations listed next to them. The following information,
will explain conventions of the menus and what they mean.

Menu Conventions
Dimmed command name - The command is not available at this time.
You might have to select a feature before you can use the command. It
might also be that the command cannot be used with your application, or
can not be executed in a certain mode.

An ellipsis (...) after the name - A dialog box will appear when the
command is chosen. This dialog box will give information and/or ask for
information to complete a function or command.

A Check Mark ( ) next to the name - The command is active. It also
indicates that the command is a toggle and will toggle between one state
or the other.

A key combination after the name - Use the key combination as a
shortcut without opening the menu first. The shortcut could be a
combination of keypress or the use of a Function key.
A triangle at the right side of a menu command - The triangle means
there is an additional cascading menu that lists other commands or
functions.
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The Menus
As mentioned before, each item in the menu bar consists of a pull down
menu. It also helps identify what will be in the pull down menu. For
example, if you were to open the MEASURE menu, a list of all
measurement functions allowed will appear in the pull down menu. If you
opened the WINDOWS menu you will be able to access each window
available in the QC-4000 and so on.

The following information gives a brief explanation of all menus. More
information about these commands is explained later in the manual.
Since File is first in the menu item, we will discuss the commands under
the File menu.

FILE MENU
∗  About - This allows the user to view such things as system settings,

the version of QC-4000 software, and the installed options if any.

∗  The �About Program� Command - In the QC-4000 it is possible to
view the current program data of a saved program in the Edit mode.
Information such as File size, Number of Steps and Total Path Length
will be displayed when the About Program command is select from
the File menu. This information is very useful when adding or deleting
program steps, or Optimizing your path.

∗  New Session - When you select this, a prompt appears. If you select
YES, the QC-4000 deletes all your features, sets the Datum to
machine coordinates, and opens a New Session. If you select NO,
you will be backed out of the New Session command.

∗  Open Session - A prompt will appear asking "Save Changes to
Session? Yes/No/Cancel. If Yes is selected, then your session will
automatically be saved and a list of previous sessions will appear.
Type in the name of the session you wish to open using .ses at the
end then click "OK" or double-click on the session you wish to open.

∗  Save Session - This will save changes to the current session

∗  Save Session As - This will name an UNTITLED session or duplicate
a previously named session under a new name. Choosing the "Save
as" command, will create a new session with changes and
modifications but will not automatically save the old session.



Chapter 2 The QC-4000 Screen

2-6

∗  Import From DXF - This allows the user to transfer a CAD drawing
from Auto Cad programs, import them into the QC-4000 and from the
CAD drawing, create a part program.

∗  Export To DXF - Allows the user to measure a part and export the
measurement data to a DXF File, thus creating a CAD drawing from
the QC-4000.

∗  SPC Link - This is an SPC "Option" used to send data to the Quality
America SPC software package. This can also be used to export data
to other software packages such as Microsoft® Excel�.

∗  Print Selected Features - Select this to print the features you have
selected from the Feature List or Part View. If only one feature is
selected, that feature name will appear on the menu.

∗  Print Part View - Selecting this will Print the part view. It will only print
what is seen in the part view. It is advised to "Zoom to Fit" if you wish
to print the whole part.

∗  Report Header - Choose this to setup the header you wish to print
before your report.

∗  Report - Launches the Report Wizard function.

∗  Preferences - Allows you to configure and customize certain
functions of your system. Your dealer has step up the options in this
function necessary for your system to work correctly. You should get
to know your system well before using this function.

∗  Supervisor Setup - This allows your dealer to configure your system.
These configurations are set at the factory or by your dealer. Once
set, these options should not be changed.

∗  Exit to Windows - This Exits you from QC-4000 into Windows. A
prompt appears, asking the user to SAVE Session - YES/NO or
CANCEL.

∗  Shutdown - This exits you out of the QC-4000 to DOS.
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EDIT MENU

∗  Cut Selected Features - This function is used in programming and
transferring information to other applications. When selected,
information will be Cut or removed from the part view or feature list
before transferring. More information can be found later in the
manual.

∗  Copy Selected Features - This function is also used in programming
and transferring information to other applications. When selected,
information will be copied from the part view or feature list, leaving the
original data in its place. More information can be found later in the
manual.

∗  Paste - This function is used in programming and/or transferring
information from other applications. More information can be found
later in the manual.

∗  Select All Features - Selects all features contained in the feature list
and part view.

∗  Deselect All Features - Deselects features from the feature list and
part view.

∗  Find Feature - Prompts you to type in the feature name you wish to
find. Press Find. That feature will be highlighted in the Feature List
and Selected on the Part View.

∗  Find Feature also uses an asterisk () as a wild card to find multiple
common features. For example, if you wanted to find and select all
circle features, you would type C when prompted. This will highlight all
the circle features within the part view and feature list.

∗  Delete Selected Features - Deletes the features selected. If only one
feature is selected, the menu will read "Delete Circle 1" for example.
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MEASURE MENU

∗  Measure Magic - The Measure Magic function allows the operator to
simply enter points into the function and as a result of various rules,
will automatically create the correct geometric feature. It is enabled by
selecting the Magician's Hat on the toolbox. Single clicking the right
mouse button to enter a point and then again double-clicking the right
mouse button to end your measurement.

∗  Point - Enables the POINT measurement function

∗  Line - Enables the LINE measurement function

∗  Circle - Enables the CIRCLE measurement function

∗  Arc - Enables the ARC measurement function

∗  Height - Enables the HEIGHT measurement function. This will
only appear if Z axis is present.

∗  Distance - Enables the DISTANCE measurement function

∗  Angle - Enables the ANGLE measurement function

∗  Create - This function allows you to create features by typing the
Nominals of Points, Lines, Circles and Arcs. Once a feature is
selected, a screen will appear to enter information needed to create
the feature.

∗  Units - Allows you to choose the unit type you wish to measure in.
Includes:

Inch
MM
Cartesian
Polar

DATUM MENU
∗  Probe Frame - Allows you to perform part alignment by targeting

points on 2 intersecting lines, using at least 2 points per line, resulting
in a Skew line and a 0,0 reference at the intersection.

∗  Set Machine Zero - A prompt will appear, "GOTO" your machine zero
point and press OK. This will set a machine zero. This is necessary
under certain conditions such as, NLEC, CNC, or using programs with
fixtured parts.
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∗  Zero - Allows you to set a Zero Datum. If "Use Machine" is pressed,
the current zero will be cleared, and the word "Machine" will appear
after Zero. If you choose to zero on a feature, the Datum menu will
appear as Zero  |(Feature type) and will create a Zero Point feature on
the feature list.

∗  Skew - Enables you to skew a part. This can be done by probing or
constructing. If the "Use machine" button is pressed, then any  current
skew will be cleared, and the X and Y axis will be set back to the
machine axes.

∗  Level - Levels the part, enabling accurate height measurements for
systems equipped with a Z axis.

PROBE MENU
Note: The PROBE menu is only visible if you have the Optical Edge

Option.

∗  Crosshair - Places the QC-4000 in crosshair mode. In this mode, the
display is updated continuously. To target a point in crosshair mode,
you must place the crosshair on the edge you wish to target and press
Enter Pt.

∗  Edge - Selecting EDGE will turn on the Edge Detector. In this mode,
the display is updated and a "Beep" is generated after every edge
crossing. An edge crossing occurs when the light sensor crosses from
a light area to a dark area, or from dark to light. This mode facilitates
easy targeting of points that lie on shadow boundaries.

NOTE: If "Force Teach" is not defaulted, a Teach must be performed
before using the Edge Detector.

∗  Auto Confirm - There are two targeting modes available for Edge
Detector, "Auto" mode and "Manual" mode. When Auto Confirm is
selected, it will automatically confirm an edge crossing. In other
words, the crossing is automatically accepted and entered into a
feature measurement without the user pressing Enter Pt each time an
edge is crossed.

If Auto Confirm is off, the QC-4000 will "beep" at an edge crossing, but
the user must enter every point manually by pressing Enter Pt.
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∗  Light Levels - This is used to check the light intensities of the Screen
and Reference fibers of the Edge Detector. The numbers tell how
much light is coming from each sensor. The values range from 0 (not
enough light) to 12 (too much light.) More information about the light
levels can be found in the edge detector section of this manual.

∗  Teach - The Edge Detector needs to know what light intensity levels
to expect for both light and dark on your system's screen. Choosing
the TEACH function will instruct the user to calibrate the Edge
Detector. The following prompts appear - "Move the Edge Sensor into
a Dark area on the screen and then press OK." After the user follows
this instruction and presses "OK", a new prompt will appear. "Move
the Edge Sensor into a light area on the screen and then press OK."
The Edge Detector now knows the difference between light and dark
on your systems screen. This calibration should be repeated every
time you turn on the QC-4000 or change your magnification.

∗  Teach to Master  - This operation fine tunes your Edge Detector to
properly read the "fuzzy" non-distinct edges. Please refer to the Edge
Detector Section for more information.

∗  New Calibration - When you switch back and forth between
Crosshairs and Edge Detector or change the magnification of your
system, the QC-4000 must be calibrated. "New Calibration" allows up
to nine individual calibration setups to be created.

 Each name can consist of up to 9 characters. After they are created, they
will appear in the menu as individual selections. An operator can
easily change magnification, and select the corresponding calibration
setup without having to go through the calibration procedure again.
Please refer to the Calibration section of the manual for more
information.

∗  Edit Calibration - Once you have your calibrations set, you may want
to change the name or delete a certain calibration setup from the
menu. These modifications can be done by selecting "Edit
Calibration". More information can be found in the Calibration section.

∗  C1 Default Calibration - When you first turn on your system, you will
notice that the first calibration is already present. C1 stands for
Calibration one. In other words, the first calibration setup. Up to nine
individual Calibrations can be created. They will be listed as C1 to C9.
Please refer to the Calibration section of the manual.
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WINDOWS MENU
The windows menu is a way of opening and closing the individual
windows within the QC-4000. The QC-4000 contains seven informational
windows that can be on the screen simultaneously. All windows are
moveable, sizable and closeable. The viewing of these windows can be
controlled under the windows menu. The window menu consists of the
DRO, Toolbox, Status Bar, Part View, Feature List, Results Window, and
Program View. A check mark next to the window in the menu indicates
the window is opened.

∗  DRO - The DRO window is a window that consists of a live digital
readout of the X and Y axis. Next to the X and Y axis display, you see
an X and Y button. Placing your mouse pointer over the X or Y
buttons and left clicking the mouse button will zero the X and/or Y at
the location of the position indicator. If your system is configured with
a third or fourth axis, the DRO will include a Z and Q axis display.

∗  Toolbox - The Toolbox consists of icons that represent the basic
measuring functions, as well as other possible functions and
commands. Clicking on a Toolbox Icon, will initiate that measurement
function.

∗  Status Bar  - The Status Bar contains the time, date, unit of measure
(in/mm) and coordinates (Polar/Cartesian). Other options that appear
on the status bar are menu shortcuts.

∗  Part View - The Part View Window is not only movable, sizable and
closable, it is also scrollable. The Part view on the QC-4000 is the
graphical representation of the part being measured. In essence, it is
the graphical display of all the displayable objects within the feature
list.

∗  Feature List - The Feature List is where the measured, created or
constructed features will be placed after an application is completed.
The Feature list can be used to select features located in the part
view.

∗  Results Window - The Results Window is where you'll find individual
numeric details about a given feature. The Results Window will open
automatically when measuring or constructing features. The Results
window also contains two pull-down menus. One to activate
"Tolerancing", and the other is "Change."

∗  Program View - Selecting this allows the operator to view and/or Edit
steps within a program. Please refer to the programming section.
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VIEW MENU
The Zoom commands are essential to get a close-up look of a particular
feature or Zoom out to view the complete Part view at one time. The
Zoom in and Zoom out commands change the view at 50% increments

Note: Zooming in or out does not effect the way your part view will print.

∗  Zoom In - When activated, it will incrementally make the features in
the part view appear larger.

∗  Zoom Out - This allows you to incrementally zoom out (make smaller)
all the features within the part view.

∗  Zoom to Fit - Returns the part view to its original 1 to 1 view.

∗  Zoom In On Area - When this is selected, the mouse pointer will
transform into a magnifying glass. While holding down the left mouse
button, "Drag" the mouse around the feature or features you wish to
zoom in on. Once the area is completely enclosed within the box,
(marquee) release the mouse button. The part view will now zoom in
on the area that you selected. (See Part View - Chapter 3)

∗  Zoom to "Selected Features" - This is used to make "Selected"
features appear larger.

∗  Center on Position Indicator - The position indicator is the colored
crosshair, Rectangle, or Circle that appears in your part view, to show
the current position of your stage. If your indicator disappears from the
field of view because of stage movement, selecting the "Center on
position indicator" automatically places the position indicator in the
center of the part view.

∗  Record Zoom - Inserting this command into a program after
completing a zoom, will store the zoom into the program. Zooming is
not a required function for running a program. This command is a
visual aid for the operator.

Auto Zoom Enabled - If a part is properly aligned when running a
program the part view window will be zoomed to fit all the features
when the program is run, and no zooming will take place without the
Record Zoom function.

Auto Zoom Disabled - If "Record Zoom" is used to zoom on a
selected feature when auto zoom is disabled, then the user must use
another record zoom to restore the part view to its original state.
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∗  Show Hidden Features - This function will show any feature that has
been defaulted or changed to invisible. Show hidden features acts as
a toggle. If selected, hidden features will always be visible.

∗  Show Feature Names - When selected, "Show Feature Name"
places the name of the features shown in the feature list next to all the
features in the part view. This is a toggle and when deselected, will
remove all the names from the part view.

Note: If "Show name" is selected from the "CHANGE" button, then the
feature name will appear for that feature, even when "Show hidden
features" is deselected.

∗  Show Position Indicator - As you may know by now, the position
indicator is the colored crosshair, Rectangle, or Circle that appears in
your part view. There may be times that you will not want the Position
Indicator to show (Print Part View). Deselecting "Show Position
Indicator" will temporarily remove the Indicator from the Part View.

∗  Refresh Part View - Also known as "Clean Up". Some complex parts
that have invisible features can result in the part view looking
incorrect. Selecting "Refresh Part View" will Redraw all the features in
the part view correctly. This also can be accomplished by closing or
resizing the window.

PROGRAM MENU
The PROGRAM menu is unlike the other menus, in that different menu
selections will appear as the user enters different modes of
programming. The following, lists all program menus and the mode the
user must be in for the selection to appear. The mode will appear in
{brackets} and will indicate if the selection will appear {Prior} to recording
a program, {During} a programming session, {After} programming or
while {Editing} a program.

∗  Record New {Prior} - Prompts the user to name the program, and
initiates the programming sequence.

∗  Record Into "Program Name" {Editing} - It allows the user to Edit
program steps into a previously recorded program.

∗  Open {Prior} - Allows the operator to open a previously recorded
program.

∗  Save "Program Name"{After} - Allows the user to "Save" changes
made to program.
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∗  Save As {After} - Using the Save As command will allow the user to
create more than one version of a program. The user can take a
previously recorded program, edit it, and save it under a different
name. This will retain the original program, and create a new program
under the given name.

∗  Run {Prior} - The QC-4000 will automatically execute the program
selected by the user.

∗  Run "Program Name" {After} - This menu selection appears after
the operator has "Opened" a previously recorded program. It will
execute that specific program.

∗  Run "Program Name" at selected step {Editing} - This allows the
user to execute a program from a specified point in the program. This
is accomplished by highlighting a specific step on the Program View
Window, then selecting "Run program name at select step".

∗  Auto Program From Features {Prior} - This is an "Advanced User"
command. It allows the user to automatically create a program from
the features in the feature list that have been measured or Imported
and edited. Please refer to programming section for more information.

∗  Edit "Program Step" {Editing} - This will only appear if a Program
View Window is opened. Choosing the EDIT command, will open the
path steps for examination and/or changes. (This can also be done by
Double-Clicking on the Program step). The operator can then delete a
step from the program or relocate a step a by choosing those
commands from the EDIT Menu.

∗  Special Steps {During & Editing} - This menu command contains a
cascading menu that consists of the following:

Delay - Pause a program for a specified number of seconds.

User Message - Inserts an alpha-numeric string that will be
displayed during program execution.

Run DOS/Windows Program - Allows the user to execute a
DOS/Windows program while running a QC-4000 program.

DDE - Enables a DDE Link while executing a QC-4000 program.

Light Control - Allows control of an external light source.
Selecting this will introduce another screen that will allow the
user to adjust the light.
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∗  Close "Program Name" {After} - This command allows the user to
�Close" the current program without saving changes.

∗  Regenerate Features {After} - After Editing a feature into a program,
the new feature will appear at the bottom of the feature list. Choosing
"Regenerate Features" will relocate that feature to its proper place on
the feature list and in the Part View. In other words, it will place the
new feature in the Part View and the feature will appear on the feature
list in the proper sequence for the program to run.

∗  Optimize Path - You�ve heard of the saying �The shortest distance
between two points is a straight line." The Optimize Path function will
rearrange selected program steps so that the distance (path) between
the points to be measured is minimized.

First, the Part View window must be open and Show Path must be
selected from the Program menu. Optimizing your whole part
program may not be necessary. The Show Path command allows the
user to view the program path thus making it easier to decide which
features to select.

Before performing Optimize Path, select About Program from the File
menu. Note the total path length.

1. Select Show Path from the Program menu. (�Show Path� will
appear only if you have CNC or VED options).

2. Select the features you wish to optimize.

3. Select Optimize Path from the Program menu. The message
�Performing Program Path Optimization� will appear.

Figure 2 - 6 (Original Path)

Note: The Path (lines), will appear only if you have CNC or VED options.



Chapter 2 The QC-4000 Screen

2-16

When the Optimization is complete, the program path will be more direct
than before. Once you�ve optimized the path, go back to About Program
and you will notice the total path length is now somewhat smaller.  This
could save a considerable amount of time when running the program.

Figure 2 - 7 (Optimized Path)

 

∗  End Recording.{During} - This command concludes the
programming session.

∗  Pause Program Execution {During}- This command stops or
"Pauses" a program execution, allowing the user to EDIT program
steps or enter messages. To continue execution, choose "Run
program at selected step" from the PROGRAM menu.

This concludes the Fundamentals of the QC-4000. Please continue
reading to learn more exciting facts about your system.
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Chapter Three

The QC-4000 Windows
The Status Bar

The Digital Readout
The Toolbox
Feature List

Results Window
The Change Button

Part View
Program View
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QC-4000 Windows
The QC-4000 contains seven informational windows that can be on the
screen simultaneously. All windows are moveable, sizable and closeable.
The following section will introduce you to all the windows and how they
work.

The Status Bar
When visible, the Status Bar will always appear at the top of the screen
under the Title Bar. The information on the status bar will always include
the time, date, unit of measure (in/mm), and coordinates
(Polar/Cartesian)

The Unit of measure and Coordinates are toggles. Each time these
commands are selected, they will toggle between Inch and Millimeter or
Cartesian and Polar.

Other commands that may appear on the Status Bar are associated
with QC-4000 Options. Since these buttons are menu shortcuts, please
feel free to click and play.

The Digital Readout

The DRO window is a window that consists of a live digital readout of the
X and Y axis. Next to the X and Y axis display, you see an X and Y
button. If your system is configured with a third or fourth axis, then the
DRO will include Z and Q axes display along with Z and Q buttons.

Placing your mouse pointer over the X or Y buttons and clicking on left
mouse button, will zero the X and/or Y at the location of the position
indicator.

In the Crosshair Mode, the display will update continuously, and the
crosshairs are the targeting mechanism.

In the Edge Mode, the display will update after every edge crossing.
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The Toolbox

This section, will introduce the icons found in the Toolbox, along with a
brief description of their use. The measurement function icons work in the
same fashion. For example, Clicking on any measurement icon once, will
bring up that window and enable that particular measurement. Once "OK"
is depressed, the measurement is complete and the window will
disappear. Double-Clicking on an icon will allow "Auto Repeat"
measurements. After you measure a feature and press "OK," the window
will re-initiate on the screen until you press �Cancel�. This allows the user
to keep measuring the like features without the repetitiveness of selecting
the same icon over and over.

Command function such as Zoom or skew are usually performed once;
double-clicking on these icons or will not initiate "Auto Repeat.

NOTE: The toolbox is defaulted with some icons already showing. To add
or remove any icons, you must do so from the Toolbox Maker in the
PREFERENCE menu under FILE. Please refer to Chapter 5
"Customizing the QC-4000."
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Toolbox Icons

Measure Magic
This magical function automatically creates the correct
geometric features simply by entering points. Of course, there
are some simple rules and probing techniques to follow, but
measuring a part will become so fast and easy you'll probably
want to use it most of the time. Double-Clicking on this will
enable auto repeat measurement until the cancel button is
pressed.

Point
Enables the Point measurement function. A Point will appear
on the Part View as a small crosshair.

Line
Enables the Line measurement function. A Line will appear on
the Part View as a solid line. (Normal)

Circle
Enables the Circle measurement function. It will appear on the
Part View as a Normal feature

Arc
Enables the Arc measurement function.

Distance
Enables the Distance Measurement function. Distance will
appear on the Part View as a Phantom with an arrow showing
the direction of measurement.
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Height
Enable the measurement of Height. This is only in a 3 axis.

Angle
Enables the Angle measurement function. An Angle
measurement generates 4 features on the part view and in the
feature list; the angle, the vertex point and the two lines that
were measured to generate the angle.

Units
Pressing the Units Icon will toggle you between Inch and
Millimeter.

Polar/Cartesian
Use this Icon to toggle between the Polar Mode and the
Cartesian Mode.

Zero
This icon allows the user to set a new Datum Point (Zero
Coordinate System).

Skew
Skewing electronically aligns a part to indicate the rotation of
the part's axes relative to the measuring machine's axes. After
the part is skewed, the Header of the DRO will read "Skewed
on Line 2" or whichever line you skewed on, indicating that
alignment has been completed.

Zoom In
This will incrementally zoom in (enlarge) all the features within
the part view.

Zoom Out
This will incrementally zoom out (reduce) all the features within
the part view.
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Center on Position Indicator
The position indicator is the red crosshair that appears on your
part view. If your indicator goes off the page because of stage
movement, selecting the this icon automatically scrolls the part
view to the place of the position indicator.

Zoom to Selected Features
This is used to make "Selected" features appear larger. The
features must be selected on the feature list or from the part
view. If no feature is selected this Option will appear "Gray" on
the menu and toolbox and will not be selectable.

Zoom to Fit
Redraws the features to original size -- 1 to 1.

Zoom in on Area
When Zoom In on area is selected, the mouse pointer appears
as a magnifying glass with a crosshair (+) in the center. There
are 2 methods for using Zoom in.

1. Dragging - Hold down the left mouse button and drag the
magnifying glass around the feature or features in the part
view that you wish to enlarge.

2. Clicking - Place the magnifying glass over the feature in the
part view that you wish to enlarge, then click the left mouse
button.

Teach
Initiates the Edge Detector Teach function. The user will be
prompted to move the edge sensor to the dark and light areas
on the screen and then press "OK." Once the TEACH function
is complete, the Edge Detector will know the difference
between light and dark on your systems screen. The Teach
function should be repeated every time you turn on the QC-
4000 or change your magnification.
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Default Calibration
Using the Default Calibration button (Defa) in the toolbox is
another menu shortcut. Depressing any calibration button will
automatically initiate that calibration setup. Up to nine
individual Calibrations can appear in the Toolbox.

Program Button
After a program is run, you can configure your toolbox with the
program name.

If you have created other programs or calibrations and wish for
them to appear in the Toolbox, you can do so from the
Toolbox Maker under the Preferences menu.

Note: When naming calibrations and programs you should
keep in mind that on the average, only 3½ letters can fit on a
button.  This average is dependent on which letters are used.
Names will be displayed in their entirety on menu, but will be
cropped to fit the buttons in the toolbox

Print Selected Features
This is a menu shortcut for printing selected features.
Depressing this will send selected feature information out to a
printer or computer via the RS-232.

Report
Selecting this from the toolbox will initiate Report Wizard.
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The Feature List

The Feature List is where a list of measured, created, constructed, or
imported features reside. The number in the title bar indicates the
number of features contained in the list.

When a feature is placed on the feature list, it will contain a graphical
representation of the feature type, the feature name and the sequential
number in which it was measured within that session.

Example:
A feature appears in the feature list, as  Circle 1
A feature ID consists of the following:

= A graphical representation of feature type
= The Feature type name
= The sequence in which the feature was measured.

The features that appear in the Feature List, can be used to construct
new features as well as selecting features in the part view.
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Selecting the features from the Feature List:

*  To Select a single feature from the Feature List:
a) Place the mouse pointer over the feature you wish to select.
b) Click the left mouse button once. This will highlight the feature

selected.

*  To select a single feature on the Feature List from the menu.
a) Select "Find Feature" from the EDIT menu.
b) Type in the feature you wish to select.
c) Click on the "Find" button or press Enter on the keyboard.

*  To select multiple features in consecutive order:
a) Place the mouse pointer over the first feature you wish to select.
b) Hold down the left mouse button and drag the mouse until the 2

or more features have been highlighted.
c) Release the mouse button. Notice that the features in the feature

lists remain highlighted and the selected features in the part view
now appear in color.

OR
a) Click on and highlight the first feature you wish to select.

b) Move the mouse pointer to the last feature you want
selected.Hold down the Shift key and click the left mouse button.
This will select the features in consecutive order in just two
clicks.

*  To select multiple features not in consecutive order:
a) Click on any feature in the feature list.

b) Hold down the Ctrl key while clicking on any other feature

c) you want selected.

*  To select all features in the feature list:
a) Drag your pointer down the feature list as explained above.

 OR

b) Choose "Select All Features" in the EDIT menu.
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Changing the feature name
The features on the feature list have default parameters that will be
displayed in the Results Window. These parameters can not be changed.
For ease of operation, the user is allowed to change the feature name.

a) Select Circle 1 from the feature list so that it appears on the Results
Window.

b) Click on the CHANGE button in the Results Window. A menu will
appear.

 

 Figure 3 - 1
c) Select "Feature Name" from the menu.
d) Type in the name you wish to call your feature. For this example, type

in Big Circle.
e) Click on "OK" or press ENTER on the keyboard.

This will put Big Circle on the feature list in place of Circle 1.

 

 Figure 3 - 2
 
Changing the feature name will not change its sequential value. If you
were to measure a circle feature after changing Circle 1's name to Big
Circle, it would appear on the bottom of the feature list Circle 9.
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Results Window

The Results Window is where you'll find individual numeric details about
a given feature. The Results Window will open automatically by
measuring or constructing features or by double clicking the left mouse
button while in the feature list. The Results window also contains two pull-
down menus. One to activate "Tolerancing," and the other is "Change."

Form Information
When you create a 50-point circle for example, all 50 points will probably
not lie exactly on the final best-fit circle. So how far were the individual
points from the circle?  Form information helps to answer this question.

When you create a circle, you'll see two numbers labeled +T and -T in
the Results Window. These numbers tell you how close the worst
"outside" and "inside" points were to the circumference of the best-fit
circle. The +T measurement tells you how far the "Worst outside point"
was from the circle's circumference, while -T tells you how far the "worst
inside point" was from the circumference.

Results Information
Most features and relations have a fair amount of data associated with
them. This data is displayed in the Results Window. The meaning of the
+T and -T form Tolerance data was described partially before, but what
do the rest of the components mean?  Here are explanations of this data
for each feature type.

NOTE: When in Polar Mode, all X, Y coordinates are shown in the form
R, A.
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Point
X, Y: Point's coordinates

Line
Angle the line makes with the Reference Frame's positive X axis.

X, Y: Point on the line which lies closest to the Absolute 
Datum. This point, however, is shown relative to the current 
datum.

+T: Straight-line distance from worst point (on side of line 
away from the current datum) to best-fit line.

-T: Straight-line distance from worst point (on side of line 
facing the current datum) to best-fit line.

Circle
r, d: Radius and diameter.

X, Y: Center's coordinates.

+T: Distance from worst point outside best-fit circle to best-fit
circle.

-T: Distance from worst point inside best-fit circle to best-fit 
circle.

Arc
r: Radius of the Arc

X,Y: Coordinates of Arc's center

L: Length of the Arc expressed in degrees

+T: Distance from worst point outside best-fit circle to best-fit
circle.

-T: Distance from worst point inside best-fit circle to best-fit
circle.

Distance
X, Y: Horizontal and vertical distance

L: The actual length. This is a pure number
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Angle
A: Included angle.

The result of an angle will always be the included angle. This can be
changed however by using the Change button in the Results Window.
Refer to "Change Button" in the next section.

Tolerance Button
Choosing the Tolerance button, allows the operator to access the various
Tolerances. These include Cartesian, True Position, MMC and LMC.
Please refer to "Tolerancing" in the Reference section of this manual.

Change Button
The Change button in the Results window is used to "Change" the
elements of the Feature List or Part View. This is a great way to modify
your Part View or the names in your feature list.

Left clicking on the CHANGE button, will open up the following menu.

Figure 3 - 3

As you can see, the CHANGE pull down menu consists of Phantom, and
Hidden along with Show Name, Change All and Feature Name. A feature
can only be Normal or Phantom and Visible or Hidden. These functions
act as toggles and a check mark will be placed next the word in the
menu.

Like most things, there are exceptions to the rules. Depending on what
type of feature or how many features are selected, you will see different
menus under the CHANGE button.

The following is a list of items you will find under the CHANGE button and
when they will appear.

Normal - The feature will appear as a solid feature. This will appear
under the Change All menu item when multiple features are selected.
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Phantom - The feature will appear as broken lines. The QC-4000 is
defaulted to show all Relations (Distances and Angles) as Phantoms.
This is because Relations are not true geometric entities such as Circles
or Lines, they are positional information between to features. Phantom
will always appear under the Change button.

Visible - This will make Invisible or Hidden features reappear in the Part
View. Visible will appear under the Change All menu.

Hidden - Choosing this function will make de-selected features disappear
from the Part View. The feature will appear on the Part View if it is
selected, or if you choose Visible or Show hidden features. This will allow
for a less cluttered Part View to check features or during program
execution. Hidden will appear under the Change All menu when more
than one feature is selected.

Show Name - Enters the name of a selected feature into the Part View.
Selecting "Show feature Names" from the VIEW menu, will place all the
names of the features into the part view.

Hide Name - This function as you might have guessed, will "Hide" a
selected feature name from the part view and will appear under the
Change All menu.

Note: The View Menu overrides any CHANGE button item.
Example - If "Show Feature Name" or "Show Hidden Features"  is
selected in the VIEW menu, than de-selecting Show Name or Visible
from the CHANGE menu will not "Hide" features or feature names.

Figure 3 - 4
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Change All
This menu selection, has a cascading menu of its own. Choosing this
function Changes ALL selected features.

Feature Name - Allows the user to customize the names in the feature
list.

To Change a feature name:
1. Select a feature from the Feature List or Part View.
2. Left Click on the CHANGE button.
3. Select Feature Name from the menu. The following screen

appears.
 

Figure 3 - 5

4. Using the keyboard, type the new name of the feature.
5. Left Click on OK or press ENTER.

The new feature name will now appear on the feature list.
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Changing All Feature names
The QC-4000 allows the operator to sequentially renumber all the
features selected in the feature list. This is usually used when editing a
program.

When more than one feature is highlighted, and Change All/Feature
Names is selected, a new screen will appear.

Enter the starting number of your sequence then press OK.

Figure 3 - 6
Your feature list will re-sequence all selected features in the feature list.

From this To this
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Changing Relations
Changing an Angle
When measuring an ANGLE feature, the result will always be the
Included Angle. Under the CHANGE button, the angle feature may be
displayed in four different ways.
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Changing a Distance
It is sometimes necessary to have a Distance measurement and a Line
measurement in the same coordinates in the Part View. Having a
Distance measurement on top of a Line measurement may become
confusing to the user. As a convenience function, the QC-4000 allows the
user to change Distances to Lines or Lines to Distances to complete an
application.

Under the CHANGE button, a Distance Feature may be changed two
different ways:
Distance to Line - This allows the operator to "Change" a Distance
feature to a Line feature. Because a Distance is not a "True Entity," the
QC-4000 will not allow a user to take points or create other features from
a Distance Measurement. By "Changing" a Distance to a Line, the user
will be

Reverse Direction - A Distance function calculates the distance between
two points entered into the function. The result in the Part View will be the
Distance measurement including an arrow to show the user what
direction the distance was probed.

Choosing Reverse Direction will reverse the direction of the Distance
between two features. It will also reverse the numbers in the Results
window to correspond with the direction change. (Positive to Negative or
visa versa.)
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Changing Constructed Distances
When constructing a Distance, the result will always be the center point
measurement of the two features used in the construction. The QC-4000
allows the operator to CHANGE the distance to the "Nearest" two points,
or the "Farthest" two points. Below, is a diagram of what you would see if
you were to make these changes between two circles.

Center - If a Distance is selected, this will give you the Center point
distance between two Circles or a Circle and another feature.

Nearest - If a Distance is selected, this will give you the Nearest distance
between two Circles or a Circle and another feature.

Farthest - If a Distance is selected, this will give you the Farthest
distance between two Circles or a Circle and another feature.

Changing Constructed Lines
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As mentioned earlier, it is sometimes necessary to change a Line to a
Distance or visa versa. Depending on what type of features were used to
construct the line, the QC-4000 will allow some different changes. For
example, if you were to construct a Line feature using a previously
probed line along with a Circle feature, you would be able to change a
perpendicular line to a parallel line.
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Changing Tangents
When constructing circle tangents to two lines, the result will always be
Tangent #1 (See figure 8). The change button allows the user to change
the view of the tangent.

TANGENT # 1 TANGENT # 2

TANGENT # 3 TANGENT # 4

Figure 3 - 7 Types of Tangents
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FEATURE STAMP
Feature Stamps are also found in the Results Window. The button is the
graphic representation of the of the information found within the Results
Window. If you depress these buttons in the Results window, you will see
the representation of that feature as it appears on the part view. The view
includes the name of the feature (line 1), the Targeted Points (if probed),
as well as the feature itself.

Figure 3 - 8
Feature Stamp located in the Results Window

The following is a table of Feature Stamps, what it represents, and what
you would see when you depress the Feature Stamp button.

Feature Stamp Represents Part View
Representation

Line
a. The Line

b. The angle the line makes with
the positive X axis

c. An endpoint of the line that
is the closest to the current 
origin.
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Feature Stamp Represents Part View
Representation

Point
a. A point

Circle
a. The X & Y location of the

center point of the circle.

b. The Radius of the circle.

c. The Diameter of the circle

Distance
a. The horizontal and vertical

distances between the two
points.

b. The straight line distance
between the two points.

* In the Cartesian Mode distances are given in X and Y coordinates as
well as straight Line Distances
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Feature Stamp Represents Part View
Representation

Angle
a. The Included angle between

the two lines

Part View representations of
Angles will differ for each Angle
type.

Arc
a. The X & Y location of the

center point.

b. The Radius of the arc.

c.. The Arc length in degrees.
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The
Part View

The Part View Window is not only movable, sizable and closeable, it is
also scrollable. The Part view on the QC-4000 in the graphical
representation of the part being measured. In essence, it is the graphical
display of all the displayable objects within the feature list.

The Part View contains a Crosshair, known as the "Position Indicator." Its
function is to show you the position of your stage. Each time you
measure a feature, you will notice that the position indicator moves to the
same position that was targeted.

The Part View can also be used to select, delete or construct new
features, just as you would do in the feature list.
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Selecting the features from the Part View

*  To Select a single feature from the Part View:

a) Place the mouse pointer over the feature you wish to select.

b) Click the left mouse button once. This will highlight the feature
selected.

*  To select multiple features:

a) Hold down the left mouse button and drag the mouse forming a
Marquee around the features you wish to select.

Figure 3 - 9

b) Release the mouse button. Notice that the features in the feature list
will be highlighted and the selected features in the part view now
appear in color. See Figure 3-10.

OR

a) Left Click on and highlight the first feature you wish to select.

b) Hold down the Shift key and click the left mouse button on the next
feature. This can be done to select 2 or more features in the part
view.
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Zooming in on Area
Using the Zoom function can make visual part inspection a lot easier.
The QC-4000 allows you to zoom on a selected feature or on a specific
area of the part.

*  To Zoom in on an Area:

a) Select the Zoom on Area Icon from the toolbox or select it from the
VIEW menu. When this is selected, the mouse pointer will transform
into a magnifying glass with a double crosshair (++) in the center.
See figure 3-11.

b) While holding down the left mouse button, "Drag" the mouse around
the feature or features you wish to zoom in on.

Figure 3 - 10
c) Once the area is completely enclosed within the box, (marquee)

release the mouse button. The part view will now zoom in on the area
that you selected. See figure below.

Figure 3 - 11
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Show Name
Feature names can be placed on the part view to easily identify and keep
track of your features. You can apply a name to one or all the features in
the part view. This is done by selecting a feature or features from the part
view, then choosing the "Show Name" command from the VIEW menu,
or from the CHANGE button.

Customizing names
The QC-4000 allows the users to customize the feature names to appear
as C1, Cir 1, or Circle 1. This is accomplished in PREFERENCES under
the FILE menu. To learn how to customize your feature list, please refer
to "Customizing the QC-4000" section.

Refresh Part View
Some complex parts that have invisible features can result in the part
view looking incorrect. Selecting "Refresh Part View" will Redraw all the
features in the part view correctly.

You can select Refresh from the VIEW menu, or by closing or resizing
the Part View Window. As a convenience, you can also Refresh the Part
View by left clicking on the small button in the lower right hand corner of
the Part View. This is a quick and easy way to Refresh the Part View
whenever necessary without going to the menu. See figure 3-13

Figure 3 - 12 Feature Names and Refresh Part View
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The Program View

Figure 3 - 13

The Program View window can be opened by choosing Program View
from the Windows menu or by opening a program. This window is used
to view or Edit program steps. The Program View Window will appear
blank unless a previously recorded program is opened or while recording
a new program.

In Figure 14, you will notice that some program steps have and ellipsis
(...) and some do not. The steps that contain an ellipsis can be opened so
that the user may Edit or view the Substeps. The steps without the
ellipsis do not contain any Substeps.
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Editing a Program
To view or Edit a program Substep, you simply double - click on the step
you wish to Edit, or highlight the step you wish to Edit and select Edit
from the Program Menu. (See Figure 3-15)

The user is allowed to cut, paste, delete, delay or add messages to any
program step.

Figure 3 - 14

Double-clicking on a substep will open a screen so that the user may
change the probing coordinates.  (See Figure 3-16).

Figure 3 - 15

Note: Caution should be used when changing the coordinates because
you could end up at an  invalid location and the point will not be found.
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Previous Reading
Before reading this section, you should have read Essential Information.
Refer to it when you need background information to understand the
material covered in this section. It is important that you know basic
mouse procedures such as "Clicking" and pulling down Menus.

About this Section
The Demonstration Section will lead you step by step through the most
used measurement functions of the QC-4000.

The latter portion of this section will introduce some advanced techniques
such as constructing features, selecting a measurement function from
the Toolbox and Creating a feature.

READ ME
There are some assumptions made here that you should keep in mind.
The CARTESIAN/POLAR function should be in the Cartesian mode.
Since the part dimensions are in inches, use INCH/MM to set the unit to
Inch mode.

Conventions
Throughout this section, we will ask you perform certain actions, like
selecting a measurement function or targeting a point. The following
three sections will explain how to accomplish these functions so that it will
not have to be explained in the actual demonstration.
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Selecting a measurement function
When you see the word "SELECT," we are asking you to choose a menu
item or measurement function. This is done by CLICKING on the LEFT
mouse button. For example, you may be asked to "Select" POINT from
the measurement menu; You would perform the following:

Using the Mouse

a. Place the mouse arrow over
the word "MEASURE" in the
Menu Bar.

b. Click the left mouse button
once. This will open up the Pull-
down menu.

c. Move the mouse pointer down
to the POINT function.

d. Click the left mouse button
once. This will SELECT the
POINT Measurement Function,
and enable you to measure a
point.

Using the Keyboard
All menu functions can be accessed by the keyboard. Open the Menu by
using the ALT key along with the underlined letter. Then, select the
measurement just by selecting the underlined letter. For example:

To open the Measure Menu and select the Point function you would:

*  Hold the ALT key and press the M key. (It does not have be
upper case.) This will open up the MEASURE pull down menu.

*  Notice that the P in Point is underlined. Now, press the P on
the keyboard. This will enable the Point Measurement
Function.
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Targeting Points
Once you have selected a measurement function, it will be necessary to
target a point. "Targeting a point" is the process of telling the QC-4000
that you wish to include a particular point in the current measurement
calculation. When you are asked to "Target a Point," this means to place
your crosshairs on the edge of the feature you wish the measure.

Because the QC-4000 interfaces with many different systems, we will be
using the word "crosshairs" in a generic fashion. For instance, if you have
a microscope - you will use the redical crosshairs in your microscope
lens. If you have a camera hook-up, you will use the video crosshairs you
see on your monitor and so on.

Whichever system you are utilizing, you will be using the crosshairs on
your system.

Entering a Point
There are 3 different methods for entering points on the QC-4000, two
using the mouse and one with the keyboard.

Using the mouse:
1. Press the right mouse button anywhere on the screen. You

may find this the easiest choice.

Note: If using the above method, the "Single Click = Enter" item in the
Measure screen under PREFERENCES must be selected.

2. Place the pointer over the Enter Pt button in the
measurement window and click the left mouse button.

From the keyboard
1. Press the "E" key on your keyboard.

Feel free to choose any method you feel comfortable with.
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Complete the measurement
After you Target and Enter the Point, you then must tell the system you
have finished. This can be accomplished two different ways. Choose the
one you feel is the quickest and easiest for you. Complete the
measurement by:

1. Moving the mouse pointer over the "OK" button on the open 
measurement window, and click the left mouse button once.

OR

2. Simply Double Click the Right mouse button anyplace on the
screen.

Note: If using the above method, the "Double Click = OK" item in the
Measure screen under PREFERENCES must be selected.

Summary
* Selecting a function is done by clicking the left mouse button 

once.

* When Targeting a Point you must place your crosshairs on the 
edge of the part or feature you wish to measure.

* To Enter a Point you can use the mouse or keyboard. Choose 
the one you feel comfortable with.

* To Complete a measurement function you can either left click 
on "OK" or Double Click the right mouse button.
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Figure 4 - 1 QC-QUICKIE SLIDE
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Getting Started
Included with your QC-4000 is a QC-QUICKIE Slide. All the instructions
that follow, refer to that part. Start the lesson by turning on your QC-4000.
Place the demonstration slide on your system (See Figure 4-1). Perform
each step of this demonstration in the order that it is presented. Feel free
to repeat any section until you are comfortable with the concepts and the
methods used.

NOTE: The dimensions you obtain may be negative numbers. This is due
to axis orientation, and means you will have to reverse your axis
direction.

Axis Orientation
Your QC-4000 must be set up for the proper axis orientation. This means
that if you move the crosshairs to the right, the X count increases from 1
to 2 to 3 and not from -1 to -2 to -3. The same holds true for the Y axis. If
you move the crosshairs up the count increases from 1 to 2 to 3.

To Check Count direction:
•  Move the crosshair to the right. The number in the X display should

increase. If the number does not, the X axis needs to be reversed.
•  Test the Y axis by moving the crosshair up. The number in the Y

display should increase; if it decreases the Y axis needs to be
reversed.

•  If you find that your axes do not need to be reversed, skip the next
section and continue to �Reference Marks�.

To Reverse Axis:
∗  From the FILE menu choose Supervisor Setup.
∗  Enter the PASSWORD when prompted.
∗  Select the Axes button.
∗  Select the Options button.
∗  Left-Click on �Reverse� inserting an X into the box(s) (⌧).
∗  Click on the OK buttons to exit all screens.
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About Reference Marks and Machine Zero

Reference marks -- are marks on a linear encoder that can be sensed
by a digital readout for the purpose of establishing a known starting
location within the measurement envelope. This location is needed to
continue measurements of the same part started the previous day, non-
linear error correction, or to use the software fence (in CNC systems).
If your machine is equipped with reference marks, you must enable the
reference marks in your QC-4000. This will locate the machine zero more
repeatably than moving your stage to the fixed location.

*************************************

Machine Zero -- is a fixed location on your stage used by the calibration
grids, software fence and may also be used in a program. This location is
established at startup and can be reset anytime (Except during program
recording) by Machine Zero in the datum menu.
Establishing a Machine Zero must be performed for NLEC and software
fence to operate properly. If one of these options is installed you will be
prompted to locate your machine zero at startup. Note: If you are using
reference marks to establish your machine zero the reference mark
calibration must be performed first.

**************************************

If reference marks are enabled, (in the Axes Setup) you will be prompted
to cross them on start up. If reference marks are not enabled on an axis,
but you have specified that you want to establish machine zero on that
axis, then you will be prompted to move to that position fixed location on
the stage) at startup. When you press OK, the machine zero for that axis
will be established at that position.

IMPORTANT: REFERENCE MARKS SHOULD ALWAYS BE CROSSED WHILE GOING
IN THE SAME DIRECTION EACH TIME OR YOU MAY OFFSET THE MEASURING
ENVELOPE BY THE WIDTH OF THE MARK. This means that you should
position the stage before you shut down so that you will cross the
reference marks in the correct direction when you restart.
If you do not have the Reference Mark indicators, you may skip this
section.
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Enabling Reference Marks:
1. From the FILE menu enter the Supervisor Setup.
2. Select the Axes button.
3. Select the Options button.
4. Left-Click on Ref Marks inserting an X into the box (⌧).
5. Click on OK.

Figure 4 - 2

Reference Mark Calibration:
1. Select the Machine Zero button in the Supervisor menu and select

the axes you wish to set when using Machine Zero. (X, Y, Z).

2. Move the stage near the reference marks. (SINCE THE USE OF
REFERENCE MARKS IS DIRECTION SENSITIVE, YOU MUST CROSS THE MARK
IN THE SAME DIRECTION YOU WILL USE ON START Up.)

3. Select �New Session� from the File menu.

4. Select Set Machine Zero from the Datum menu.

Perform the following instructions:

♦  �Cross the X axis reference mark.�

♦  �Cross the Y axis reference mark.�  (This will set the Machine
Zero at the reference marks.)

 
Note: If your system is equipped with a Z axis you would be prompted to
�Goto your machine zero point for the Z axis and press �OK�.

You have now completed your Reference Mark Calibration and have
established the Machine Zero. Remember: Position the stage before you
shut down so hat you can cross the reference marks in the correct
direction when you restart.
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Establishing a Reference Frame
A powerful feature of the QC-4000 is the ability to skew and establish a
datum. Your first step should always be to align the part, which is done by
establishing a Reference Frame.

A Reference Frame has two components:
1. Skew - Two axes, that describe the rotation of the measurement

plane.
2. Datum - An Absolute Zero, that is usually tied to a dimensioned point

on the part.

The QC-4000 provides you with a procedure for establishing a Reference
Frame. While establishing the Reference Frame, you will have to probe
or construct two lines. This process is described briefly in the following
paragraphs.

To Establish a Reference Frame:
a) Select Probe Frame from the Datum menu. The Frame

measurement window will appear.

b) Target between 2 and 50 points along the skew line (X axis). (See
figure 3.)

c) When you have entered enough points, press "OK."

Figure 4 - 3 (Establishing A Reference Frame.)
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d) Now target between 2 and 50 points along the Y axis spreading the
points out along the left side of the part.

e) Press OK.

The QC-4000 now knows all it needs to about the placement of the part.
Even if the part is not perfectly parallel with the axes of your stage, the
QC-4000 will automatically compensate for it.

NOTE: During a FRAME command, if Cancel is used during the
measurement of the 2nd line, the original alignment and features will be
lost.

If your part is misaligned with respect to the travel of your machine, you
will notice that more than one DRO display will change, as you move
along one axis only. This is because the QC-4000 knows you are moving
diagonally with respect to the part.

Once a Reference Frame has been established, you are in Part
Coordinates. The part must be placed within 45° of the correct
orientation, or the orientation of the axes may change.

Feature List

After Framing the Part, you will notice that the feature list contains 3
features.

Line 1 - This is the first line you probed, also known as the Current Skew.
This indicates the rotation of the part's axes relative to the measuring
machine's axes.

Line 2 - This line, when intersected with the previously probed line, yields
the Absolute Datum or part zero.

Point 3 - This point is automatically created by the QC-4000 to show the
intersection point between Line 1 and Line 2, also known as your
Absolute Datum or Part Zero.
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Point Measurement
Points are the easiest features to measure because they require very
little interaction between the user and the QC-4000. Follow these steps to
measure several points on the part.

Selecting a measurement tool can be done in various ways. For
demonstration purposes we will be selecting the measurement tools from
the Measure Window. (Refer to Selecting a Function).

a) Select the POINT function (F2) from the Measurement Window.

b) When the Point Measurement Window appears, Target any point on
the part and click on "Enter Pt." Notice that the "Pts Entered = 0" (in
the measurement window) now changes to 1.

c) Now click "OK." This finishes the Point measurement and closes the
Point Measurement Window.

d) Repeat steps a. thru c. and target 2 more points.
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Figure 4 - 4 (Point Measurement)
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Feature List
Notice that the list contains all the points that have been measured The
number in the right hand corner implies that there are (6) features in the
Feature List. (Three from the FRAME measurement and three from the 3
points just taken.)

Part View
The Part View Window now includes the 3 features from your Frame
command along with three +'s. These are the Points that you have
targeted and entered.

Results Window
The result of a point function is a single two dimension point that
represents the points entered into that function. .
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Average Point
The average point, or "Multi-point point" is a way to obtain more accuracy
in point measurements by targeting the point two times and then
averaging the positions entered when generating the POINT feature.

Average points may also be constructed by selecting two features from
the feature list or part view. For more information, refer to Constructions.

a) Select the POINT function (F2) from the Measurement Window. The
Point Measurement Window appears.

b) Target two points on the part or select the features from the feature
list and click on OK.

This finishes the Average Point measurement and closes the Point
Measurement Window.
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Line Measurement
The QC-4000 can also measure lines. Taking between 2 and 50 points,
the QC-4000 will calculate the line that best fits those points as well as
providing Form Tolerance.
Let's measure the line formed by the part's measurement plane and the
right face. Proceed as follows:

a) Select LINE (F3) from the Measure Window. The Line measurement
box appears.

b) Target Points along the line clicking on "Enter Pt" after each target.

Note: You must target at least 2 points to define a line and you may
target up to 50 if you wish.

c) Click on "OK" to signal the end of the line measurement.



Chapter 4 Demonstration

4-17

 
Figure 4 - 5 (Line Measurement)
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Feature List
The new line feature is placed at the bottom of the Feature List, and the
information about the line is displayed in the Results Window.

Part View
In the part view you will now see the line that you just measured (in
color). Notice that the features that have been measured previously are
still there, but they are now shown in black.

Results Window

Figure 4 - 6

The result of a line function is a two dimension line that is the best fit line
calculated from the points entered into the function. The information from
the results window is as follows:

1. The amount of points entered for the line measurement.
2. The  entry is the angle the line makes with the positive X axis
3. The endpoint on the line that is the closest to the current origin.

Also know as the: (X, Y point on the line that lies closest to
the Reference Frame's Absolute Datum).

4. The +T and -T bound and unbound

When you measure this feature, you will see +T and -T in the Feature
Expansion Window. These numbers tell how close the worst �outside�
and �inside� points were to the best-fit construction. The +T measurement
tells you where the "worst outside point" was; -T tells where the "worst
inside point" was located.

The +T and -T meaning for this feature is as follows:

+T: Straight-line distance from worst point (on side of line away
from the current datum) to best-fit line.

-T: Straight-line distance from worst point (on side of line facing
the current datum) to best-fit line.
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Circle Measurement
The QC-4000 enables you to make very precise calculations about any
circle or arc of circle. Given anywhere from 3 to 50 points, the QC-4000
can calculate the circle's center and radius, as well as Form Tolerance.

For most 3-dimensional parts, circles are actually the intersection of a
cylinder and the measurement plane. For this example use the large
circle in the demonstration part and follow these steps:

a. Select the CIRCLE function (F4) from the Measure Menu.

b. Target between 3 and 50 points along the circle, clicking on
"Enter Pt" after each target.

c. When you have entered enough points, click on "OK."
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Figure 4 - 7(Circle Measurement)



Chapter 4 Demonstration

4-21

Feature List
After you click "OK," the QC-4000 will place the resulting circle feature at
the bottom of the Feature List. Notice the number in the right hand
corner, has changed, matching the amount of features stored on the
feature list.

Part View
In the part view you will now see the CIRCLE that you just measured (in
color). You also might have noticed that your part has been "redrawn" to
fit the Window. This is because the QC-4000 has a great feature known
as "AUTO ZOOM." After each feature is added to the part view, dynamic
scaling will take place and the part view will be redrawn if it is necessary
to fit new features within the view. More details about "Auto zoom" can be
found later in the manual.

Results Window
The circle function calculates the least squares best fit circle from the
points entered into the function. The output is as follows:

1.  The number of points taken for the circle measurement.

2.  The X & Y location of the center point of the circle.

3.  The Radius of the circle.

4.  The Diameter of the circle.

5.  The +T and -T meaning is as follows:

+T. Distance from worst point outside best-fit circle to best-fit circle.

 -T. Distance from worst point inside best-fit circle to best-fit circle.
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Distance Measurement
Another function performed by the QC-4000 is distance measurement.
The QC-4000 can calculate the X and Y distance between two points.

In this example of the part demonstration we will measure the height of
the part (the dimension of the part along the Y axis) using the following
steps.

a) Select Distance (F7) from Measurement Menu.

b) Target any point on the edge near point 1 of Figure 4-8. clicking on
"Enter Pt" after you have targeted your point.

c) Target any other point on the edge near point 2 of Figure 4-8, again
clicking on "Enter Pt" after you have made your selection.

d) Click OK to indicate the completion of the distance measurement.
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Figure 4 - 8 (Distance Measurement)
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Feature List
The new distance relation is placed on the bottom of the Feature List.

Part View
The Distance Representation that you just measured now appears in the
Part View Window, as Dashed Lines. Since distances are relations
between existing features and not true entities, they appear on the Part
View as Phantoms. They also include arrows, that show the direction in
which to measurement took place. You can Change the direction of the
arrows by clicking on the "Change" button in the Results Window. (Refer
to the Change button section.)

Results Window
The horizontal and vertical distances between the two points in the
Cartesian mode, distances are given in X and Y coordinates as well as
straight line distance readings in the Results Window.

1. The X & Y location of the Distance measurement relative to the
zero datum.

2. The length of the distance measurement.

In this example, the Y distance representing the part, is what we're
interested in. The X distance is meaningless, since it depends upon
which two points we used for the measurement. The Y distance should
be the same regardless of where the two points fall on the top and
bottom edge.

The order of entry of the two points is most important. If the Y distance
display is 1.8 inches, it would have been -1.8 inches if the points had
been entered in reverse order.
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Arc Measurement
The QC-4000 enables you to make very precise calculations about any
circle or arc of circle. Given anywhere from 3 to 50 points, the QC-4000
can calculate the Arc's center and radius, as well as Form Tolerance. To
measure an arc:

a. Select the ARC function (F5) from the Measure Menu.
b. To determine an ARC you must target between 3 and 50 points

along the arc, clicking on "Enter Pt" after each target.
c. When you have entered enough points, click on "OK."

Feature List
After you click "OK," the QC-4000 will place the resulting arc feature at
the bottom of the Feature List. Notice the number in the right hand
corner, has changed, matching the amount of features stored on the
feature list.

Part View
In the part view you will now see the ARC that you just measured (in
color).

Results Window

The ARC function calculates the least squares best fit arc from the points
entered. The output is as follows:

1. The number of points taken for the arc measurement.
2. The Radius of the arc..
3. The X & Y location of the center point
4. The Degrees of arc length.
5. The arc orientation which is from the center of the arc to the center 

point of the arc segment express in degrees from the positive X axis.
6. The +T and -T would be calculated for a circle.

+T : Distance from worst point outside best-fit circle to best-fit arc.
 -T : Distance from worst point inside best-fit circle to best-fit arc.
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Angle Measurement
Your QC-4000 can also measure angles. The angle function calculates
the angle and vertex point between two lines that are probed within the
function.

For this exercise use the side and bottom of the demonstration part as
shown in Figure 4-9 and follow these steps:

Note: Angles are usually generated as relations between existing
features (usually two lines).

a. Select ANGLE from the Measure Menu. A prompt appears
instructing the user to probe the 1st leg of the angle.

b. Target between 2 and 50 points on leg 1 on the part for the
part's angle face (see Figure 4-9).
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Figure 4 - 9 (Angle - Leg 1)
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c. Press OK when you have entered enough points.

Another prompt appears instructing the user to probe the 2nd leg.

Figure 4 - 10 (Angle - Leg 2)

d. Target between 2 and 50 points on leg 2 on the right face of the
part (see Figure 4-10).

e. Press OK when you have entered enough points.
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The Angle listed in the Results Window is the Included angle. If you press
the change button in the Results window, you will be able to change the
results to show other angles. These angles include the Complementary
Angle, the Excluded Angle, and 180° plus the Included Angle. All other
angles have a geometric relationship to the first angle. (See figure 4-11.)
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Results Window
1. The number of points taken for the angle measurement.

2. The Included angle between the two lines.

3. The X & Y coordinates of the vertex of the angle. This is shown
as a point measurement located on the feature list below the
angle just measured. If selected, it will appear in the results
window as a point.
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Feature List
After you press OK the second time, the QC-4000 will perform a few
calculations and place the resulting angle relation on the bottom of the
Feature List. Notice that a Point is also added to the bottom of the feature
list as well. This Point is the X and Y coordinates of the vertex of the
angle just measured.

Part View
In the part view you will now see the Angle that you just measured.

You have now concluded the BASIC portion of the Demonstration
Section. You may want to go back and repeat any steps that you might
have found confusing.
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ADVANCED DEMONSTRATION
Now that you have become a PRO at measuring features, this portion of
the manual will take you one step further. This section will walk you
through the following:

∗  Construct a feature from existing features.

∗  Skewing on two circles.

∗  Creating a feature.

∗  Creating a Tangent Circle

∗  Using Measure Magic.

Constructing a Feature
Constructing a feature is merely the process of combining existing
features to generate a new feature.

As an example, let's construct the distance between two circles found on
the Quickie Slide. If your feature list does not already contain two circles,
follow the instructions earlier in the demonstration section for probing
circles.

1.  Select the Distance Tool from the toolbox or Measure menu.

2.  Move the mouse pointer over a circle in the part view.

3.  Left click on the mouse button. That feature will change color in
the part view and will be highlighted in the feature list.

4. While holding down the SHIFT KEY on the keyboard, move the
mouse cursor over second circle and Left click on the mouse
 button.

5. Click on OK in the measure window.

Your Distance will now appear on the Part View as a dotted line and will
appear at the bottom of the feature list.
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Angle Construction
As mentioned in the Angle Measurement section, angles are usually
generated as relations between existing features, instead of probing them
from scratch. Now we'll see how to construct the angle between two line
features. First we must place two line features in the Feature List.

1. Select the LINE from the tool box.

2. The LINE Measurement window now appears.

3. Probe points along the first line.

4. Select "OK" when you are done probing the line.

5. Repeat steps 1 � 4 for the second line.

6. Select the ANGLE Key from the toolbox.

7. Select the two lines from the part view by left clicking on
them.

8. Select "OK."

A new angle relation appears on the Feature List and on the Results
Window. This is the angle between the two separately measured line
features.

In all measurements, there is a simple rule to remember. There are two
basic ways to generate features -- Probe or Construct.

To Probe a feature, you must first target and Enter the points of the
feature you wish to generate.

To Construct a feature, you must first select the type of feature you wish
to generate (i.e., Line from 2 points or Angle from 2 lines) then select the
previously generated features from the feature list or part view.

Note: If you are using Auto Construct, you must first select the features,
then select the feature type. (Refer to Preference Menu section.)
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Skewing On Two Circles
In the beginning of the Demonstration Section, you were shown how to
"Establish a Reference Frame." Framing your part, eliminates the need
for time consuming, costly, manual alignment or fixturing.
There are times that the part you are measuring will consist only of radii,
but still must be skewed to insure correct measurement. If you didn't
perform a Skew Alignment before measuring, and instead tried to
"eyeball," your chances of finding the correct measurements are slim.

The procedure is for skewing on two circles is quite simple, and will
insure proper measurements.

a. Select the CIRCLE function from the Measure Menu or toolbox.

b. Target between 3 and 50 points along the circle, clicking on "Enter
Pt" after each target.

c. When you have entered enough points, click on "OK."

d. Repeat steps a, b and c for the second circle.

e. Choose the SKEW function from the toolbox or DATUM menu.

f. Select the 2 circles from the part view or feature list.

g. Press OK on the measurement window.

The Skew function is now completed. The feature list will now contain
Line # (Current Zero & Skew). The DATUM menu will contain that skew
line number next to the words Skew and Zero.
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Creating features
Sometimes you need to be able to reference a feature without actually
probing it. One such instance is when you have an off-the-part Absolute
Datum--you could generate this datum by creating it manually.

The QC-4000 allows the user the create Points, lines, angles, and circle
features.

Figure 4 - 11 (Create Menu)
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Create a Point
When creating a Point, enter the X, Y, Z (if applicable) coordinates of the
Point, then press OK or ENTER.

Figure 4 - 12 (Create a Point)

Create a Line using 2 points
When creating a Line with 2 points, just enter the X, Y and Z coordinates
of both the start and end points of the line.

Figure 4 - 13 (Create a Line)
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Create a Line
When creating a line for point, angle & length results, you need to supply
a point (X, Y, & Z) through which the line passes, as well as the angle
and length that the line makes with the positive X axis.
When this feature is placed on the Feature List, don't worry if the X, Y
coordinates change. The point that the QC-4000 stores is the point on
the line closest to the Absolute Datum, which may not be the same as the
point you entered. It's just a different point on the same line.

Figure 4 - 14

Note: You cannot partially probe and then partially construct a feature or
relation. You must completely probe or completely construct a feature or
relation.

To create a Circle
a. Select Circle from the Create pull down menu.

Figure 4 - 15
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b. Enter the X, Y and Z (if applicable) coordinates of the circle's center
and the radius and/or diameter. Then press OK or ENTER.

The new feature is placed on the Feature List and Part View, and, since
this feature was neither probed nor constructed, the Form Tolerance
information for the feature is +T=0 and -T=0.

Create an Arc
Like lines, the Arc can also be created two ways. (Start and end angles)
or (Start and end points).

Figure 4 - 16

When creating an Arc using the Start and End
angles, you must also supply the X/Y coordinates
of the center of the radius, along with the size of
the radius.

In this example, we used a 0,0 Center Position, a
starting angle of 270° and an ending angle of
35°.
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When creating an Arc using the Start and End points, the Arc�s final
position is somewhat dependent upon its� Center position coordinates.

We say �somewhat dependent� because the center position coordinates
do not have to be exact, they are used to give the Arc an approximate
placement factor.

To better explain this, let�s created two arcs with the same start and end
points but different center point coordinates.

First, we�ll create two lines without the Arc.

•  From the Measure menu.

•  Select Create then Line (pt, angle, & Length).

•  Create line 1 use following coordinates:
X=0 A=0
Y=1.125 L=1

•  Create the line 2 using these coordinates:
X=1.125 A=90
Y= 0 L=1

***********************************

Now that we have the lines, let�s create an Arc to connect the lines.

•  From the Measure menu.

•  Select Create then Arc (start & end pts).

Approx Center Position Size
X=1 r =.125
Y=1

Start Point End Point
X=1.125 X=1
Y=1 Y=1.125

In this case, a Center position of 0,0 or 1,1 will
place the arc at the same location. Figure 4 - 17

(Center Position 1,1)
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Now create an arc using the same start and
end points but with a Approx Center Position of
1.125, 1.125

Approx Center Position Size
X=1.125 r =.125
Y=1.125

Start Point End Point
X=1.125 X=1
Y=1 Y=1.125

Notice the placement of the Arc. In this case, using 2 instead of 1.125
would have produced the same result.

Creating a Tangent Circle
Tan�gent - A line or plane which meets a curve or curved surface at a 

single point without intersecting it.

Of course this is only one definition of Tangent. And like the definition,
tangent Circles can be used for many different applications. Creating a
tangent circle is as simple as choosing the Circle Measurement and
selecting the two lines that you wish to insert the circle.

If you already have an angle on your part view, you
may use that. If you do not have angle, please probe
or create one now. (See figure 4-20.)

•  Choose Circle from the toolbox or the Measure
Menu.

•  Select the two lines from the part view or feature
list.

•  Choose OK and enter the radius and/or diameter
of the circle.

Figure 4 - 18 (Center
Position 1.125, 1.125)

Figure 4 - 19

Figure 4 - 20
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Using Measure Magic
This function automatically creates the correct geometric features simply
by entering points. Of course, there are some simple rules and probing
techniques to follow, but measuring a part will become so fast and easy
you'll probably want to use it most of the time.

The following gives a brief description of how to use Measure Magic
along will some of the rules. Select Measure Magic by clicking on the
Magicians hat icon or double-click to initiate auto repeat mode.

Measure Magic Probing Techniques
As mentioned above, there are some rules and probing techniques that
you must follow for Measure Magic to work accurately. Following these
simple probing techniques, will allow the Measure Magic function to work
at its fullest potential.

POINT MEASUREMENT
Enter one point and press OK.

DISTANCE MEASUREMENT
Probe two points, then press OK

LINE MEASUREMENT
Probe three or more points then press OK. If the line is very
irregular the QC-4000 may calculate the line to be an ARC.
Don't worry that can be changed once we exit measure magic.
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ARC MEASUREMENT
Probe at least three points on the arc then press OK. The ARC
must be at least 5 degrees but no more than 190 degrees.

CIRCLE MEASUREMENT
Probe at least three point on the circle then press OK. There
must be at least 190 degrees of arc from the first to the last
probed point. Although 3 points is sufficient to measure a circle,
a good procedure would be to probe at least 4 points equally
spaced around the circle. This will insure accurate circle
measurement.

ANGLE MEASUREMENT
Probe and Equal number of points (at least 3) on each leg of the
angle then press OK.

"Use Relations" must be turned on for ANGLE measurement. This
can be found in the measure area of the PREFERENCE menu.

Continue Reading
The next section of the manual is the Programming section. It will take
you through the program capabilities of the QC-4000. These are only
basic programs to get you started. Once you learn the full potential of the
QC-4000, you will be able to see your productivity soar.
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Customizing The QC-4000
Customizing the individual windows within the QC-4000 screen to meet
your needs, is another great feature you will find in the QC-4000. As
mentioned earlier, the windows can be sized, moved, or closed, but that
is just the tip of the iceberg. There is a command under the FILE menu
that allows you to customize other items such as Sound, Part View and
even your Toolbox.

The Preference Menu
Although closing and sizing is a form of customizing your windows, there
is another method of customizing that is unique to the QC-4000 only. This
is accomplished by PREFERENCES under the FILE menu.

The following section will walk you through the Preference menu and the
different selections you are able to select to customize your QC-4000.

Preferences
Open the FILE menu, by clicking on it, or press ALT F on the keyboard.
Select PREFERENCES from the menu. The Preferences menu will
appear.

Figure 5 - 1
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•••• Sound
Clicking on "Sound" or pressing the "S" on the keyboard will bring up a
screen with a selection of all the different sounds the QC-4000 makes.
Your system is defaulted with all sounds turned on. These options are
toggles which means, they will turn off (blank box) when selected once,
then on if selected again.

Figure 5 - 2

To turn sound on or off:

Move the mouse pointer over the appropriate box. Left click the mouse
button. (The X in each box implies - sound is on)

Selecting the small speaker symbol on the left side of the screen will give
a sample of that particular sound. After completing your selection, click
on "OK".
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•••• Measure
The Measure screen allows you to set up User Preferences. There are 8
different sections within the Measure prompt.

Figure 5 - 3

1.  Annotation (Forward and Backward)
Forward Annotation is the process of designating a specific
number of points for the targeting of a feature. When Forward
Annotation is used for a Circle measurement for instance, Pts
Needed = 3 appears in the measurement function window.
The number of points can be changed by clicking on the up or
down arrow. When that number of points is reached, the system
will automatically advance to the next step. This means it will not
be necessary for you to click on "OK".

Backward Annotation is the process where the program does not
indicate a predetermined number of points to target a feature.
When the user has "Entered" enough points, the user would then
click "OK" or Double-click the Right mouse button.
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2.  Right Mouse Button
Single or Double Clicking the Right Mouse button is another
method for entering points ("Enter") or completing an application
("OK"). There are times however, that you may to turn this off so
that a point will not be entered by mistake. The X in the box
indicates that this option is turned on. Clicking on the box(s) will
turn the Right Mouse Button off.

3.  Safety Net
When you are working with the QC-4000 or any other application
window, you should "Save" often. Auto Save in the QC-4000 will
automatically "Save" after any major function has been
performed. (Example; adding a new feature to the feature list). If
the session is "Untitled", it will send a "Save As" prompt asking
the user to name the session. This feature will "Save" the user
from repeatedly having to select "Save" form the menu or
keyboard.

4.  Preselection
Auto Construct is a quick and easy way to construct features. To
construct a feature with Auto Construct on:

a.  Select 2 features in the feature list.

b.  Select the type of feature you wish to construct.

A few more steps must be added to construct a feature without Auto
Construct.

a. Select the type of feature you wish to create.

b. Select 2 features from the Feature List, pressing "Enter" after
each selection.

c. Press "OK" in the measurement window or "O" from the
keyboard.
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5.  Measure Magic
As you know, the Measure Magic function allows the operator to
simply enter points into the function and as a result of various
probing rules, will automatically create the correct geometric
feature.

Because features are automatically generated, the QC-4000 may
confuse a 6 point ANGLE with an ARC measurement. Enabling
Allow Relations, will force the QC-4000 to measure an ANGLE
without confusing it with an ARC measurement.

If Allow Relations is disabled, the user may make all other
measurements in Measure Magic, then complete all ANGLE
measurements by choosing ANGLE from the toolbox or menu.

6.  Feature default type
Features in the Part View can be customized to appear as
Normal (solid) or Phantom (dashed). Since Relations are not true
entities, they are defaulted as Phantoms on the Part View.
Constructed and Created features are also defaulted as
Phantoms so that the User can tell the difference between these
features and Probed features.

If you would like to have the names of the features appear next
to the features on the Part View, you can set this default by
selecting Show Name.

To change the default settings for each feature type, move the
mouse pointer over the preferred default and click on the left
mouse button. An X in the box, implies that the feature will
appear as Phantom, Hidden or will have the feature name
appear in the part view. When you are finished making your
selections, click the "OK" button. If you wish to change back to
the original settings, click the "Set Default" button.
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7.  Outlier Detection
•  The intent of this function is to remove any �Incorrect� points that may

have accumulated during a measurement function. Point filtration
operates only during program execution (not while recording or when
doing non-programmed measurements) A minimum of 8 points must
be present for the filter to be used.

To use Point Filtration: - Deselect �Lock Point Filtration� under
Locks in the Supervisor menu. Enable the Point Filtration Function
by clicking on the box in the Outlier Detection under the Measure
Button in the Preferences menu. For more information on point
filtration, please refer to chapter 7.

Point filtering tuning parameters:
Point filtering works by the following method:

a) First the least square best fit feature is calculated.

b) The error of each point is determined (distance of point to best fit).

c) The worst point is determined.

d) If all criteria are met, the point is eliminated.

e) The method is then repeated (goto step a).

In step d, in order for a point to be filtered there are five criteria that must
be met simultaneously. One criteria is that point filtering is active in the
system (set in measure preferences). Additionally, there are two fixed
criteria and two modifiable criteria which may be adjusted in QC4000.INI.

The fixed criteria are:

1. A minimum of 8 original points must be present in a feature
measurement before filtering is allowed.

2. No more than 25% of original points will be filtered out of a
measurement.
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The modifiable criteria are:

1. Sigma Factor:  Default value = 2.00  This parameter is specified in
standard deviation units, or �sigma." When a best fit is calculated, the
point errors are evaluated statistically and the standard deviation is
determined. Because the sign of error is included, the mean error is
nearly zero. In order for the current �worst� point to be eliminated
from a measurement, the absolute value of the error of the  point
must exceed 2.00 times the standard deviation (using the default
value of the parameter for example). This parameter ensures that
only true statistical outliers are eliminated.

2. Filtration Threshold: Default value = 10.000. This tuning parameter
is specified in encoder counts or parts of counts. In order for the
current �worst� point to be filtered, the error of that point must exceed
10.000 times the X axis encoder resolution. For example, if the
encoder resolution was 0.002 mm, the error of the worst point would
have to be greater than 0.02 mm. This parameter ensures that the
error of a true statistical Outlier which is being considered for filtering
is not less than the estimated system repeatability. The system
repeatability is not based on the encoder resolution alone, so the
Filtration Threshold may need to be modified accordingly.

8.  Heights
•  Heights are normally always positive. Enabling �Allow Negative

Results� will allow for negative height measurements
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•  Angle

The Angle display lets you choose between DMS ( Degrees Minutes
Seconds ) and DD ( Decimal Degrees ). What's the difference? Suppose
you had an angle that was exactly 10° 30' (or, in other words, 10.5°). If
you select DMS, the angle will be displayed as 10°30' 00". A selection of
DD would display 10.5000°.

•••• Part View
As you can see, the Part View Preferences has several options in which
the user can select from. This will allow the operator to customize the
Part View in a way to best fit his/her needs. The following paragraphs will
provide a brief description of each selection.

Figure 5 - 4
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1.  Orientation
This allows the user to change the orientation of the part as it
appears on the part view.

Note: Your system may not show Orientation the same way as
the following chart. This chart is only an example of how
Orientation Selection works.

For Example:
Let's assume that you originally set the orientation for X and Y in
the positive direction.

ORIENTATION SELECTION WHAT THE PART VIEW
WOULD LOOK LIKE

Normal View = Positive X

Positive Y

Reverse Y = Positive X

Negative Y

Reverse X = Negative X

Positive Y

Reverse X and Y = Negative X

Negative Y
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2.  Position Indicator
The purpose of a position indicator is to show the current position
from Zero. In the QC-4000 however, it also is a representation of
what you would see on your monitor or comparator screen.
Choosing one of the 3 different type indicators is done by left
clicking on it.

•  Crosshair Indicator
This indicator is a basic Position indicator. The crosshair will
move around the part view each time a point is entered, showing
the current position.

• Rectangle Indicator
As mentioned above, the Position Indicators are also are
presentation of what you would see on your monitor or screen. If
you are using a monitor, this Indicator (shaped like a rectangle),
would most likely be the one you would choose. The view that
you see on your monitor is the same on the part view.

• Circle Indicator
If you are using a comparator, this Indicator (shaped like a
circle), would most likely be the one you would choose. The view
that you see on your comparator screen is the same as the part
view.

•  Show Edge Detector
When the Show Edge Detector feature is enabled, you will see
two (2) position indicators on your part view. A small green circle
will appear along side the crosshair, indicating the edge sensor.
When performing a Teach, Teach to Master or Probe Offset, this
is the indicator that you will use to calibrate your edge.

Figure 5 - 5
All three position indicators can be sized to the Field of View. Please refer
to the Calibration section of the manual.
NOTE: If the Position Indicator you have selected, does not appear in the
part view, check "Show Position Indicator" under the VIEW menu and/or
change Field of View size.
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3.  Zoom
The Zoom selection box is where you would select or deselect
the Auto Zoom function. An X in the box, indicates that Auto
Zoom is initiated.

What is Auto Zoom you ask? Simply, Auto Zoom means the
same as "Zoom to Fit". Each time a feature is added, the Part
View will automatically redraw if need be, to fit all the features
onto the part view.

Because Auto zoom redraws the part view frequently, it tends to
slow your system down. If you are measuring a large part with a
lot of features, it is recommended that you turn Auto Zoom off,
and use "Zoom to Fit" under the VIEW menu when you need to
view all the features in the part view.

If Auto Zoom is off, and you are measuring a large part, some
features may not be visible on the part view; in essence they will
"Fall off the page". Zoom to Fit will redraw all the features to their
perspective place on the part view.

4. Grid
For those of you who prefer working on a grid, the QC-4000
allows you to set your own grid spacing for inches or millimeters.

5.  Feature Name Display
As mention earlier, the part view can also have the name of the
feature appear next to the feature. Feature Name Display is
where you choose how you would like the name to appear.

If you choose: It appears on the part view as:

Long Circle 1

Med Cir 1

Short C1

If you customized a feature name such as "Big Circle" it will always
appear as Big Circle, no matter what the default is.
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•••• The Toolbox Maker
The Toolbox Maker is used to add or remove tools that appear in the
toolbox. The following procedure describes how to accomplish this:

a. Choose PREFERENCE from the FILE menu. A menu will
appear.

b. Place the mouse pointer over "Toolbox Maker" and click the left
mouse button.

A new screen appears showing all available icons, and the Icons that
currently appear in your toolbox.

Figure 5 - 6

To add a Tool
a. Select an Icon in the available list.

b. Left click on COPY. This will place the icon in your toolbox.

c. Press OK or ENTER on your keyboard.

To delete a Tool
a. Select an Icon in the Current Items list.

b. Left click on REMOVE. This will remove the icon from your 
toolbox.

c. Press OK or ENTER on your keyboard.
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•••• RESULTS
This window is one that is limited in how small it can be sized. For your
convenience, there are two different size formats to select from.

To change formats
1. Select the RESULTS button under Preferences. A new screen

appears.

2. Deselect the Wide Format by left clicking on the Wide Format
box.

Note:  After deselecting the Wide format box, you must Size the Results
Window.

Wide Format

4 X 1.5 Inches
Narrow Format

1.5 X 4 Inches.
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•••• LOCKS
Choosing this button allows the user to lock all windows residing within a
QC-4000 session. Once LOCK is initiated, the user cannot move or size
any of the individual windows.

To Lock the window positions:
Using the mouse - Left click on the lock window box then click on OK.

Using the keyboard - Depress the W on the keyboard then ENTER.

Note:  Even though window positions are locked, you are able to size the
QC-4000 window as a whole.

•••• LANGUAGE
The language window allows the user to select from English, French or
German. This will make all QC-4000 menus and screens to appear in
that language.

Figure 5 - 7
Note: This will only change the QC-4000. If you do not have the DOS
version for the selected language, you will not be able to enter any text
for the selected language into the QC-4000.
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Measure Magic

Measure Magic is a unique and revolutionary inspection technique that
will dramatically reduce the time required to inspect your parts.

With any other geometric computational system that you may have been
familiar with, you must first select a geometric function such as a line,
circle etc., then probe points on that feature. The results are then
calculated and displayed for that feature.

This is a perfectly acceptable technique and is a convention that is
currently utilized by the QC-4000. The one drawback of this method of
inspection is that you must continually reach for the readout, select a
measurement function and then probe.

For an inspector using a measuring microscope, this involves constantly
looking away from the eyepieces of the microscope, looking at the
readout controls and back to the eyepieces.

Measure Magic allows you to simply probe any geometric feature and
Measure Magic will automatically determine the type of geometric feature
you have probed.

When coupled with a foot switch, your hands and eyes never have to
leave your inspection machine. By following a few simple rules, Measure
Magic will think with you, and allow you to push the work, not the buttons

At last, a readout with real intelligence!
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Before you Begin
Before you begin using Measure Magic, the user must decide whether
they wish to include RELATIONS in the session. To include relations
when using Measure Magic, you must turn on Allow Relations from the
MEASURE dialog box in PREFERENCES under the FILE menu. (An X in
the box indicates "Allow Relations" is on.)

If Allow Relations is off, Measure Magic will not generate any Distances
or Angles. When it is on, a 2 point line will be generated as a Distance,
and Angles will now be generated if probing technique is correct.

Using Measure Magic
Measure Magic operates in two different modes. By selecting the
Measure Magic icon from the toolbox (or from the measure menu or the
F1 button), you will see a prompt window with instructions on using
Measure Magic along with OK, Enter Pt, Remove Last (Point) and Cancel
buttons.

• In this singular mode, you will be able to probe points on one
feature, and Measure Magic will calculate information on that one
feature. Measure Magic is now deactivated and you can now select
any other measurement function.
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• By Double-Clicking on the Measure Magic icon, you are now in the
Auto Repeat Mode. You are now able to probe an unlimited number
of features until you chose to deactivate Measure Magic. With
Measure Magic in the Auto Repeat Mode, just probe features then
press the OK button or foot switch and see your productivity soar.
Measure Magic lets you push the work, not the buttons.

To initiate Measure Magic for multiple feature measurement, move the
cursor over the Magicians hat icon, and double click the left mouse
button. This will turn the Measure Magic icon green, indicating that you
are in the auto repeat mode, thus allowing for multiple feature inspection.

Now probe points on any geometric feature pressing the OK button in the
Measure Magic prompt window (or double clicking the right mouse
button, or press foot switch) at the completion of probing points on each
feature and by following these simple rules:

MEASUREMENT FUNCTION RESULT

POINT - to measure a point enter ONE point and
press OK.

DISTANCE - to measure a distance (slot width
etc.) Probe TWO points, then press OK.

LINE - to measure a line, probe THREE or more
points on the line, then press OK. If the line is
very irregular the QC-4000 may calculate the line
to be an arc. Don't worry, we can change and
recalculate once we exit measure magic.

ARC - to measure an arc, take at least THREE
points on the arc, then press OK. The ARC must
be at least 15 degrees but no more than 190
degrees.
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MEASUREMENT FUNCTION RESULT

CIRCLE - to measure circle, probe at least
THREE points on the circle then press OK. There
must be at least 190 degrees of arc from the
first to the last probed point.

Although 3 points is sufficient to measure a circle,
is good practice to probe at least 4 points equally
spaced around the circle. This will insure
accurate circle measurement

ANGLE - to measure an angle, take a minimum
of THREE points and an equal number of
points on each leg of the angle then press OK.

Note: Angles and Distances will only be generated if "Allow Relations" is
initiated and probing techniques are correct.

Using the Change Button
The differentiation between lines, arcs, and circles is where the possibility
of an erroneous feature calculation. With Measure Magic this is not a
problem. For example, if you have probed three points on a very irregular
line, there is the possibility that Measure Magic could interpret the line as
an arc. It is very easy to "CHANGE" the Arc into a Line.

• Once you have ended the Measure Magic session, select the feature
in question of the part view or feature list.

• The results will now display information about the ARC.

• Click on the "Change button" in the results window and select LINE
from the menu.

This will change the feature from an ARC to a Line. The line information
will be display in the results window and the part view will be updated
accordingly.
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Figure 7 - 1
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About User Programs
The QC-4000 offers extensive programming capabilities. Using different
command functions, your system will perform "electronic instruction" that
will automatically create programs and measure the features of the parts
you commonly deal with. These instructions, called "User Programs" or
just "programs," automate the sequence of key presses needed to
examine a part, leaving you free to concentrate on targeting points and
interpreting the results. To make it even easier, the Part View will show
you the area in which you must target the point.
You can also lock programs to prohibit access to any QC-4000 functions
other than �Run a Program� and �Shutdown�. To Lock programs select
Fixed run Program Mode under the LOCKS in the Supervisor Setup.
Part programs are created using two different methods. These methods
are Self Teach, and Auto Program; generation from a DXF (CAD) file.
To help you learn to use the programming system, we'll walk through the
creation, modification, and execution of a User Program designed to find
the distance between two circles located on the Quickie Slide using the
Self Teach Method. After you become familiar with a basic program and
how it works, continue on to learn about Importing from DXF, and using
DDE (Dynamic Data Exchange) while creating programs.
Creating a program to measure a feature is almost as easy as measuring
the feature itself. The following are the four basic steps for creating a
program.

1.  Tell the QC-4000 to start recording a program.

2.  Name the program.

3.  Perform the measurements.

4.  Tell the QC-4000 to stop recording the program.



Chapter 7 User Programming

7-5

Creating A Program -- Self Teach
Points to Remember
Recording a program is as easy as measuring the part. However, there
are several points to remember when recording a program to make the
program run smoothly each time it is initiated.

1. When recording a program you should use "New Session" in the
File menu before you start to record so that there is no part
reference frame or features in the system.

2. Prior to recording a program, you must establish a part reference
frame. Establishing a reference frame will align the part and insure
proper placement of features each time you run the program.

3. Before running a program, you must establish the same part
reference that was in effect when you recorded that program.
Programs will always run in the same part reference frame that was
present before you started to record.

4. When running a program, the Machine Zero point must be the
same point as when you recorded the program. For simplicity,
whenever you are going to record or run a program, use the "Set
Machine Zero" function in the datum menu before you start to
record or run a program. Always set the machine zero point to a
repeatable point on the stage (not the part).

5. Skewing and zeroing are programmable steps. This means that the
reference frame may be modified during the course of recording (or
running) a program. If you follow rules 1 thru 4 (above), and if you
have a fixture that holds the part in the same position every time,
then the program will know the part location on the stage and will
run correctly.

6. If your program is not running correctly, it is easier to re-record it,
than to try to change it by editing (unless your program is very
large). Recording a program is quite easy because you simply
measure the part as you normally would. You don't have to think
about the fact you are recording. Remember to turn off the recorder
by "End Recording" in the program menu.
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7. You may use Measure Magic when you record a program but you
must remember the Measure Magic probing rules. (Please refer to
the Measure Magic section of the manual). It will not be possible to
modify the type of feature when recording, so use Measure Magic
carefully.

8. When recording a probed angle into a program, it's recorded as two
lines followed by an angle construction. The sequence will not be
exactly as recorded, but the program will still run properly and
generate the angle and apex point. We recommend that relations
(angles and distances) be constructed rather than probed.

9. Auto Program from features is an advanced function of the QC-
4000. You can use it to create a program from previously measured
features or to program parts read in from a CAD "DXF" file. There
are several extra requirements for using the auto program
generator, so do not attempt to use it unless you have a thorough
knowledge of the CAD system you are using. (Please refer to
"Creating a Program from a CAD file" section of the manual.)

Following these simple rules will make programming a breeze. It will
also allow the operator to adapt different parts into a like program by
copying and editing a previously written program.

Before we begin programming, we will need something to measure.
Place the QC Quickie Demo part that came with your QC-4000, on your
measuring machine. You can check any measurements by referring to
the Quickie drawing in the beginning of the Chapter.

Start A New Session
Before recording a program, it is a good practice to start a New Session,
which will eliminate all the existing features from the Part View and
feature list.
• From the File menu choose New Session. A dialog box will appear

to confirm your selection.

• Left click on YES, or press ENTER on the keyboard. This will clear
your feature list and part view. You are now ready to record a
program.
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SKEW the Part
The first step of our program will be skewing the part. This procedure will
align the part to establish a reference.

• Select SKEW under the DATUM menu. A dialog box appears,
prompting you to probe or construct a Line.

• Probe 4 points on line 1 of the Quickie slide. You can probe between
2 and 100 points on the line, however for this program, probe four
points that are well spread out on line one then press "OK."

Skewing the Part (Figure 7 - 2)

The Skew function is now complete. The feature list will automatically title
Line 1 as Current Zero and Skew, and the DRO header will show which
line the user has Skewed on.

Establishing a ZERO Datum
•  Select the Line function from the toolbox. Again you are prompted to

probe a Line.
•  Probe 4 points on line 2 then press "OK."
•  Select Zero from the DATUM menu.
•  Select Line 1 and Line 2 from the feature list or part view. (Features

will turn blue when selected.) Once you have selected the two
features, press "OK."
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Figure 7 - 3

Once OK has be pressed, the QC-4000 will automatically create an
intersection point (Point 3) from the 2 lines and will appear on the feature
list as Current Zero. All features measured from now on will be relative to
this point.

Figure 7 - 4

At this time you may want to delete these features by highlighting all the
features in the feature list and selecting Delete Selected Features from
the Edit menu. The deletion is not necessary, but it will avoid any
confusion when recording the reference frame inside the program.

1.  Start Recording a Program
• From the Program menu select Record New. A dialog box will

appear to prompt the user to name the program.

2.  Name the Program
• Using the keyboard, enter a program name of up to 8 characters,

then press the "OK" button. For this exercise, please name the
program DEMO.
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You are now recording a part program.  This "Recording" Icon
will appear on the Status Bar and any measurements, constructions, or
print operations that you make, will be retained in this part program. If you
make a mistake or want to make some changes, don't worry, editing a
program is fast and easy.

Establish a Reference
Now establish a Skew and Zero reference just as you did prior to
recording the DEMO program.

3.  Perform the measurements
As mentioned earlier, we will measure two circles and construct the
distance between them.

 Circle Measurement
•  To measure a circle, select the CIRCLE icon from the toolbox.
•  Probe 4 points on one of the circles located on the Quickie, (Circle 4)

then press "OK." (See figure 5)
•  

Figure 7 - 5

• Probe a second circle in the same fashion. (Circle 5)
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 Construct a Distance
Constructing a feature simply means combining existing features to
generate a new feature. Refer to Chapter 4 for more information.
•  To construct a distance between 2 circles, select the Distance icon

from the toolbox.
•  Select the 2 circles from the feature list or part view, then press OK.

The result will be the center to center distance between Circle 4 and
5. (Distance 6). (See figure 5)

4.  End Recording
• From the Program menu select End Program. You have now

created a basic program.

If you don't already have the Program View showing, select Program
View from the Windows menu.

Figure 7 - 6

This is what your program should look like. Step 00001 is System
Settings which will be explained later in this section. Steps 00002 through
0004 is where we established a reference frame and lines 00005 thru
00007 are the actual measurements and constructions that were
performed while recording this program.
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Special Steps
It is possible to insert �Special Program Steps� into a program. Located
under the Program menu, this menu item contains a flyout menu with
separate commands that can be inserted into a program while recording
or edited into a previously created program.

Figure 7 - 7

Delay - Pause a program for a specified number of seconds.

User Message - Inserts an alpha-numeric string that will be displayed
during program execution.

Run DOS/Windows Program - Allows the user to execute a
DOS/Windows program while running a QC-4000 program.

Export to ASCII File - Allows the user to export specific information such
as, Time and Date, Position of Selected feature, and text to an ASCII file.

DDE - Dynamic Data Exchange is a message protocol for data exchange
between Windows programs. It performs actions equivalent to choosing
the commands from the windows program. These commands are called
command-equivalent functions. For example, giving the command
PARTVIEW.OPEN is the same as opening the Partview from the QC-
4000 Windows menu. For more information about DDE, please refer to
the Reference Section.
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Running a Program

With the program already open, left clicking on the  button in the

status Bar will turn the button into this  and will begin running the
program. Or highlight the first step of the program then, select Run
"DEMO" from the Program menu.
If you do not have a program open select Run from the Program menu.
A screen will appear prompting you to select the program you wish to run.
After pressing OK, the program will automatically begin to run.
The part view will fill with all the features that are to be inspected. Notice
that the features are gray. They will turn black as they are inspected.
There will be a flashing green cursor on the first feature to be inspected.
Probe a point in the general vicinity on that first feature where the flashing
green cursor indicates. After probing the first point, the cursor will move
to the next probing point. After 4 points are probed, the cursor will then go
to the next feature. Just follow the flashing cursor and let the QC-4000
guide you through inspection of the DEMO part.

Close The Program
To store the DEMO program, left click on the Program menu and select
Close "DEMO". If you changed the program, but didn't save it, a "Save
As" prompt will appear.

 Editing User Programs
The Program View Window is used to view or Edit program steps. This
window will appear blank unless a previously recorded program is
opened or while recording a new program. There are two types of editing:
Line editing and "Record Into".

Line Editing
Line Editing is changing the parameter of a line, inserting special steps or
using the Cut and Paste functions to re-sequence your program. In Figure
7-8, you will notice that the program steps have an ellipsis (...). This
means that the step can be expanded to view or edit the Substeps. Steps
without the ellipsis do not contain any Substeps.
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To view or Edit a program Substep, you simply double-click on the step
you wish to Edit, or highlight the step you wish to Edit and select Edit
from the Program Menu.

Figure 7 - 8

Double-clicking on a substep or selecting Edit from the Program menu
will open a screen so that the user may change the probing coordinates.
Pressing the Here button will "Zero" the X/Y coordinates.
(See Figure 7-9)

Figure 7 - 9
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Record Into (Insert a Step)
This type of editing will allow you to record new steps such as a user
message or another feature into your program. For this demonstration,
we will add the message Cir,Cir,Dist into the program to let the operator
know that they will be constructing the distance between two circles.

1. Highlight Line 00004 in the program view.
2. Select "Record Into" from the Program menu.
3. From the Program menu select Special Steps, then User Message.

The following screen will appear.

Figure 7 - 10

4. Using the keyboard, type the message you wish to display. Initiating
the Pause function will display the message and prompt the
operator press OK before the program will continue. Selecting the
Print and Print Date/Time will of course print the message and/or
the date and time via the RS232 port.

5. Press OK.
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6. Now from the Program menu, choose End Recording. Notice in
Figure 7-11 that a new line was added.

Figure 7 - 11

Delete A Step
You can delete a step in a program easily by opening the desired
program and program view. Select a line in the program you wish to
delete, by moving the mouse pointer over the line and left click the
mouse button.

Select "Delete Step XXX" from the EDIT menu.

Note: It is advisable to regenerate features after editing a program.  You
could end up at an invalid location and the point will not be found.
Regenerate Features will re-sequences your Feature list to reflect the
changes. This function is located in the Program menu.
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System Settings

System Settings will always appear as the first line in a program and
cannot be cut, copied or deleted. You can view the System Setting
screen by double-clicking on it, or Selecting Edit from the Program
menu. Items such as Times to Execute and Use As Recorded are
selectable from this screen only. (See Figure 7-12)

Figure 7 - 12

Use Machine Skew
If no other Skew has been established, "Use Machine Skew" will be
selected automatically.

Use Machine Zero
If no other Zero has been established, "Use Machine Zero" will be
automatically selected.
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Clear Features
Having this selected will clear the feature list before the program begins
to run.

Use As Recorded
If "Use As Recorded" is on, the program will run using the same edge
type, light levels or other calibrations you may have performed when
recording this program.

Ignore Errors
This will allow a program to run complete without pausing and displaying
an error message.

Palletize function
This allows the user to measure several fixtured (same) parts with one
program. The fixture holds the parts at a known distance from each other
in a row or column or both.
To use this function -  first skew and zero on the first part. Record a
program which has a skew and zero as the first two steps. After making
all the measurements, stop recording. It is good practice to run the
program at least once to make sure all measurements are correct before
setting up the Palletize function. After checking the program, double-click
on �System Settings� (the first program step in the program view
window). The System Settings screen will appear. Enter the number of
rows and columns in the fixture and the X and Y distance between the
parts. (Columns = X axis and Rows = Y axis.) Save and close the
Program.  Start �New Session." (This is not a necessity but it�s good
practice clear any unwanted datum�s.)
Skew and zero on the first part.  Now run the program. The program will
loop and reset the datum by the offset specified. The program will
measure in a Serpentine scan path. That is, it will measure all the
columns of a row, and then move up and do the next row.

Manual Execution Mode
Manual Execution Mode pertains to CNC option only. If your system is
equipped with the CNC option, please refer to the CNC manual.
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Lock
This locks the program -- A locked program cannot be edited in any way
and only opened by entering the supervisor password. The "Lock" will
initiate after closing the program. You can run a locked program by
choosing Run from the Program menu.

Times to Execute
This of course, is the number of times you wish your program to execute.
Using the keyboard, enter a number from 1 to 100.

Point Filtration
This enables the Point filtration function. Caution: Point Filtration can
remove valid data.   

What is Point Filtration?
The intent of this function is to allow Video Edge Detection programs to
measure similar parts more repeatably by automatically removing Outlier
points from measurements. For example: Some applications require very
high magnification. This sometimes will pick up dust particles as points.
Point Filtration will remove these undesired points or "False" edges.

Here's the catch -- The removal of these undesired points may also
cause valid data to be lost. Caution should always be taken when using
the Point Filtration function. (See Figure 7-13)

"How does the filtering work" you ask? The system calculates a threshold
based on two times the standard deviation of error and at least 10 times
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the encoder resolution. It then removes points beyond 2 sigma from the
mean and recalculates until no more points lie outside the threshold, or
25% of the points have been deleted. These points are removed from the
database and may not be recalled.
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Using Point Filtration
When the QC-4000 is shipped from the factory, access to the Point
filtration feature is locked and can only be unlocked in the Supervisor
setup under LOCKS.

Figure 7 - 13

After Point Filtration access is unlocked, the point filtration function can
be enabled in the "System Settings� screen (Double-click on line 1 of the
program view). Enable Point Filtration by left clicking on the Point
Filtration box, then press OK.
The point filtration function operates only during program execution (not
while recording or when doing non-programmed measurements.) A
minimum of 8 points must be present for the filter to be used in a
measurement. UP to 25% of the points may be removed by the filter.
Once these points are removed from the database, they cannot be
recalled.
In a measurement with normal distribution of errors (no outliers), about
one of every twenty points will be removed by the point filter function. The
Result window indicates if any point have been removed by filtration. For
more information on point filtration please refer to chapter 5.
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IMPORTING AUTOCAD DXF FILES INTO
THE QC-4000

1. The QC-4000 has the ability to read AutoCad DXF files although
some limitations apply. The information below should be read and
understood before importing any files.

2. The Tables section of the DXF file also is currently ignored.
3. Some programs that generate DXF format files may send arc

features as a polyline of many segments. This can quickly fill the
feature list with many short lines. In this case, the user should make
room in the feature list by constructing an equivalent arc within the
QC-4000 and delete the group of lines that make up the Polylines.

4. From the imported drawing, strip all points, lines, circles, arcs and
unwanted Polylines. Specifically, remove the border, title block,
dimension lines and arrows. These items will otherwise, be displayed
in the partview and listed in the feature list.

5. The Import function ignores the DXF File Header. Therefore, the
drawing must be drawn in the units that are to be imported and
without any scale factors. To import a drawing in inches, place the
QC-4000 in inch mode and import the DXF file. To import the
drawing in MM, place the QC-4000 in MM mode and proceed with the
import.

6. Auto Program from Features -- This is an advanced feature of the
QC-4000 and is used to program parts read in from a CAD "DXF"
file. In some ways, it will be easier to "Setup" the part program in the
CAD system before you import the CAD file into the QC-4000.
a. Be sure that the features of the drawing are in a 1:1 scale with

the actual part. Also be sure to place the origin of the drawing of
the part at the same datum point you will be using during the
measurement.

b. Put the features you want to measure on a separate "layer" of the
drawing, and export only those features to the DXF file.

c. If there are arcs and circles in the drawing, make sure that they
have not been drawn with Polylines. The program generator will
measure all Polylines as lines, not circles.
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EXPORT OF THE PART VIEW IN DXF FORMAT
The partview and feature list can be exported in the DXF format for
editing by a drawing editor. The resulting file will not contain the Tables,
Blocks, or Header section. The export file also will not include polylines;
they convert to lines and arcs during the import of the file.
Select the features from the Part View or Feature list, then from the File
menu choose Export to DXF.
Now that you have read the import and export information, please
continue to the next portion of the manual (Creating a Part Program).
Please feel free to refer back to this page whenever necessary. (This
information will not be mentioned in the proceeding pages.)

CREATING A PART PROGRAM FROM A CAD FILE
By now you have become familiar with the operation and programming a
system of the QC-4000. One of the key features of the QC-4000 is the
PART VIEW that acts as visual road map for repetitive part inspection.
Up to this point you had to create a part program by doing a first piece
inspection. There is a very powerful alternative to this method.

The QC-4000 has the capability of creating a part program from a DXF
file. A DXF file is a common format utilized by many CAD programs such
as AUTO CAD by AUTO DESK. This will dramatically reduce the amount
of time to create a part program. Here's how:

1. We have included a sample DXF file with your QC-4000 to help
demonstrate. The Quickie Slide is the sample DXF file.

2. Select NEW SESSION and then OK from the FILE menu.
3. Pull down the FILE menu and select IMPORT FROM DXF. A dialog

box will appear prompting the user to choose a file.
4. Double click on quicky.dxf
5. The part view will now fill up with a drawing of the quickie slide.
6. The quickie slide was drawn with the intersection of line A and B as

the ZERO point. This is fine for our demonstration, however, the zero
point can be moved anywhere on the part by constructing features on
the part view as we have done previously.
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7. Now hold down the SHIFT key on the keyboard, move the mouse
pointer over the features you wish to select and left click on all the
features in the part view that you want to measure. As the features
become selected they will chance color. For our demonstration select
circles C, D, line E, and arc F. (See Figure 7-15)

Figure 7 - 14

8. Now pull down the PROGRAM menu and select AUTO GENERATE
FROM FEATURES.

9. A dialog box appears and asks for the number of points on a line,
circle and arc. When the QC-4000 auto generates a part program
from the DXF it will evenly space the selected number of points for
each geometric feature. For example, enter 3 points for a circle. Now
when we run this program we will be prompted to take 3 evenly
spaced points on every circle.

Figure 7 - 15
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10. A dialog box now appears prompting you to name the program. Enter
CADDEMO then OK.

11. The program view will now appear. We have just created a part
program.

Figure 7 - 16

Run the Program
To run the program, first save and close program CADDEMO, then select
new session. Now place the Quickie Slide on the stage and skew on line
A. Measure line B and construct a zero point at the intersection.

Now pull down the PROGRAM menu and select RUN and CADDEMO.
The part view will fill with the features that we selected from the CAD
drawing and prompt us to measure the specified number of points on
each feature.

By using the program editing system we can add Tolerancing, print
commands and special steps to a program generated from a DXF file.
Remember, when editing tolerancing steps the nominal information is
already there. This information is required to create the part drawing.

NOTE: It is important that DXF files are drawn to scale. It is impossible
for the QC-4000 to create a correct part program unless the DXF is 1:1.
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Using Record Zoom In A Program
While performing an inspection routine, it may be necessary to take a
close-up look at a particular feature(s). Inserting this command into a
program after completing the zoom function, will conveniently store the
zoom into the program. This allows the operator to take a closer look
without pausing the program.
If your program contains a large amount of features, it may become
difficult for an operator to remember which features to zoom while
recording the program. It is recommended that the "Record Zoom"
function be Edited into a previously recorded program.
The "Record Zoom" function will zoom one feature at a time. So if you
want only one feature zoomed, you must record a "Zoom to Fit" after that
feature. If the "Zoom to Fit" is not performed, and Auto Zoom is selected
in Preferences, your feature will stay zoomed until after the next feature
is measured. If Auto Zoom is not selected, then only that feature will
remain in the part view until a Zoom to Fit is performed.
The following will walk you through a program using the "Record Zoom"
function.  Since you know how to write a program, the instructions given
will not be as detailed as before. If you need assistance recording a
program, please refer to the previous sections.
In this program Auto Zoom is turned on. For Demonstration purposes we
will call this program ZOOM. We will measure some features on the
Quickie Slide and Zoom one feature using the Zoom to Fit command and
one without so that you may see the difference.

1. Begin the recording of the Zoom program.

Figure 7 - 17
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2. Measure Line A, Circles B & C, and Arc D, then End Recording. (See
figure 18)

Your program should look like this:

Figure 7 - 18

Note: For a Record Zoom to work properly, the Zoom must be performed
first. After the Zoom is performed, it is recorded into the program.

3. Highlight Line 1 from the Part view or feature list.

4. From the View menu choose Zoom to "Line 1".

We want this to zoom while we measure it. This means we have to insert
the Record Zoom before the Probe Line step.

5. Highlight the step before Probe Line 1 -- System Settings.

6. From the Program menu, choose Record into "ZOOM".

7. From the View menu, choose Record Zoom.

8. From the Program menu, choose End Recording.

9. Now Select Circle 3 from the feature list

10. From the View menu choose Zoom to "Circle 3".

11. Highlight the step before Circle 3 -- "Probe Circle 2."

12. From the Program menu, choose Record into "ZOOM".

13. From the View menu, choose Record Zoom.

14. From the Program menu, choose End Recording.
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15. Select Circle 3 from the feature list

16. From the View menu choose "Zoom to Fit".

17. Highlight Probe Circle "Circle 3" from the program view.

18. From the Program menu, choose Record into "ZOOM".

19. From the View menu, choose Record Zoom.

20. From the Program menu, choose End Recording.

Your program should now look similar to Figure 7-20.

Figure 7 - 19

Run the program. You will notice that Line 1 will stay Zoomed until Circle
2 is measured. Circle 3 will zoom in to measure then Zoom to fit after the
measurement.

Note: If your part view is too small, it will automatically zoom out after the
measurement of line 1.
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Deleting Programs and Sessions
When you no longer need a program or session, you should delete it to
make the disk space available for other programs. Always use caution
when deleting a program or session.

The deletion of programs or sessions is accomplished using the
Windows File Manager. You should minimize the QC-4000 to an icon or
close it completely.

To delete a file, or group of files:
1. The File Manager is located in the Main window in the Program

Manager. Its' icon will look like a file cabinet. Double click on the
icon to open the File Manager.

2. Select the C Drive  from the status bar by clicking on it
once.

3. From the View menu, choose Tree and Directory. This will show
your directories on the left and all your files on the right.

4. Highlight the QC-4000 directory by clicking on it once. All the QC-
4000 files will appear on the right hand side.

5. Select the file or group of files you want to delete. Session files will
have an extension of .ses and programs with .prg.

6. From the File menu, choose Delete. The following screen will
appear.

7. Press OK. Another screen will appear to Confirm your choose.
Press Yes if you are sure that you want to delete that file.

You have now deleted a program. You can now exit the file manager.
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Programming Summary
In this section you have learned how to Create, Edit and Run a Self
Teach program as well as creating a part program from a CAD file.

The Auto Program from features is not limited to CAD files. It can also be
applied to previously recorded programs or a measured part that you did
not record a program while measuring.

Please reference "Points to Remember" while recording a program and
the Import DXF information. It will allow your programs to run smoothly as
well as making your programs adapt more easily to product updates or
other part programs.

You also learned how to use Record Zoom which you can apply to any or
all features measured within a program.

Deleting unwanted programs and sessions from the File Manager will
save disk space.





Chapter Eight

Reference Section

This section provides detailed information about the
functions and capabilities of the QC-4000 and expands

upon topics covered in the other sections.
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About this Section
This section provides detailed information about the functions and
capabilities of the QC-4000 and expands upon topics covered in the other
chapters.

What is a Session?
A dictionary definition for a Session is "a period of time spent in some
activity."  Thanks Mr. Webster, but the QC-4000 is a unique system, and
therefore, has its own definition.

Session - A screen in which the user spends time configuring and
customizing the QC-4000 for the measuring of his/her particular part or
parts.

The QC-4000 allows you to save and name a session with the "Save
Session As" command. This allows the user to always keep his/her
setup.

NOTE;   It is highly recommended that you use  "New Session" in the file
menu before you start to record a program, so that there is no part
reference frame or features in the system.

What is a Feature?
The geometric entities that you can generate with a QC-4000 include
points, lines, circles, angles, distances, and lengths. Each time you
complete one of these elements, you will have created a feature. Each
feature has different distinguishing information. For instance, circles have
a center and radius, angles have a degree reading, and points have an X,
Y location.
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Polar Coordinates
Polar coordinates offer an alternative way to display 2-dimensional
positional information.

Don't let polar measurement confuse you. Polar coordinates merely
change the way information is displayed, but it's still the same
information, just as 1 inch and 25.4 millimeters are two different ways of
expressing the same length.

In Cartesian coordinates, distance is expressed with a pair of coordinates
named X and Y. This is the system with which we are most familiar. In
polar coordinates, we also express a distance with a pair of coordinates,
but these are named R and A. These terms represent the radial (straight
line) distance and angle magnitude.

Surveyors use polar coordinates all the time. When land is surveyed the
plot is not defined by Latitude and Longitude (a version of Cartesian
coordinates) for all the corners of the property. Rather, it is defined by
polar measurement. The survey will read from boundary marker X23 (the
origin) northeast 36° 52' for a distance of 65.1 feet, and so on. This is
polar measurement, where distances are denoted by traveling some
distance in some direction from an origin. Surveyors use north a 0°, but
north isn't a standard direction when it comes to comparators. We use
the positive X axis as our 0° line.

Scientific convention dictates that we use the counterclockwise direction
(left hand rule) to measure angles. So if you swing from the positive X
axis around past the positive Y axis the angle increases.

Polar measurement can be very useful for things like straight line
measurements (when the line isn't aligned with the X or Y axis of the
part) and for quick angle measurement.
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Datuming
When creating a part program, or just measuring a few parts, it is very
important to establish a reference point. The QC-4000 allows for
establishing Datum's or Part Zeros. The QC-4000 will also allow for Part
Skewing. This enables an operator to set a part on the stage and
mathematically correct for the offset angle of the part as it sits on the
stage. This eliminates time consuming manual alignment and enables
more accurate part inspection.

Frame Command
The FRAME command is used to Skew a part and establish an Absolute
Zero for the X and Y axes. This routine will skew the part from the first
probed line. The user will then be prompted to probe a second line. The
vertex point of these two lines will then become the absolute zero. These
features will be added to the part view and feature list. The Title Bar of
the DRO will indicate that the part skew has been established from the
first measured line of the FRAME procedure.

Note: Constructing a FRAME can be accomplished by using the SKEW
and ZERO function under the DATUM menu.

Now let's walk through Probe Frame procedure.

1. Select Probe Frame from the DATUM menu. You will be
prompted to probe a skew line.

2. Probe the first line, then press "OK." You will be prompted
to probe a second line.

3. Probe the second line, then press "OK."
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The Frame command is now complete and all future measurements will
be relative to the vertex point. The Part View, Feature list and DRO have
all been updated. (See figures 1, 2 and 3.)

Frame Command (Figure 8 - 1)

DRO (Figure 8 - 2)

Feature List (Figure 8 - 3)

Note: A FRAME command is not allowed during part programming.
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Skewing
The Skew function is a very powerful and useful function that eliminates
costly fixturing and time consuming part alignment.

Note: To Unskew a part, choose "Use Machine" in the Skew dialog box.
(Refer to Use Machine later in this chapter.)

1. Select SKEW under the DATUM menu. A dialog box
appears, prompting you to probe or construct a Line.

2. Probe a line on the part in either the horizontal or vertical
axis.

3. Press "OK."

Line 1 ( Skewed )
Unskewed

Figure 8 - 4

The Skew function is now complete. The feature list will automatically title
Line 1 as Current Zero and Skew, and the DRO header will show which
line the user has Skewed on.

Note: To avoid confusion, try not to place the skew line of the part near
the 45 degree mark of your stage. ( See Figure 8-5).

YES NO

45˚

Positioning the part (Figure 8 - 5)
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Zero
To set a new ZERO point, you may use any method for probing or
constructing a single point. (See POINT measurement or construction.)
This will create a point feature on the feature list that can be identified as
"Current Zero." All future measurements will reflect the current zero.

One powerful application to construct a ZERO Datum, would be to use
the intersection of two lines.

Example:

1. Select Zero from the DATUM menu.

2. Select Line 1 and Line 2 from the feature list or part view by
holding down the SHIFT key while left clicking the mouse
button. (When the features are selected; they will turn blue).
Once you have selected the two features, press "OK."

Zero Point (Figure 8 - 6)

Once OK has be pressed, the QC-4000 will automatically create an
intersection point (Point 3) from the 2 lines and will appear on the feature
list as Current Zero. All features measured from now on will be relative to
this point.
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Use Machine
Machine Zero in actually the "Current Position" of your stage when you
turn on the QC-4000. The "Use Machine" button, that appears on both
the Zero and Skew functions, allows the user to Unskew and Unzero
his/her current zero or skew positions.

Figure 8 - 7

Figure 8 - 8

Once the "Use Machine" button is pressed, the Zero and Skew
commands under the DATUM menu will appear as:

Zero... I Machine

Skew... l Machine
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Set Machine Zero
The "Set Machine Zero" function is utilized in systems that are equipped
with the NON Linear error correction (NLEC) and CNC options.

With these options installed, it is essential to establish a Machine Zero in
order for correct and accurate part measurement.

When Set Machine Zero is selected, a screen appears, prompting the
user to go to the established machine zero points and press OK. (See
figure 8 - 9).

Figure 8 - 9

After the user completes this function, he/she will be able to quickly and
accurately measure features and/or create fast and easy part programs.

Note: If Reference Marks are enabled, you will be asked to Cross your
Reference Marks.
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Multi-Point Measurements
When you measure a circle, any three non-collinear points are sufficient
to fully define that circle. So, when you use 50 points to define a circle,
what happens to the other 47 points?

Every point is weighted equally and counts no more than any of the other
points. The first three points are used to form a "guesstimation" of the
circle.

In effect, the circle is "shifted" around until its circumference is as close to
every point as it can be. Any further shifting to better accommodate a few
points would lead to greater distances from other points.

One reason for using more than the mathematically needed 3 points to
measure a circle is to average out unavoidable inconsistency. Using
three points to measure a circle means that each point contributes
approximately 33% to the answer; using 50 points gives each point, on
average, a 2% weight. Any single stray point will not severely change the
measurement of the circle as a whole.

Similarly, a part with rough edges would be difficult to measure accurately
without the QC-4000's Multi-point capabilities. When more than 3 points
are used, a rough edge can be measured with greater repeatability.

This entire discussion can be applied equally to all multi-point features.
Pictured on the next pages are illustrations of the multi-point features:
angles, circles, and lines. (Although, to be precise, angles are relations,
not features.)

The quantization error that exists in all geometric measuring systems
also exists in the QC-4000 system. A small arc less than 90 degrees may
cause a repeatability problem (similar to measuring a small arc on an
overlay screen versus measuring a complete circle). An arc less than 30
degrees may cause serious repeatability problems. The very short legs of
angles may also induce an error factor into the system calculation
capability.
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The following chart shows the mathematical effects of the number of
points taken on a circle with a radius of .250" and .00008" (2 Micron)
resolution scales. (This chart assumes no system error). As you can see
the average error above 90° arc is the scale resolution and the
repeatability of the calculation is +/- 1 count of the scale.

Circle Radius = .250"  Encoder Resolution = .00008" (2 Micron)

Degrees of Arc Segment

10° 30° 45° 60°
Points Mean Max Mean Max Mean Max Mean Max
3 .0060 .0186 .0007 .0020 .0003 .0009 .0002 .0006
4 .0053 .0174 .0006 .0018 .0002 .0008 .0002 .0004
10 .0041 .0143 .0005 .0017 .0002 .0007 .0001 .0004
15 .0035 .0126 .0004 .0015 .0002 .0006 .0001 .0004
20 .0032 .0107 .0004 .0013 .0002 .0006 .0001 .0003
30 .0027 .0108 .0003 .0010 .0002 .0005 .0001 .0003

90° 120° 180°
Points Mean Max Mean Max Mean Max
3 .0001 .0003 .0001 .0002 .0000 .0001
4 .0001 .0002 .0001 .0002 .0000 .0001
7 .0001 .0002 .0001 .0002 .0000 .0001
10 .0001 .0002 .0001 .0002 .0000 .0001
15 .0001 .0002 .0001 .0001 .0000 .0001
20 .0001 .0002 .0001 .0001 .0000 .0001
30 .0001 .0002 .0000 .0001 .0000 .0001

Unless shown differently, the numbers in this chart are shown to the
nearest .0001" because of Metric scale resolution.

Mean = The average true position of the calculated circles center for 0,0.
Max = The total repeatability error that can be expected from the

calculated circles' center.
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Find Feature
By now you're probably familiar with most of the basics of the QC-4000--
how to open, close and save sessions and programs. This section will
teach you the convenience of the Find Feature command.

Trying to find a particular feature by scrolling through a very long list of
features could become very tedious and time consuming.

Being able to find and select a single feature or certain type features
without having to scroll through the feature list is an important time-saver.
The Find Feature command finds and selects one or all features you
specify, making it fast and easy to locate the features you want.

To search for a feature:

1. From the EDIT menu, choose Find Feature. The Find Feature 
dialog box will appear (See figure 13).

Figure 8 - 10

2. Type the feature name you wish to search for, then press ENTER 
or left click on the Find button.

Use wildcards (*.*) to initiate the search for all features of a specific type.
Example: Type Circle*.*  to search for all circles listed in the feature list.
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Specifying Search Criteria
Some part measurements or programs can be quite long, resulting in a
rather lengthy feature list. Choosing the Find Feature Options button
provides a convenience alternative to scrolling through the feature list to
find and select specific features. By specifying certain criteria's for
features that have similar coefficients or a specified coefficient range, you
can pinpoint the exact feature or features you want in a flash.

Feature Types
One of the question you must ask yourself when using the find feature
command is -- "What Feature Type shall I choose?"  Various ranges and
types can be selected. It is also possible to select one certain criteria,
then go back and ADD another without losing any of the other features
already selected. (See "Adding and Removing Features")

The following is a list of Feature Types you can select. Only one can be
selected at a time. Left clicking on the word will fill the circle next to the
feature type. In this sample, Circle is the feature type that is selected.
This means that all Circles on the feature list will be selected, unless
certain criteria's apply. See Logic Operators.

Selected feature type !

Find Feature Types (Figure 8 - 11)

If All is selected, then all features or all features with a specified criterion
will be selected on the feature list.
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Logic Operators
The logic operators are used to select the specified feature or coefficient
range. For example, by selecting the equal sign in the distance column,
and choose the Distance Feature Type, you can find all Distances with a
length equal to 1 inch.

The following table helps explain how the Find Feature Options window
works.

Greater than or
Equal to the #. Coefficient Less than or

Equal to the #.

Greater than the #. Coefficient Less than the #.

Equal to the #. Coefficient Equal to the #.

Not equal to the #. Coefficient Not equal to the

#.

The Find Feature Command also allows the user to choose a specific
feature number or a range of features. In this sample, we are looking for
features numbered 1 to 10.

1 Feature # 10

The Logic Operators in the Feat.# box can also be changed to Greater
than, Less than or Equal to. This will allow you to select a single feature
or a range of features.



Chapter 8 Reference

8-15

To find specified features:

For this demonstration, we will find all Circles having a radius equal to (=)
1 with a +/- Tolerance greater than (<)  .005.

1. Choose the Options button in the find feature display window. The
following screen will appear.

Find Feature Options Screen (Figure 8 - 12)

2. Choose the Circle feature type.

3. Left click on the right logic operator beside the word Radius until
just the equal (=) sign appears.

4. Type 1.0 in the box to the right of the button.

5. Left click on the left logic button beside the +/- T until just the
greater than (<) sign appears.

6. Type .005 in the left column beside the +/- T.

7. Press OK.

The QC-4000 will now search the feature list for all circles with the
Radius of 1 and a tolerance greater than .005.
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Adding and Removing Features
The Find Feature Option allows more than one type of feature or criteria
to be selected. You can also deselect features that have been chosen
previously.

Since all circles with the Radius of 1 and a tolerance greater than .005
are selected, let's go back and include all features that have a tolerance
greater than .005.

Adding other Criteria.
1. From the EDIT menu, choose Find Feature. The Find

Feature dialog box will appear.
2. Choose the Options button in the find feature display window.
3. Choose CLEAR to erase any unwanted numbers.
4. Select ALL from the Feature Type column.
5. Left click on the left logic button beside the +/- T until just the

greater than (<) sign appears.
6. Type .005 in the left column beside the +/- T.
7. Left click on the ADD button.

All features with a tolerance greater than .005 including circles with a
radius of 1 will now be selected.

Now let's remove all the Circles and just look at the tolerances.

Removing features
1. From the EDIT menu, choose Find Feature. The Find

Feature dialog box will appear.
2. Choose the Options button in the find feature display window.
3. Choose CLEAR to erase any unwanted numbers.
4. Select Circle from the Feature Type column.
5. Left click on the left logic button beside the +/- T until just the

greater than (<) sign appears.
6. Type .005 in the left column beside the +/- T.
7. Left click on the REMOVE button.

All circles with a +/- T of .005 will be deselected from the feature list.
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Tolerancing
Tolerancing a feature allows the user to determine if the position and size
of the feature(s) is in accordance with blueprint specifications. The
Tolerance button can be found in the Results Window.

The QC-4000 has the capability of doing full feature tolerancing including:
Cartesian, True Position, Maximum Material Condition (MMC), Least
Material Condition (LMC), Runout, Concentricity, Circularity, Angle,
Straightness, Parallelism, and Perpendicularity.

Although you can tolerance a feature with as few as 10 points, it is
recommended that you enter as many points as feasible to insure
accurate tolerancing.

Different feature types have different tolerancing data. The following
paragraphs will go through the allowed tolerances for each feature.

Valid Tolerance Types (More than 10 points)

FEATURES ALLOWED TOLERANCES

Point Cartesian, True Position

Line Angle, Straightness, Parallelism, Perpendicularity

Circle Cartesian, True Position, MMC, LMC, Runout
Concentricity, Circularity.

Arc Cartesian, True Position, MMC, LMC, Concentricity,
Circularity.

Distance Width (X, Y & L)

Angle Angle
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Tolerancing Information

Cartesian Tolerance Screen (Figure 8 - 13)

Each tolerance program step includes the following information:

1. Nominal values.

2. Tolerance values.

3. Print/Pause directive.

4. Tolerance Name

• Once a Tolerance Type is selected, you must enter the nominal
values for the X, Y position and radius or diameter (when tolerancing
circles).

• The tolerance values may be entered as either plus and minus
values or as the dimension maximum and minimum (+/- Limit).
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• The Print/Pause directive is identical for all tolerances. This may be
set to either PRINT or PAUSE after each tolerance for both the PASS
and FAIL conditions. Left mouse click on each directive to
enable/disable the condition.

Note: If PAUSE is set, then, when running programs, continue after the
pause by press the Continue button in the tolerance screen.

• Assigning names to frequently used tolerance values will save the
user a considerable amount of time. The user just selects a
previously saved tolerance name and the values will automatically
appear in its proper designated area. A feature name can be used for
different features so long as the tolerance type is the same. Please
refer to "Tolerance Type" later in this section.

After tolerance values are entered, just type a name in the Tolerance
Name box. Up to 20 characters can be used to identify a tolerance.
When assigning a tolerance name, it is recommended you use
characters that will show a relationship between the tolerance values
and its name.

Once a tolerance name has been created, the values can no longer
be edited. You can however, delete unwanted tolerance names.

To Choose a previously named tolerance:

*  Left-click on the down arrow at the end of the box. A list 
of available names will appear. Left click on the appropriate 
one.

You can also select tolerance names using the keyboard. Tab
over to the box then use the down arrow key on your keyboard.

To Delete a Tolerance Name:
* Choose the tolerance name as mentioned above.

* Press the Delete Tolerance button (Del Tol).
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Tolerance Types
There are several different types of tolerances. The QC-4000 follows the
terms in the ANSI Y14.5M Specification for Location, Orientation, Size,
Runout and Form Tolerances. However, when applied to discrete point
measurements, the QC-4000 is unable to conform totally to this code.
Please read the Disclaimer below.

DISCLAIMER
Some types of measurements (straightness, flatness, etc.) is difficult to
perform on the Optical Comparator or CMM because of the relatively
small number of points that are used to measure (estimate) a feature. In
addition to this problem, the specific definition of these terms in the ANSI
Y14.5M Specification (Dimensioning and Tolerancing), is subject to some
interpretation when applied to discrete point measurement. There are, in
fact, other methods for calculating fit that may be used to determine
feature form. One example is the "largest Inscribed/Smallest
Circumscribed circle. This method duplicates the pin or ring gage
technique used to measure the size of pins or holes. For further
information refer to ANSI B89.3.1.

Tolerance of Location
Tolerance Locations are relative to the current incremental zero and may
be "Cartesian," "True Position," "LMC" or "MMC" type. In the QC-4000
system, these tolerances are applied to points, arcs or circles.

Before a tolerance test is applied, the nominal position of the feature
must be entered. Then the actual position is measured and compared
and the tolerance report is displayed. The feature position is always
displayed in relation to the current datum which is either absolute or
incremental zero. This same position data is used when the tolerance
tests are done. Always be sure that you enter the nominal position in
relation to the appropriate datum.
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Concentricity (shown below) is just one example of a Location Tolerance.
This figure is a visual representation of what the concentricity tolerance
screen indicates after a tolerance is performed.

Figure 8 - 14

Size Tolerance
Distance is an example of a Size Tolerance. This function works in
essentially the same way as the POINT Cart Tolerance. When a distance
is generated by probing, construction, or the CREATE function, and
"Tolerance" is selected (with the distance as the current feature) the QC-
4000 will display the same tolerance screen as in POINT Cart except the
screen heading will read "Distance Width Tolerance". As in POINT
Cartesian Tolerances, you must enter the Nominal position, the plus and
minus values or the dimension maximum and minimum. The missing
fields will be filled in automatically.

Width Tolerance Screen (Figure 8 - 15)
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Orientation Tolerances
The Orientation tolerance for lines gives and estimate of how parallel,
perpendicular or angular a LINE is compared to the datum alignment. We
say estimate because when a line is measured, the line itself is estimated
(by the least squares best fit method) and the datum alignment is also
estimated. The same limitations apply to the RUNOUT tolerance for
circles.

The least squares best fit method uses discrete probed points. If a larger
number of points are used, we can apply statistics to the point data
information and get a more practical measure of orientation. For any
critical tolerance, a minimum of fifty (50) points should be taken when
probing the feature.

Note: The least squares best fit method is used to estimate part
alignment, therefore, it is a good idea to use a large number of points
when doing the part alignment.

The screen for Parallelism and Perpendicularity are the same (except for
the heading of course).

To perform a LINE Orientation Tolerance:
1. Probe a line using at least 10 points (more is recommended).

2. Select the appropriate tolerance type from the Results
Window. The tolerance screen will appear.

Tolerance Setup Screen for Parallelism(Figure 8 - 16)
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3. Indicate your choice for Print/Pause for any tolerance.

4. Enter the nominal value. This is the width of the "Tolerance
Zone" which defines the parallelism or perpendicularity.

5. Enter the feature is which it will be referenced by, or press the
SELECT button to choose the feature from the feature list,
then press OK.

The orientation tolerances are displayed as well as the PASS/FAIL
condition. Press "Continue", to proceed to the next measurement or "Edit
Tol." to (you guessed it), Edit the Tolerance.

Result Screen(Figure 8 - 17)

RUNOUT tolerance for a circle is performed in essentially the same
manner as that for the parallelism/perpendicularity of a LINE. The same
types of statistics are used for the points that were probed on the circle.

The next page shows a visual representation of how Parallelism,
Perpendicularity and Runout are determined.
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Form Tolerance
Form Tolerance is method of estimating the straightness of a line or the
roundness (Circularity) of a circle. Please refer to the "Form Disclosure"
at the beginning of the Tolerance section.
This type of report displays statistical information for two different fitting
algorithms. The fitting methods are "Least Squares Best Fit" (LSFB) and
"Constrained Best Fit" (CBF).
The LSBF is the method used in virtually all Optical Comparators. In this
method, all the points used in multi-point measurement are treated as
being equally important. The resultant feature is an "average" of all the
points. With LSBF a line is calculated which minimizes the sum of the
errors of all the squares.
The CBF is another, equally valid, method of estimating the position and
size of features. In this method the "high and low" points which were
probed on the feature surface, are used to calculate the best fit. With
CBF we are calculating a line for which the worst error is minimized.

GROUP TOLERANCING
The QC-4000 also allows the user to perform group tolerancing. This is
generally used as a programming step when creating a program. It does
not show "group" results, but will show the tolerance results of each
individual feature when the program is run.
This is where the Find Feature command under the Edit menu, comes
in real handy. By choosing Find Feature and selecting the Options button,
you are able to select specific features to tolerance. If you have one
hundred circles to tolerance, using the Find Feature command will find
and select all the circles necessary for you. It definitely beats having to
select them out of the feature list one at a time. (Refer to the Find
Features section).
After completing all the measurements in the program, simply select the
features you would like to tolerance, then select Tolerance All from pull-
down menu in the Results Window, and select the tolerance type from
the second pull-down menu. When your program is run, you will get the
results for each feature toleranced.
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About Print/Pause Pass/Fail
When performing a Group Tolerance, the Print/Pause command
becomes a tri-state control. In other words the check box can have one
of three choices:
1. Clear - Set all tolerances in the selected group to OFF.
2. Checked - Set all tolerances in the selected group to ON.
3.     Grayed - Leave all tolerances in the selected group to the state

that they are currently in.

To perform a Group Tolerance:
1. Create a program.
2. After all features are measured, select features you wish to tolerance

from the feature list or by the Find Feature command. and press OK.
3. Select Tolerance All from the Results Window.
4. Select tolerance type from the pull down menu.

5. A group tolerance screen will appear.

Group Tolerance Screen (Figure 8 - 18)
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Notice that in this screen; the "Nominal" box already contains asterisks
(*). This is because the features that have been selected have different
nominal values.

Note: When performing a group tolerances, the Nominal box should be
filled with asterisks.

6. Choose your tolerance dimensions and the Print/Pass directive.
7. Press OK.
8. End Program.

USING TOLERANCE IN A PROGRAM
By now you should be able to record a program like a Professional. This
portion will walk you through a small tolerance program so that you may
see for yourself how easy Tolerancing can be with the QC-4000.

Start recording a program and measure the large circle on the Quickie
slide. Remember, you should skew and zero the part before measuring
the circle.

Once the Circle measurement is completed:

• Select the circle so that it appears in the results window.

• In the results window, you will see a "Tolerance" button. Left-click
the button. A menu will appear with the various types of Tolerancing.

• For demonstration purposes, select CARTESIAN. The Cartesian set
screen will now appear (See figure 22). Note that the nominal for the
X and Y coordinates and the radius and diameter are the actual
values from the features just measured.

• The X coordinate nominal box should be highlighted. At this time,
enter the nominal dimension from the blue print. (Use the QC-Quickie
Slide as your print, located at the end of this chapter.)

X = 3.000 inches

Y = 0.500 inches
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Figure 8 - 19

Note: When entering numbers using the keyboard, you may use the tab
key to get around the screen or use the mouse by placing the I-beam in
front of the number. Hold down the left mouse button and drag the
mouse to highlight the number; then type the number from the keyboard.

• Now tab over or use the mouse, and go to the X +TOL box. Enter
.005. For demonstration purposes, we will use .005 as our limits.

• Now tab over to the X -TOL box and enter .005.

• Tab over to the Y + and - boxes and enter .005. This will establish
our upper and lower limits.

• Now tab down to the nominal RADIUS box.

• Enter the nominal dimension from the Quickie Slide of 0.250
inches.

• Enter 0.005 in the + and - TOL boxes.

In the Action Setup area, be sure that both PAUSE PASS and PAUSE
FAIL are selected. An X in the box indicates they are selected and will
allow you to view the tolerance results.
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• Press "OK." The Tolerance results screen will appear. Notice the
green and red warning lights indicating whether the feature passed or
failed.

• To continue recording, press the CONTINUE button.

• End Recording.

What happens when the program is run?
When a toleranced feature is measured, the tolerance calculation will be
done. If the tolerance data specifies that the program should pause on
PASS or FAIL conditions, the tolerance report will be displayed, If print on
PASS or FAIL is specified, the report will be printed. Press Continue to
proceed.
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Results Screen (Figure 8 - 20)

When Tolerancing Remember:
• A minimum of 10 points is need to perform tolerances.
• Tolerance values must be entered as plus & minus values or as

dimensions MIN/MAX.
• Print/Pause command is identical for all tolerances.
• To save time, assign names to frequently used tolerances. The

names can contain up to 20 characters.
• Using the "Find Feature" command can save valuable time when

performing Group Tolerances.
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Tolerance Report Sample
The tolerance report shows the nominal values, the actual feature
coefficients, the deviation from the nominal, and the PASS or FAIL
condition. For CIRCLE tolerances, the report also indicates whether the
size tolerance passed, whether the position tolerance passed and, for
MMC and LMC, whether the CIRCLE feature passed overall.

QC-4000 Feature Print Out

Quickie Printing
30 Anywhere Road

Someplace, USA 03110
Date: 7-27-93
Job: Printout Part: QC Quickie

Time: 3:12 p.m.
Operator: Q.T.

FEATURE ACTUAL NOMINAL FLG DEVIATION FORM

True Pos
Point 1

Inch
X  =   -0.6066
Y  =   -0.5450

  -0.6066
 -0.5450

0.0000  P

+T  =   0.0000
-T  =   0.0000

0.00'00"  PLine 2
Angle
Inch

Circle 3
MMC
Inch

+T  =   0.0000
-T  =   0.0000

A  =   90.34'28"   90.34'28"

X  =   -0.5492
Y  =   -0.1529
R  =   -0.0925
D  =   -0.1850

   -0.5492
   -0.1529
   -0.0925
  -0.1850

0.0000  P

0.0000 
0.0000  P
0.0100 Bonus  =

Bonus + Dia. = ***********P
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Report Header

Report Header Screen (Figure 8 - 21)

There are two ways a feature printout can be generated. The first is the
"Print Selected Features" function and the second is the "Report"
(wizard), both of which are located under the FILE menu. No matter
which format you are using, you can customize the information on your
Report header.

Selecting Report Header from the File menu will bring up the Report
Header screen (See Figure 8-24). Choose the field types you wish to
appear on your header, then using the keyboard, type the information as
you want it to appear.
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Print Selected Features
It is very important to understand the differences between "Print Selected
Features" and Report Wizard.

• Print Selected Features allows you to print one feature at a time or
several selected features.

• Unlike the Report Wizard, the Print Selected Features printout format
is a fixed format and cannot be customized. (Except the Header).

• This format does not include an automatic form feed. It must be
performed manually (on the printer) or by selecting the Form Feed
button from the report header screen.

• Normally, this format is to be printed out on an Epson compatible
printer. If you try to print this format on a laser printer you may get
garbage at the end of your printout.

To try the Print Selected Feature function:
Select a feature or several features from the feature list.

From the file menu select Print Selected Features function. (ALT F, R)

One of two standard printout formats will be used for these features
depending on whether or not the feature was toleranced (see figures 25
and 26 on next page).
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QC-4000 Feature Print Out

Quickie Printing
30 Anywhere Road

Someplace, USA 03110

Date: 7-27-93
Job: Printout Part: QC Quickie

Time: 3:12 p.m.
Operator: Q.T.

FEATURE DIMENSION FORM

+T  =   0.0000
-T  =   0.0000
+T  =   0.0000
-T  =   0.0000

# UNITS POSITION

1
pt

pts
2

3
pts

fts
2

point
Point 1

Line 2
line

Circle 3
circle
Dist 5
distance

Inch

Inch

Inch

Inch

A  =   90°34'28"

X  =   0.2972
Y  =   0.0030
L  =   0.2972

R  =   -0.0925
D  =   -0.1850

X  =   -0.6066
Y  =   -0.5450
X  =   -0.8448
Y  =   -0.0085
X  =   -0.5492
Y  =    0.1529

X  =   -0.8448
Y  =   -0.0085

Feature Print Out (Figure 8 - 22)

QC-4000 Feature Print Out

Quickie Printing
30 Anywhere Road

Someplace, USA 03110
Date: 7-27-93
Job: Printout Part: QC Quickie

Time: 3:12 p.m.
Operator: Q.T.

FEATURE ACTUAL NOMINAL FLG DEVIATION FORM

True Pos
Point 1

Inch
X  =   -0.6066
Y  =   -0.5450

  -0.6066
 -0.5450

0.0000  P

+T  =   0.0000
-T  =   0.0000

0°00'00"  PLine 2
Angle
Inch

Circle 3
MMC
Inch

+T  =   0.0000
-T  =   0.0000

A  =   90°34'28"   90°34'28"

X  =   -0.5492
Y  =   -0.1529
R  =   -0.0925
D  =   -0.1850

   -0.5492
   -0.1529
   -0.0925
  -0.1850

0.0000  P

0.0000 
0.0000  P
0.0100 Bonus  =

Bonus + Dia. = ***********P

Tolerance Printout Format (Figure 8 - 23)
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Exporting to Excel
As mentioned earlier in this manual, the SPC Link function can be used
to export features to other software packages. Exporting to Excel will
allow the user to print all the features out at one time or create a graph.

To Export to Excel:

1. Open Excel. Excel must be opened to export data from SPC link.
You can minimize Excel to an icon and still have it running.

2. From the QC-4000 select a feature. The SPC Link command
allows you to export up to eight features at one time.

3. From the File menu choose SPC Link. The following screen will
appear. (See figure 8-27) This screen will only appear once.-- The
first time during a session that a link is made.

Figure 8 - 24

4. Since EXCEL is the application we are using, type Excel in the
"Application Name" box.

5. If you have a previously saved file, you may type the name of the
program in the File name box. (Example -- Demo.xls.) If this is the
first time opening Excel and you do not have any files, you may
type book1 like in figure 4-27. (You can "Save As" later.)
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6. Press OK. A new screen will appear (See figure 4-28).

Figure 8 - 25

7. This screen is used to send certain feature information to a
specified column on the Excel data sheet. Choose the feature
coefficient and column from the arrow on the side of the box.

8. Enter the Row that you wish the coefficient to appear.

9. Press OK. The information will now be sent to the Excel
program that is open. Wasn't that simple?

Choosing the Options button will bring you back to the SPC Link Options
screen, to allow you to change your file name.

Note: The SPC Link function will allow 8 features but only one Feature
Coefficient to be exported at a time. It is advisable to name your Excel
worksheet columns the same as your feature coefficients to avoid any
confusion between them.



Chapter 8 Reference

8-37

DDE
Dynamic Data Exchange is a message protocol for data exchange
between Windows programs.
While Windows DDE is a very powerful tool, It is important to understand
some concepts and terminology before using DDE. Dynamic data
exchange is actually a �conversation� between two applications.
When using the QC-4000, we can simplify this explanation by
characterizing the two applications as, �The Talker�-- one sending a
command, and the �The Listener�-- the one responding to the command.

QC4000 RESULTS FEATURELIST
DRO STATUSBAR
PARTVIEW TOOLBOX

Each of the above can precede the following text:
.OPEN  - This opens the corresponding window.
.CLOSE  - This closes the corresponding window.
.MINIMIZE - This minimizes the corresponding window.
.MAXIMIZE  - This maximizes the corresponding window.
.RESTORE - This restores the corresponding window to a non

minimized/maximized size.
CNC.GOTO  - (X position units, Y position units, Z position units,
relative move). This causes CNC GOTO to happen. Units can be either
MM or Inch. Relative move can be either TRUE (Relative to Current
Position) or FALSE.

Example:
CNC.GOTO (1.25mm, 2.871mm, -3.411mm, FALSE)
PROGRAM.WAITFORCONTINUE
WaitForContinue causes a program that is running to stop at the current
step and wait for a Continue Command.
PROGRAM.CONTINUE
PROGRAM.RUN (Program name)
This runs the program given as a parameter.
PROGRAM.PAUSEPROGRAM
This will act as if the Pause Program menu item was pressed.
If you need more in-depth information about DDE, you may want to refer
to your Microsoft® manuals or contact the Microsoft support network.
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Supervisor Setup

Figure 9 - 1 SUPERVISOR SETUP SCREEN
The Supervisor Setup Screen is used to setup and calibrate the QC-
4000. These setups are performed at the factory and by your distributor.
Changing the parameters may cause severe degradation of your
system   

To enter the Supervisor Setup menu select "Supervisor Setup" under
the FILE menu. (ALT F, V). A message will be displayed, prompting you to
enter the special Supervisor Code. Supervisor codes are available only
through a dealer.

When typed, the password will appear as asterisks (*). Press OK.  The
Supervisor Setup screen will appear. (See figure 9-1).

This section will describe the specifics of the Supervisor Setup screen. It
is used to set such items as resolution, display, and to test your Axis, I/O
and Edge board.
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Display

Figure 9 - 2 DISPLAY SETUP SCREEN
As you can see, this is where you would 1) Set your display resolution, 2)
Set your DRO as Decimal Degrees (DD) or Degrees, Minutes, Seconds
(DMS), 3) Type of time (military or standard), 4) How the date will be
displayed on the status bar. 5) Set how you would like your features in the
Results Window to read.  

Axes

Figure 9 - 3 AXES SETUP SCREEN
This screen allows you to select your encoder type. Setting your Encoder
resolution has never been easier. Just left click on the arrow to the right
of the box, scroll through the selections and choose one for each axis.
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Figure 9 - 4 ENCODER OPTIONS SCREEN
The Options button is a second way to set Encoder resolution. It is also
where you would enable mm if you have a metric encoder, reverse axis
count direction, activate the 5X circuit, and enable the Reference Marks.

LEC

Figure 9 - 5 LEC SETUP SCREEN

Linear Error Compensation allows you to correct for small linear errors in
your stage. An error is linear if it is the same wherever you are on the
travel of your machine--if you find that you have 0.0002" error in 1 inch of
travel, you will have 0.0012" error in any 6 inches of travel.
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To use Linear Error compensation you must first have a reference
standard available for each axis of motion, namely X and Y. Next, you
need to measure this standard on your system, noting the measured
distance (or "observed Lengths"). If your measurement is repeatedly too
short or too long compared to the standard's length, then you need to use
LEC.

CAUTION: You must clear the previous error compensation from the
axis you wish to correct before you attempt to calibrate that
axis.

To clear LEC:
Enter a non-zero standard length (such as 1 inch) and then enter the
same number (1 inch) for the observed length.

If you have determined that you need to use LEC, measure your standard
in the X and Y axes to obtain your "observed lengths."

Once you have your numbers:

1. Choose Supervisor Setup under the File menu.

2. Enter the Supervisor Password when prompted. Then press ENTER.

3. Select LEC from the setup screen.

4. Enter the Standard and Observed lengths in the appropriate space.

5. Enable LEC by left clicking on the box.

6. Press ENTER or left click on OK.
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Axis Board Test
This initiates a self test of the Axis board circuitry. The self test checks a
large portion of non-CNC circuitry but not all. When selecting this test, a
message will appear. "Performing an axis board test will change the
current scale position and thus render any previous feature and datum
information incorrect. Do you still want to continue?"  Press Yes to
continue or No to exit the test.

If Yes is selected, the following screen will appear.

Figure 9 - 6 AXIS BOARD TEST SCREEN

What the screen is telling you, is that it has detected the X and Y axis, it
has run the test and passed 27 times. Select End Test to exit the screen.

If, out of several passes, the board fails only one time, end the test and
try it again. (It could have been a glitch.)

If all the tests pass, but there is still something wrong, check all your
cabling and connectors to insure proper seating and connection.

If the test failed several times, then there may be something wrong with
your axis board.
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NLEC
The Non-Linear Error Correction button will only appear if your system
includes this option. If so, please refer to the NLEC portion of the Options
Section.

Locks
The LOCKS button in the Supervisor Setup, allows you to lock (or
unlock) certain QC-4000 features. When these features are unlocked, it
is possible that they may fall prey to a curious user.

Figure 9 - 7

Lock Preferences - Some customers would prefer the QC-4000 to
remain in one particular setup. Enabling "Lock Preferences" would gray
Preferences under the File menu making it inaccessible to users. It can
only be unlocked by re-entering the Supervisor Setup and deselecting
"Lock Preferences."

Lock Access to Point Filtration - Point Filtration is enabled or disabled
in the System Settings step of the program view. Enabling this will lock
Point Filtration in the same state (enabled or disabled) which is selected
from the System Settings. Please refer to the Programming Section for
more information on Point Filtration.

The normal default for Point Filtration is Locked.
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Fixed Run Program Mode - Locking the Program Mode will only allow
the user to Run a program or Shutdown the QC-4000. The only other
menu selection from the File menu is the Supervisor Setup. Going into
the Supervisor Setup is the only way to unlock this mode.

Lock Calibration Data - Enabling this function will remove the Edit
Calibration menu item from the Probe menu. The user is allowed to
perform New Calibrations, but not allowed to edit any calibrations
previously performed.

Lock QC4000 at Full Size - This title may be a bit confusing. When this
is enabled, it will lock the QC4000 window at the same size as it is at the
time you selected the lock function. For example, if the QC-4000 is only
taking up half the screen and you enable this lock then, that will be the
size it will be locked in. (That will be considered �Full Size�) You will be
able to move and size all windows within the QC-4000, but you will not be
allowed to size the QC-4000 window itself.

CNC I/O Test
For Non-CNC systems, this is a footswitch test. This tells you if your
footswitch is connected and working properly.

When the CNC I/O test
button is pressed, the
following screen appears.

Pressing on the footswitch,
will change "Normal" to
"Depressed," indicating that
the incoming signal is
working properly.
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Edge IO Test
This button is for engineering purposes only.

Footswitch
This is the Footswitch setup screen.  Left clicking on the down arrow will
allow you to map Enter Point or Done Measurement to your footswitch.

Figure 9 - 8 FOOTSWITCH SETUP

Software Fence
The function is for CNC option only. Please refer to the CNC insert for
more information on Software Fence.

Machine Zero
Selecting this button will the allow the user to choose all or one axes to
establish a Machine Zero at Startup. After selecting the Axes, you must
shutdown the QC-4000 in order to initiate the �Set Machine Zero� prompt.

Each time you power up the QC-4000, the following prompt will appear:

�Goto your machine zero point
for the X, Y axes and press OK.�

Note: If Reference Marks are enabled, you will be prompted to cross
your X and Y Reference Marks.
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Print
If all your settings work well, we recommend that you print them out and
put them in a safe place for future reference. Once parameters are set,
do not change them.  Changing the parameters may cause severe
degradation of your system.

There are two different ways to print your settings. One method is to
press the Print button in the Supervisor Setup screen. Not everyone is
allowed to access the Supervisor Setup, so we recommend you try the
second method.

Second Method
From the File menu, choose About. The following screen will appear.
Please note that your software version, date and Installed Options may
be different than the screen shown here.

Choose View Settings. A Windows Application (NOTEPAD) will appear
with all the QC-4000 setup information. The QC-4000 will not recognize
any changes made to these settings, so don't worry if you accidentally
change something.

From the File menu choose the Print Command. This will send all the
information shown to a printer via the RS-232.
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Option
Overview

The QC-4000 may be equipped with the following options. These options
are available at the time of purchase or any time afterward. The
installation of some options for the QC-4000 systems may need to be
returned to the factory for reconfiguration of the software and hardware.
For additional information about many of these option, please refer to the
Options Section.

Not included in this section, will be additional information on the QC-CNC,
VED2 and Auto Focus options. These options have manual inserts of
their own and will be supplied with the purchase of that option.

TWO BUTTON FOOT SWITCH - A two button foot switch that will reduce
operator fatigue. The foot switch can be programmed it to "Enter a Point"
or as a "Finish" button, available at the tap of a foot.

ELECTRONIC PROTRACTOR - The Electronic Protractor displays stage
rotation via a Q axis on the QC-4000 screen. May also be configured for
linear display for use with a height gage.

NON-LINEAR ERROR CORRECTION - NLEC is a program that
automatically corrects for most non-linear measurement errors. Vibration
or differential expansion error is not corrected by this program.

OPTICAL EDGE DETECTOR - Edge Detector senses changes of light
intensity from the profile screen image and interprets the change as a
light to dark or dark to light edge crossing.

LIGHT CONTROL - This programmable option allows control of an
external light source. Up to 4 light control channels can be added.
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OPTIONS (CONTD.)

WINDOWS® BASED SPC - Affords internal process control, lets you
generate histograms, X-bar, Range and Sigma charts, and other
pertinent capability and process control data.

VED2 - Accurate, repeatable video edge detection in color or
monochrome for your video measuring machine, CMM or toolmakers
microscope. User-defined tools, set by using our unique Magic Wand®.
Tools include line buffer, nearest, farthest, average points, circle and arc
buffer tools and Auto Focus.

AUTO FOCUS - Is a multi-pass video based system which analyzes
image contrast. The focus location is determined by passing through
focus and then comparing the contrast of video images from in-focus and
out-of-focus. This system requires a motorized Z axis.

PC-CNC - "Hands-off" automatic part inspection for your QC-4000. High
speed repetitive inspection will dramatically increase productivity, when
coupled with optical or video edge detection. After first piece inspection,
measurement function and stage movements are driven by the QC-
4000's closed loop stage position system and take place automatically,
without operator intervention or subjectivity.

Q-CNC - Although it's not an autofocus, the Q-CNC will drive your focal
axis for measurements on different planes or allow you to do plannar
alignments on your part.
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Foot Switch
The one button foot switch allows the operator to utilize the QC-4000
without having to repeatedly press ENTER or OK. In other words, all point
entries can be made with the tap of the foot, without ever having to look
away from what you are doing.

The following steps describe how to set up the foot switch.

1. Attach the foot switch to the foot switch connector on the back of the
QC-4000. (See figure 10-1.)

Figure 10 - 1

2. Select Supervisor Setup under the FILE menu.

3. Enter the Supervisor code. Press ENTER or left click on OK.
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(The supervisor setup selections will now appear on the screen.)
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4. Left click on the FOOT SWITCH button. The foot switch dialog box
will appear.

Figure 10 - 2

5. Left click on the pull down menu to view the setting selections.

Figure 10 - 3

6. Left click the selection of your choice. Press OK to exit the Foot
switch Setup, then OK to exit the supervisor setup.

No meaning = Not in use.
Enter Point = Enter Pt on measurement window.
Done Measurement = OK on the measurement window.

The foot switch is now ready to work for you, entering points or
completing measurements at the tap of your foot.
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Electronic Protractor
The Electronic Protractor is an extremely useful option providing you
have encoders installed on your system. If the system is configured as an
optical comparator with a rotating screen, it becomes a rotary display. It
can be used for a screen rotation indicator or a linear movement indicator
on an appropriate gage.

A microscope is another configuration for the Electronic Protractor option.
Here the Q Axis is used as a linear display to calculate the Z travel
(simulating a height gage) plus having zeroing and information printing
capabilities.

The Electronic Protractor displays stage rotations using the Q axis on the
QC-4000's DRO. The Q axis is a 3rd axis in the QC-4000 which may be
defined as either a linear or rotary display.

NOTE: This axis is used for display purpose only and is not part of the
feature reference frame.

SETTING THE Q AXIS ENCODER (LINEAR OR ROTARY)

1. Select Supervisor Setup under the FILE menu.

2. Enter the Supervisor Code. Press ENTER or left click on OK.

3. Left click on the AXES button.

4. Select scale type from Q axis pull down menu. (See figure below)

Figure 10 - 4
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5. Select the Options button. The Encoder Options dialog box will

appear. (See figure below)

Figure 10 - 5

6. If you are using Linear encoder resolution, enter the resolution in the
Q axis dialog box. Then, press OK.

For Rotary Encoders do the following:

a) Left click on the TEACH button. The following screen appears:

Figure 10 - 6
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b) To teach the QC-4000 the Q axis resolution, enter the number of
degrees of rotation in the degrees box (usually 360). Align the
encoder to a known location and press Start. Rotate the encoder
through the specified number of degrees and press End. The
QC-4000 now knows the Q axis resolution.

c) Press OK to exit all setup screens.

Continue Reading

The following pages will contain a quick overview of NLEC, SPC, VED,
CNC and Edge Detector options. This will give you some idea on how
they work and will help you along until the released version of the manual
is published.
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Non-Linear Error Correction
The Theory

NLEC is different from our standard linear error compensation. Linear
error compensation is an incremental error compensation. With linear
error compensation, if you move along the X or Y axis, the linear error
compensation will add or subtract the appropriate correction factor for the
distance traveled. This correction is applied linearly along the full travel
of the axis. In contrast the NLEC allows you to have up to 30 different
correction factors per axis each with its own linear correction for that
segment.

NLEC works by dividing your optical comparator's area into a grid of up to
29 x 29 blocks. You choose the number and size of the grids. Each grid
area has its own compensation factor built in and the QC-4000
remembers each factor. This optional feature allows you to electronically
compensate for any inaccuracies that your optical comparator may have
developed.

The electronic correction grid must be physically tied to the machine
travel. For example, the correction for the lower left corner of travel is
only valid for that corner. In order to realign this electronic grid with the
physical travel of your machine, you must assign a landmark or
"Reference Point" on the machine. This point is called Machine 0,0.
Once NLEC is setup and enabled, the QC-4000 will automatically prompt
the user to GOTO Machine 0,0 when the system is turned ON.

NOTE: You must return to this same point and press ENTER every time
you turn your system on.

Please note the following:

• If a power failure should occur, the Machine 0,0 must be re-
established.

• If you get an axis error while take a measurement, it means your
NLEC has been corrupted. You must clear the error and start over at
0,0.
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NON-LINEAR ERROR CORRECTION
This section is intended for those who have purchased the NLEC option.
You may skip this section if you do not have NLEC. Your dealer will have
electronically compensated your system when he/she installed your QC-
4000. Therefore, this section is for informational purposes; however, you
may use it to perform periodic realignments if necessary.

The NLEC feature is a software program that will automatically correct for
most small linear measurement equipment errors such as axis
squareness or straightness. Linear errors caused by vibration or
differential thermal expansions are not corrected by this program.

As you know, optical comparators tend to need frequent adjustment to
maintain their accuracy. To correct this problem, NLEC lets you map out
the errors inherent in you comparator and remembers where these errors
are located. Each time you pass through an error the QC-4000
automatically adds or subtracts the appropriate error factor.

The NLEC program must be provided with correction data in order to do
its job. The following illustration shows a NLEC "Grid" as it might appear
on a typical measuring stage.

0,3 1,3 2,3 3,3 4,3

0,2 1,2 2,2 3,2 4,2

0,1 1,1 2,1 3,1 4,1

NLEC Grid ! 0,0 1,0 2,0 3,0 4,0

Figure 10 - 7: NLEC Grid
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Each small rectangle is delineated by four "stations." The grid may be
plotted for a maximum of 30 x 30 rows and columns. If there are 3 rows
and 4 columns, as in the proceeding illustration, then there are 20
stations that must be qualified; that is, each station is a point which must
be measured against a standard.

After NLEC setup is complete, the NLEC program corrects the DRO
display by using a weighted average of the error at each of the four
stations surrounding the current position.

Setting up NLEC
To properly set up NLEC, you should:

* Make sure you have established a "Machine 0,0."
** Start a "New Session"
*** Make sure that NLEC is NOT currently active.

Establish a "Machine 0,0."
To determine the grid location and station errors you must establish a
Reference Point. This reference point (Machine 0,0) is a convenient,
repeatable, known point by which the NLEC grid will be located.

a. From the DATUM menu select "Set Machine Zero" (ALT D, M). 
A "Goto Machine zero" prompt will appear

b. Place you crosshairs at the Extreme lower left corner of the 
stage movement (see the illustration), then press OK.

Start a "New Session."
It is always a good idea to start a New Session when performing any
calibration task. Don't worry, you won't lose your Machine 0,0.

a. From the FILE menu, choose "New Session." (ALT F, N).
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Make sure NLEC is not active
If NLEC had been previously setup and is active, you must go into the
setup screen and disable NLEC.

a. Choose "Supervisor Setup" from the FILE menu. (ALT F, V)

b. Enter the password.

c. Left click on NLEC (TAB, E). The following screen will appear.

Figure 10 - 8

d. Make sure the block next to NLEC On is blank; if not, left click 
on the block now.

Align Grid

The glass alignment grid must be "manually" aligned: with either the X or
Y axis. Before actually performing setup, be sure that NLEC is turned off
and then align the grid in its proper location as close as possible.

Once your grid is aligned, enter the number of grid points and block size
and go to town. See next page.
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Setting Grid Size
a) Enter the number of grid points for the X and Y axis. (In this

demonstration it will be 5 in the X axis and 4 in the Y.)

b) Enter the Grid block size. (1 inch in X and Y)

c) Left click on "Measure Grid..." (TAB, M)

d) Click on OK in the Supervisor Setup screen

Measuring the Grid
When measuring a grid, you must have a 0,0 point. This is the lower left
corner of the glass grid and is the first point that you calibrate when you
are using the normal automatic calibration procedure. The NLEC 0,0
point must be in the "most negative" corner of the grid. "Most negative"
means that if you move to the left and the distance displayed is
decreasing, then your NLEC 0,0 will be near the side where you run out
of grid in that direction.

Note: Establishing an NLEC 0,0 can be accomplished at any time during
this procedure. However, establishing your first point as the Zero will
eliminate any chance of duplicating the same point.

a) Select Zero from the DATUM menu.

b) Position your crosshair at the most negative corner of the grid.

c) Right click to enter a point or left click on Enter Point.

d) Left click on OK. You have now taken the first point of Station 0,0
and set NLEC 0,0.

e) Now select Measure Magic or Point measurement from the
Toolbox. Double click for auto repeat mode.

f) Position your crosshair at the next intersection point and take the
next point.

g) Select OK
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h) Continue to target all the intersection points on the grid. You

must take the exact amount of points as indicated in your setup.

Completing the Procedure
Once all the points have been targeted, you must return to the Non-
Linear Error Correction Setup display window. (See below)

Figure 10 - 9

a) Left click on "Import From Feature List..."

b) Turn NLEC on by left clicking on the empty box.

c) Choose OK to exit the Correction and Supervisor setups.

Non-Linear error correction is now complete. Choosing the Edit will show
you the offset or station errors from the notepad. If a printer is installed,
you may print a NLEC report by selecting "Print" from the FILE menu
while in the notepad.

Note: It is a general recommendation NOT to change any numbers within
the Edit screen. Use this only to view or print NLEC.
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Optical Edge Detection
Edge Detection Operation
If you did not purchase the Edge Detector Option with your QC-4000, you
may skip this section. It is included for the benefit of those who have
purchased an Edge Detector.

This section gives you a brief explanation of how Optical Edge Detection
works, explains how to hook up your edge detection to your QC-4000,
and illustrates several examples of additional functionality the Edge
Detector provides.

Before reading this section you should read Essential Information, The
QC-4000 Demonstration, and, if necessary, the Reference Guide. Please
refer to these sections when you need background information.

About Edge Detection
The QC-4000 may be purchased with an Optical Edge Detector which
greatly enhances your comparator or other projection-based measuring
machine. The Edge Detector senses changes in the comparator screen's
brightness and interprets such a change as a profile edge crossing.

The QC-4000 can recognize both light-to-dark and dark-to-light edge
crossings. Please note that the Edge Detector requires a consistent
bright and a consistent dark and as such, will only perform well in the
profile mode.

What is Optical Edge Detection?
Optical edge detection permits the QC-4000 to recognize different levels
of intensity of light from your comparator's view screen. Therefore, the
QC-4000 can determine exactly where you crossed a shadow on the
comparator's screen.



Chapter 10 Options

10-16

How Edge Detection Works
Two fiber optic cables are attached from the QC-4000 to your
comparator. One cable is for the Screen Sensor  that is connected to the
view screen and the other is for the Reference Sensor  that points directly
at the lamp.

The reference sensor automatically corrects for slight changes in light
intensity and filters out the A.C. noise common in projection lamps.

The screen sensor measures the amount of light directly beneath it on
the screen. The reference sensor provides a bright standard to measure
the screen sensor against. The sensors are attached to the comparator
using two fiber optic cables; the screen sensor connects to the viewing
screen and the reference sensor points directly at the lamp.

The Sensors
After setting up your QC-4000 according to the Operator's Manual,
examine the two black optic cables packaged with the QC-4000. Notice
that one end of each cable contains a curved metal piece. This curved
metal piece is the collecting end of the cable where the light from the
screen or lamp enters the cable. The other end of the cable, the
depositing end, plugs into your QC-4000.

Figure 10 - 10
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Connecting the Edge Detector to the QC-4000
When you order Edge Detection, you receive a separate shipping
container that contains the Edge Box, an interface cable, 2 Fiber Optic
Cables (2 meter for the Screen Sensor and 6 meter for the Reference
Sensor) and of course, a power cord.

On the back of your QC-4000, you will have and Edge I/O Card that
contains a 15pin connector (Edge) and a 44pin connector (Light Control).
(See figure below)

∗  Edge Detector Interface Box

Figure 10 - 11

∗  Edge Interface Cable [15pin (M) to 15pin (M) connector]

Figure 10 - 12

∗  QC-4000 Edge Input/Output Card

Figure 10 - 13
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Cautions about Fiber Optic Cables
1. The Fiber Optic Cable is not a wire and cannot be bent smaller than

a one inch radius without effecting its performance.

2. The cable has a maximum safe operating temperature of 100
degrees centigrade.

 
Connecting the Screen Sensor
1. On the front of the Edge Box, you will find two matching Photo

Diodes. Securely attach the 2 meter fiber optic cable to one marked
�SCREEN".

2. Enclosed with your edge box is a plastic ruler. The ruler is used to
hold the screen sensor in place against the view screen. Make sure
the hole in the plastic ruler is free of debris and your view screen is
clean.

3. Place the plastic ruler under your comparator�s chart clips so that the
small hole in the ruler is located over an unobscured portion of your
viewing screen.

4. If necessary, gently clean the collecting end of the screen sensor with
a soft lint free cloth.

5. Place the tip of the screen sensor through the hole in the plastic ruler
with the sensor�s metal tip flush against the screen. Be careful not to
scratch the view screen with the metal collecting tip.

6. Secure the optic cable to the ruler using the plastic stick-on clamp
provided.

Connecting the Reference Sensor
The reference sensor must point directly at the comparator�s lamp. One
way would be to secure the sensor on the outside of the lamp housing
facing inward. The other way is to place the sensor inside the lamp
housing.

The second approach is recommended, but the first is acceptable. Both
methods are presented following a description of the optic cable
characteristics.
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Placing the Reference Sensor Outside the Lamp Housing.
1. On the front of the Edge Box, you will find two matching Photo

Diodes. Securely attach the 6 meter fiber optic cable to one marked
�REFERENCE�.

2. The trick is to secure the Reference Sensor tightly enough so that it
cannot be moved by casually bumping the optic cables. There is no
easy method to do this because each comparator is different. The
Reference Sensor must point directly at the lamp and the excess
optic cable must be kept out of the operator�s way. Three methods
we have used are:

1) Using stainless steel hose clamps around the condenser
lens housing to secure the cable

2) Snaking the cable through the lamp housing and securing it
with nylon cable ties.

3) Drill 2 holes in the lamp housing and secure the optic cable
to it using a metal tie pulled through the holes. This tie �hugs�
the optic cable to the housing and point the sensor at the
light source.

The optic cable must be secure, receive plenty of light, and stay relatively
cool. Installing the cable so it receives cooling air from the lamp fan is a
good idea since the cable maximum operating temperature is 100
degrees centigrade.

Placing the Reference Sensor Inside the Lamp Housing.
In many cases, it is easier to place the sensor cable inside the lamp
housing but caution is required with respect to temperature. The same
general restrictions apply, and the installation must provide a stable
sample of the light source. This method provides a much cleaner
installation because the cable is completely out of the way of the
operator.
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Connecting the Edge Box to the QC-4000
∗  On the back of the edge box you will find a 15pin connector marked

�INTERFACE�. Plug one end of the 15pin cable into the connector.

∗  Plug the other end of the cable to the 15pin connector located on the
back of the QC-4000.

∗  Check the power switch and make sure that it is in the 0 (OFF)
position.

∗  Insert one end of the power cord into the back of the edge box, and
the other end into a grounded power strip or outlet.

Continuing On
This completes the basic Edge Detector installation. Be sure to check all
your connections and then continue with the next section.

Powering up the QC-4000 with Edge Detection
∗  Before you power up the QC-4000, you must turn on your Edge Box

by switching the power switch to the 1 (ON) position. When the QC-
4000 powers up (�boots�), it executes a series of commands. One of
the command functions performed, is to ensure that the edge is
turned on and connected to the QC-4000.

∗  If the Edge is not detected the following error message will occur
during power up:

Edge Detector is not responding. Please exit the QC4000 and make
sure all cables are connected and the power is on.

Checking the Light Source
To insure accurate edge crossings, it is very important that the light
source going into the edge detector is not too much or too little. (0 being
not enough and 12 being to much). The best results are achieved when
the numbers are between 3 and 8.
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To check the light level, select Light Level under the PROBE menu.

Figure 10 - 14

If it is above 11 or below 1, check to make sure that the depositing end of
the reference sensor cable is firmly connected to the lower optic
connector on the back of the QC-4000. If the number is still out of range,
perform the following steps:

•  If the number is below 1, not enough light entering the cable. Adjust
the cable so the collecting end is pointing more directly at the light
source. Continue adjusting the cable until the number is between 3
and 8.

•  If the number is 11 or more, too much light entering the optic cable.
Turn the collecting end of the cable slightly away from the light
source, so the number falls between 3 and 8.

You are now ready to calibrate the Edge Detector. This calibration is
called TEACH.

NOTE: TEACH should be repeated every time you turn on the QC-4000
and every time you change magnification.
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To TEACH the light levels to the QC-4000:

• Select TEACH from the Probe menu. The following prompt appears:

Move the edge sensor into a DARK area on
the screen and press OK.

• Once this is done, a new prompt appears:

Move the edge sensor to a LIGHT area on
the screen and then press OK.

The Edge Detector now knows the difference between the light and dark
on you screen.

Editing the Teach Command
Double-clicking on the TEACH program step allows the user to enter in
edge values manually. This is a convenience feature, and is typically
used when you want the exact same edge values for more that one
program.

Figure 10 - 15
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Teach to Master
The Teach to Master Calibration, fine tunes your Edge Detector to
properly read the �Fuzzy� non-distinct edges.

To perform a Teach to Master you must:

a) Enter the size of your standard,

b) Choose which axis you wish to calibrate,

c) Perform a Teach so the edge detector knows the light levels, and

d) Cross the edges on your standard.

This calibration procedure should be performed when the light source of
the comparator is not well columned.  For instance, if you change from
measuring a very flat part with distinct sharp shadows to a part with fuzzy
edges, you must perform a Teach to Master procedure. If you change
from highly reflective parts to dark non-reflective parts or vice-versa,
repeat the procedure.

You will need a sample part from those you are going to check. Position
the part on the comparator so it is aligned with the comparator�s axis.
Carefully measure the part using the crosshair (you must know the part�s
exact dimension).

1. From the Probe menu choose Teach to Master. A screen will appear
prompting the user to enter the standard and choose one axis to
calibrate.  (See below)

Figure 10 - 16
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2. Once the standard Size has been entered and a Cal. button selected,
a new screen appears prompting the user to �Teach� the edge probe.

 
3. Follow the instructions in the message window and press OK.

Figure 10 - 17

4. Again, follow the instructions in the message window and press OK.

5. Once OK is pressed, another message appears prompting the user
to Prepare for first edge crossing.  In other words, position the edge
sensor near but not over the first edge of the standard. This is to
avoid any improper edge crossings. Press OK.

Figure 10 - 18
 
6. A new message window appears prompting the user to cross the

sample part. If you selected �Cal. Using X," you must move the stage
in the X axis direction only (right to left). If �Cal. Using Y� was
selected, move the Y axis only.
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Figure 10 - 19
 
 

7. Move the edge sensor across both edges of the sample part.
 
 

 
 Figure 10 - 20

 
8. Once both edges are crossed, The �Calibrate To Master� screen

appears. If the �Measured Size� is not exactly the same as the
�Standard Size," or if an incorrect point was entered, left click on the
Try Again button and cross the edges again.

 
9. Repeat steps 7 and 8 until the Standard and Measured Size numbers

are identical.
 
10. Left click on the Accept button.  The screen will disappear indicating

the Teach To Master procedure is complete.

If you can not get the numbers to match, your target value is too far from
the actual measurement.  Perform a �Teach� and repeat the Teach to
Master procedure.



Chapter 10 Options

10-26

Other Edge Features
Show Edge Detector
When the Show Edge Detector feature is enabled, you will see two (2)
position indicators on your part view. A small green circle will appear
along side the crosshair, indicating the edge sensor. When performing a
Teach, Teach to Master or Probe Offset, this is the indicator that you will
use to calibrate your edge.

Pictured below is a view of how your part view will appear when the Show
Edge Detector feature is enabled (without the descriptive words of
course).

Figure 10 - 21
To Enable the �Show Edge Detector�:

1. Select Preferences from the FILE menu.

2. Select Part View from the Preferences screen.

3. Left Click on the Show Edge Detector box under the Position
Indicator section.

4. Click on OK to exit the menus.

Edit Edge Point Measurements
The QC-4000 makes it possible to edit a program and change the
direction that the edge detector crosses the point.

Figure 10 - 22
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Double-clicking on the points� substep will enable the Probe Edge Point
screen. Use the arrows or enter the position change manually.

Figure 10 - 23

By adjusting the direction of the edge crossing, your part view can go:

From This To This

Figure 10 - 24

Note: To view the edge path, you must choose Show Path from the
Program menu.
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Probe Offset
The QC-4000 allows the user to switch back and forth between using
either the crosshairs or the edge detector. But to do this, the QC-4000
must know how far apart the edge detector's screen sensor and the
crosshairs are. This calibration must be done every time you move the
edge detector's screen sensor or change magnification. It is called
PROBE OFFSET.

To set Probe Offset perform the following:

•  Select Edit Calibration from the PROBE menu. The Calibration
dialog box will appear.

Figure 10 - 25

•  If you know your probe offset in the X and Y location, type the
numbers in, then press OK. But why not let the QC-4000 do the work
for you.

•  Left click on the LEARN button under the Probe Offset box. A circle
measure prompt will appear, instructing the user to Probe a CIRCLE
using the Edge Detector. (You may use any circle on the Quickie
slide to perform this calibration.)

•  Probe the circle using the Edge Detector and press OK.

•  A new prompt will instruct you to probe the same circle, this time
using the cross hairs.
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•  Probe the circle, then press OK.

The QC-4000 will now know the distance between the Edge Sensor and
the cross hairs. This allows the user to switch back and forth between
edge and cross hairs, and still obtain accurate measurements.

Force Teach
As mentioned previously, you will have to remember to do a TEACH each
time you change calibrations or turn your system ON. The QC-4000 is so
smart, that you can set it to do the remembering for you. This is called
Force Teach.

To enable Force Teach, perform the following:
• If you only have one calibration type listed, then select Edit

Calibration from the PROBE menu.

•  If more than one calibration type is listed, then select the calibration
session you wish to change making sure that there is a check mark
next to it, then choose Edit Calibration.

NOTE: If you wish to change calibration sessions, repeat the following
steps for each one.

•  Left click on the Options button in the calibration screen. The Options
dialog box will appear.

Figure 10 - 26

• Left click on Force Teach Yes, then press OK.

Now every time you change calibrations, the prompts will appear to
calibrate the edge detector.
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QC-4000 Light Control
This is an �option� that allows control of an external light source has been
added. The Light Control menu command will be located under the
Program, Special Steps menus. Up to 4 light sources may be configured
into the QC-4000 and can be added at any time.

Figure 10 - 27

The Toolbox
Configuring the toolbox with the light control features, is a fast and easy
way to adjust your lighting.

Figure 10 - 28
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Pressing  in the toolbox or selecting Light Control from �Special
Steps� under the PROGRAM menu will introduce the light control channel
screen.

Adjust the lighting by dragging the box in the scroll bar or clicking on the
appropriate arrow. This can also be used to insert a light control step into
a program.

Light control Quick- Sliders

Pressing buttons  through  will bring up the
light control quick-slides.

To adjust the lighting from a quick-slide, click and hold
down the left mouse button.

The only movement your mouse is capable of performing
at this time is the up and down movement you must make
to adjust the lighting.  Once released, the quick-slide will
disappear.
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Programming with light control
Light Control is a recordable program step. Click on light bulb in the
toolbox or select it from the Special Steps in the PROGRAM menu. We
suggest you record a light control step in the beginning of your program.
This will allow the user to adjust lighting for the entire program at one
time if necessary.

Figure 10 - 29

Double-clicking on the Light Control step in a previously recorded
program allows the user to re-adjust the lighting without �Recording Into�
the program. After pressing the OK button, the numbers within the
program will change.

Figure 10 - 30

Note: Although programmable, Quick-sliders will not be inserted into a
program step until another step is recorded (usually a measurement
step).
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SPC
Statistical Process Control

SPC - is an extremely powerful analysis tool. However, it has added
capabilities made possible by the Windows environment. For instance, up
to 120 different variables, attributes or Pareto classification can be
analyzed in a single data file in SPC.

One of the features found with SPC is the ability to view charts and data
on the same screen. This allows you to see changes on the control chart
when changes are made in your analysis options or your data file.

SPC give you simple, uncluttered menu selections.
Current analysis options Include:

• X Bar and R

• X Bar and Sigma

• Individuals Chart

• Histograms with Capability Analysis

• Pareto Analysis

• P Chart

• U Chart

• Np Chart

• C Chart

• CuSum Chart

• Multi-variate Analysis

• Moving Average Range & Sigma

The SPC option is a modified version of SPC-IV by Quality America , a
popular Windows based Statistical package. By using the SPC-LINK
command the QC-4000 uses D.D.E. (Dynamic Data Exchange) to
automatically transfer data into a data base.
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The chart portion of the SPC then uses this data base to calculate and
draw the statistical graphs. This gives you the advantage of running Real
Time, On-Line SPC. The SPC-Link commands may also be included in a
part program to be transparent to the operator. The flexibility of Windows
also enables you to resize the QC-4000 and have your SPC chart on
screen and updating every time you add data.

SPC DEMONSTRATION
By now you should be comfortable with using windows so we won't get
into a click by click (or step by step) routine.

The first thing we need to do is set up an application to accept the data
coming from the QC-4000.

To do this:

•  Double-click on the SPC-PC IV window to start the SPCWIN program
.

•  Then from the File menu open a New database. A "Create New Data
Set" window will open listing the available layouts.

•  Choose Standard Variables, then choose Create Data Set.

Figure 10 - 31
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You should now have an empty data base in the SPC window.

•  Select the DATA1 column.

•  Choose Column Format from the Edit menu.

•  Change the Title to RADIUS.

•  Set the Column Type to Numeric, the Width to 8, with 4 Decimal
Places, and the Sub-group Size to 3.

•  Choose OK or press Enter.

•  Save this Data Set as BIGCIR.QDB. (You can also use any other D
Base compatible extension EXAMPLE:BIGCIR.DBF).
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You have now created a data base to collect data from the QC-4000. At
this point you may close the data base, but SPC-PC IV must remain
running to interface with the QC-4000.

Performing the SPC Link
We are now ready to start measuring with the QC-4000 and Linking our
data to the SPC application.

•  Open the Demo Stage and start the QC-4000.

•  Measure the big circle on the Demo Stage. (See figure below)

Figure 10 - 23

•  From the QC-4000 File menu and choose SPC Link....

The first time you activate the SPC Link an SPC Link Options window
will appear. See figure below.

•  The Application Name for this SPC software must be SPCWIN.

•  For the file name enter BIGCIR.QDB (the same name we used for
the data base).

•  Choose OK or press Enter.

Figure 10 - 24
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If your SPC application has been setup properly you will now have an
SPC Link window.

•  For the Feature Coefficient select RADIUS from the pull down list of
available coefficients. This is the data we want to send to the SPC
application.

•  For the File Column select RADIUS, then press OK.. This is the
name we gave to the DATA1 column in SPCWIN.

Figure 10 - 25

When you choose OK, the radius of the circle that you measured on the
Demo stage will be automatically sent to the SPC application.

•  Measure the same circle again and repeat the SPC Link Command
until you have a sufficiently large sample of data to calculate an SPC
chart.  (In this example the circle was measured 36 times. You can
do it with less, but the more samples you have the more realistic the
results.)

Now we can go to the SPC application and create an SPC chart. You can
close the QC-4000 and the Demo Stage. For the rest of this
demonstration they won't be needed.
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Creating the SPC Chart

•  Go to the SPC application.

If you had closed the data base you'll notice that the SPC Link opened it
up again. Your application should look something like the picture below.

•  Move the cursor to the first line in the DATE column and press the
left mouse button to select this space.

•  Now press CTRL D and the date will be automatically filled in. Now
do the same for the TIME but press CTRL T.

Figure 10 - 26

The SPC application is capable of calculating many different charts.  For
this example we will do the X-Bar & R Chart. For other charts and
analysis refer to your SPC manual.
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•  In your SPC data base, highlight the RADIUS column.

•  Select X-Bar & R from the Chart Menu. A window will open,
prompting you for the Variable name, Sub-group size, Group
Range, Use Nominal Col, Chart Output, and type of analysis.

•  If everything was set up properly, the window will look like figure 10-
27. If you have something different, change it to match figure 10-27.

•  Then select OK or press Enter.

Figure 10 - 27

You should now have a Process Capability Options window like figure
10-28. The values you get may be different but don't change them yet.
These are the defaults for the values in the data base and the type of
analysis you chose. Once you've succeeded in producing an SPC chart
you can come back to this window and change the values to see what
effect it has on your chart. For now just select OK or press Enter.

Figure 10 - 28
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Well, if everything went according to plan you should now have a chart
similar to the one in figure 10-29. Don't worry if the curve or graph looks
drastically different then the example. Your results will only be the same if
your values just happen to match the ones used for the demonstration.

Now it's time to go back and play with the other types of charts. Be brave
and experiment a little, change some values and recalculate the charts.
And don't be afraid to pick up the SPC manual. It's full of useful
information about SPC.

To see all of the output clearly, it may help to click on the maximize
button when viewing SPC charts.

Figure 10 - 29

This concludes the demonstration of the SPC option of the QC-4000.  For
further information about SPC refer to your SPC manual.
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REPORT WIZARD
WHAT IS IT?
The Report Wizard is a powerful tool that has two primary purposes.
Primarily the report wizard is used to customize the print out of
measurement information. Think of the Report Wizard as a template
maker. It simply allows you to create a printout in any format that you
need. By using the Report Wizard you can customize the print out to your
exact requirements. Whether you need a special printout to conform to
your ISO 9000 specification or providing documentation to your
customers, the Report Wizard is the solution.

The other purpose of the report generator is to allow you to send data
directly from the QC-4000 to an ASCII file. This enables you to store
massive amounts of data in a file.

Another benefit is the ability to send data to a Statistical Process Control
(SPC) program that you may already have in use at your facility.

How easy is it to use?
As with many new concepts, it can be very confusing to the first time
user. But with a little practice, you will become a Whiz at making new
forms.

The Report Wizard template is similar to what you would find in a spread
sheet. You can size it, add columns, add a custom header, format the
data, output to files or a feature column. If you are familiar with windows,
then you know the basics of drop down menus. These work the same
way except that the menus displayed and the selections in them will vary
depending on the feature type selected in the feature column.

When you select a cell, you are really choosing a feature type from the
feature column such as Point NT (non-toleranced points), Circle TP
(circles with true position tolerance), etc. Depending on the feature type
selected, the data available from the drop down menus will apply only to
that feature type. The order that the feature appear in the feature column
is arbitrary and has no affect on printing. The order of printing is
determined by the order in which features appear in the feature list and
only the selected features will be printed.
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PRINTING FEATURES
There are two ways a feature printout can be generated. The first is the
"Print Selected Features" function located under the FILE menu. The
second is Report Wizard.

Before we get started with the Report Wizard, it is very important to
understand the differences between "Print Selected Features" and Report
Wizard.

•  Print Selected Features allows you to print one feature at a time
without form feeding.

•  When printing with the Report Wizard, one feature is also one page.

•  Unlike the Report Wizard, the Print Selected Features printout format
is a fixed format and cannot be customized. (Except the Header).

•  Print Selected Features format does not include an automatic form
feed. It must be performed manually (on the printer) or by selecting
the Form Feed button from the report header screen.

•  With Report Wizard you can select "Pre" or "Post" Form feed to be
performed automatically.

•  Normally, an Epson or Epson compatible printer is used with the Print
Selected Feature format.  If you try to print this format on a laser
printer you may get garbage at the end of your printout.

•  The Report Wizard is capable for printing to a File, Printer or
clipboard. You can use any printer that is compatible with you
Windows setup. Please refer to your Windows manual to set up your
printer.
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REPORT
The other method of generating a printout the Report function. Choosing
Report under the File menu will gain you access to the Report Wizard.

The QC-4000 is equipped with two Default templates. One for normal
feature printouts called Default.rpt, and the other for toleranced features
called Tol.rpt. These forms contain the most commonly used feature
coefficients.

Selecting the Edit Form command allows you to make changes in a
previously created form, and use the Save Form As command to create
a whole new form.

Let's get into the fun stuff and try to print using the default form. We will
assume your printer is properly setup and tested.

♦  Measure and select several features.

♦  Now choose Report from the File menu a dialog box will appear.

Figure 11 - 1 Report Setup Screen
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Browse
The browse button will prompt the "File Open" screen. This is where you
would select previously created reports by clicking on the report you wish
to open, then press OK. Since we haven't created any reports yet, the
only file you will see, is the default files.

Figure 11 - 2 File Open Screen

Edit Form
Choosing this will open the form that appears in the Report Form Name
box. The last form that was created will always be the one to appear in
this box. When you open Report for the first time however, "default" will
appear in the Name box.

You can also choose the Browse button to select a different form.

Printer
Sends information to printer via your printer port. Your printer is set up
through WINDOWS, not though the QC-4000.

File
Sends information to a specified file. Please refer to "Writing to an ASCII
File" section later in this manual.

Clipboard
Sends information to a Clipboard, used to transfer data between the QC-
4000 and other WINDOWS applications. (EXAMPLE: WORD FOR WINDOWS)
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Pre Form Feed
Will issue a for feed before the report prints

Post Form Feed
Will issue a form feed after the report prints.

Toleranced Features Only
Selecting this will print only features that are toleranced; even when non-
toleranced features are selected.

♦  For our demonstration please check off Printer and Pre Form Feed.

♦  Press OK.

♦  You have now printed out your first report.

If the Report did not print:
♦  Make sure that you have selected features in the feature list or part

view.
♦  Check you printer setup. Try to print with another application such as

NotePad.

Figure 11 - 3 Report Wizard Default Template
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CREATING A FORM
OK, so you don't like the default form. You need to have more information
or you may want Nominals followed by Actuals and Deviations while
others may want Deviation first followed by Actuals then Nominals.

With Report Wizard, you have complete control of the layout of your
report. Create your own form to suit your needs.

The following information will walk you through opening, creating, saving
and printing a new form. For this demonstration we will be printing to a
printer. Make sure your have setup and tested your printer.

1. From the File menu choose Report. The Report setup screen will
appear. For this demonstration, choose Printer and Post Form
Feed.

2. Now click on Edit Form. The default form (or the last form that was
created), will appear.

3. From the File menu, choose New Form. A template will appear and
is the starting point for creating your custom form.

Figure 11 - 4 Untitled Template
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In the first column (Feature) you will see all of the possible feature types
and tolerancing conditions that can be applied. The feature column will
appear as you see it, every time you select "New Form".

This column is use to select which types of features you want to appear
in the report. You can also customize this column as any other by
highlighting a specific feature or the whole column.

As the report is generated, the feature column will automatically print the
feature types you have selected from the feature list. Features that are
not contained in the feature list will not print on the report.

To the right of the feature type list, you will see abbreviations for the
different tolerance types. The following information will list what the
abbreviations stand for.

• NT = No Tolerance
• Cart = Cartesian Tolerance
• TP = True Position Tolerance
• <Tol = Angle Tolerance of a Line
• Form = Form Tolerance
• Orien = Orientation Tolerance
• Runout = Runout Tolerance
• XY = X and Y tolerance for a Distance.
• L = Length Tolerance on a Distance.

To the right side of the report, you will notice a RED dotted line. This line
indicates the page width. If any portion of your report extends beyond that
line, it will not print out.

To the bottom of the report, you will see a status bar indicating the
Version number of the Report Wizard as well as the page size. (See
figure 5).

The page size status bar is also your printer indicator. Since this feature
is linked to the Microsoft print manager, clicking on it will allow you to
change orientation and size of the paper just as if you were to select
PRINT.

Figure 11 - 5
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For a practice round, let's create a form that must have Actuals,
Nominals, deviation and a pass /fail indication.

4. To begin, move you cursor in the box containing the words COLUMN
2 and press the left mouse key. This will select the entire column
(and turn it a nice shade of blue) and bring up several new menu
items. At this time we can choose the information that we want to
appear. (See Figure 6)

Figure 11 - 6

5. The first thing we want to do is properly name the column. To do this
select Column Header from the Edit menu.

6. A dialog box will pop up and the words COLUMN 2 will be
highlighted. Press the back space key to erase (See figure 7).

Column2

Figure 11 - 7

7. Using the keyboard, type in NOMINALS and press OK. You can see
that the second column has now been renamed.

In the NOMINALS column, we want to see the X, Y and diameter
nominals.

8. From the Position menu select Nominals, a new fly out menu will
appear.
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9. Select X from the menu. As you can see, tolerancing can be a
applied to any X value that is marked with X NOMINAL.

 Part of the word nominal may be obstructed because the column is
not wide enough. To make the column wider, move the cursor to the
right hand edge of the NOMINALS column on the template. As you
can see the cursor now changes into a bi-directional arrow. When
you see the bi-directional arrow, hold down the left mouse button and
drag the cursor to the right. Do this until all entire word NOMINAL is
displayed.

10. From the Position menu, select Nominals, and then Y. Be sure the
column is still selected!

Please note that numbers will not appear while creating a form. We are
laying out the template. For our example we also want diameter values.

11. To set up for Diameter nominals, select Size (Vs position as
diameters have size) then Nominals and then d (for diameter).

 At this point your template should have two columns one with
FEATURE and the next with NOMINAL. If you don't please reread
this section of the manual and try again.

Now we want to set up the ACTUALS column. Please be sure the
nominals column is still selected (blue).

12. From the Edit menu, select New Column. A new column to the right
of the selected column called COLUMN 3 will appear.

13. Select Column 3 by moving the cursor to the box containing the
words COLUMN 3 and press the left mouse. That column will turn
blue.

14. Name Column 3 by selecting Column Header under the Edit menu.
Using the keyboard, type in ACTUALS then hit OK.

15. Now select Position, then Actual, then X. Do the same for Y.

16. Now select Size, then Actuals, then d for diameter.

Your template is now starting to take shape. You may need to widen this
column as you did with the nominals column. Now it is time to set up the
deviation column.
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17. First, be sure that the ACTUALS column is selected (blue). From the
Edit menu, select New Column, then select column 4. From the Edit
menu select Column Header and type in DEVIATION.

18. Now select the Position menu then Deviation, then X. Now do the
same for Y.

19. Now select the Size menu, then Deviation, then d.

To finish out our template, we must add in the PASS/FAIL column.  Be
sure that the Deviation Column is selected (blue).

20. From the Edit menu, select New Column. Select and rename this
column PASS/FAIL.

21. Now select Position, then Pass/Fail then X ; do the same for Y.

22. Now select the Size menu item, then Pass/Fail, then d for diameter.

Your template should look like the following form.  (See Figure 8).

Figure 11 - 8
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Editing the Header
Now that you have created the template, you can edit the Header
information for the printout, this will include information such as customer
name, address, etc.  Do not confuse this Header with the Print Selected
Features Header. Although they may look alike, the are two different
screens.

♦  Select Edit Header the File menu of the Report Wizard. A dialog
box will appear with a series of fields that can be customized to fit
your company's requirements. Using the keyboard, enter the
applicable information. If you do not wish a certain field to print,
simply disable it by clicking on the appropriate field (leaving the box
blank).

♦  Press okay to get out of the Edit Header page.

Figure 11 - 9 Report Header Screen
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Preferences
The Preferences Screen located under the File menu in a Report allows
you to further customize you report.

Figure 11 - 10

Print Gridlines
The default for Print Gridlines is enabled. Disabling this feature will print
the Report without the separations between the columns.

Print Header
Enabling Print Header will print the header information on the first page of
the printed report.

Header On Each Page
Selecting this function will print the header information on each page of
the printed report.

Print Column Headings
Disabling this feature will remove the Column titles from the printed
report.
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Numbers Only
There are some interactive programs that will only accept raw data. The
Report Wizard gives the user the option to turn off all words and just print
the numbers on the report.

For example, the information under the Position Column normally
appears as: X = 1.2345.

Y = 6.7891

With Numbers Only enabled the data would appear as: 1.2345
6.7891

Now that we have finished creating and customizing a new template,
you'll want to save it.

To save the form you have just created:

• Select Save Form the File menu. A dialog box will appear with a
message "File Name" follow by a blank field with .RPT.

• Hit the backspace Key and type in TEST then, select the OK button
(The QC-4000 will automatically put the extension .RPT at the end of
the file name "TEST".

Figure 11 - 11
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Congratulations, you have just completed your first Report Wizard Form!
To check this form and view the results, measure several features
including a circle with tolerance information.

Now select all of these features from the feature list or part view. From
the File menu of the QC-4000 and select Report. The QC-4000 will
default to the last form you saved and in the report name file it should say
test; this is the form we just created. Press OK and the measurement
data will be printed out in the format we specified.

Note: If TEST does not appear in the "Report Form" name box, choose
Browse and select the form name from the list, then press OK.

Obviously this was a very simple form that we just created; however, we
have learned a lot about the power of the Report Wizard. You now have
the basic understanding to create your own customized report form. The
Report Wizard is very flexible and you should go ahead and experiment
to get the desired form you require.

Report Summary
• You can create a series of different report forms that can be used

and stored.
• To select a different report form from the list of report forms, select

the Browse button. This will bring up a list of the various reports you
have created.

• Simply select the report form you desire and that format will now be
used to print reports until you change to another report form.

• Use a previously created form to create a whole new form by
selecting Edit Form then Save Form As.
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WRITING TO AN ASCII FILE
For many of you, the ability to write to an ASCII file will allow you to
communicate to a Statistical Process Control (SPC) package that you
may already have in house.

To demonstrate this capability we must first create a new report form. For
our example we want to send the feature name, the actual X coordinate,
and the actual Y coordinate with commas between the three fields.

1. First select Report from the File menu of the QC-4000.

2. Select Edit Form from the Report window.

3. From the File menu, select New Form.

4. Select the second column by clicking in it.

5. Now go to the Position menu and select Actual and then X.

6. Now go to the Edit menu again and select New Column which will
create column 3.

7. Select Position, Actual then Y.

8. From the File menu of Report Wizard, select Preferences.
The Delimiter will allow you to put space, commas, tabs, or special ASCII
commands after each field. (See figure 12).

Figure 11 - 12

9. For our demo, select Comma, then press OK.

10. Now go to the File menu of the report wizard and select Save Form
As.   

11. Using the keyboard, type TEST then press OK.

12. Go to the File menu and select Exit.
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You are now back at the Report window and we are ready to send data to
an ASCII file. First be sure that you have several features selected. You
may have to exit REPORT to do so and select Report from the File menu
again. The Report Form should currently be TEST. If not go to Browse
and select TEST. RPT. (Please note that all forms are give the extension
.RPT.)

13. Now from the Output Device area, select File as we are exporting
to a file.

14. Now press OK and the File Open window will pop up.

Figure 11 - 13

The Filename will always be saved as a TEXT file. You can view your
files by opening NOTEPAD in Windows.

In figure 13 you will see a column called "File Actions". There are four
choices that can be made pertaining to how the data should be added to
the ASCII file. They are:

Append
This will allow you to continuously add information onto the same file. All
information can be viewed a one time. EXAMPLE: If the file contains ten
features and you send five more you will have a total of 15 features in the
file.
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Auto Number
Every time you send a report, a new file will be created and will
consecutively number the files using the same initial file name.

EXAMPLE Filename is file.txt

1st file will be saved as c:\QC4000\file 000.txt
2nd file will be saved as c:\QC4000\file_001.txt

Overwrite Always
Selecting this will overwrite a file with the same name. Caution should
always be used when selecting the Overwrite Always command;
important information could be lost. example: If you have ten features in
the file and you send five more features, the ten original features will be
purged (lost) and only the five most recent features will be present.

Warn On Overwrite
When OK is pressed, a warning prompt appears asking the user
"Overwrite File? Press Yes to overwrite the file. Pressing No will exit the
report and return to the QC-4000 (See figure 14)

Figure 11 - 14

15. For our example select APPEND.

16. Type ASCITEST.TXT in the File Name box, then press the OK
button. You have just created a file called ASCITEST.TXT and the
data from the selected features will now be in that file in the format
that we created.

All text files can be view through NOTEPAD, which is a Windows
application. The notepad is located in the ACCESSORIES Window.

a) First minimize the QC-4000 and open the "Accessories"
window located in the Program Manager.

b) Now OPEN the NOTEPAD application by double-clicking on
the notepad Icon.
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c) Select Open from the File menu. Now this will get a little tricky.

d) Our file ASCITEST.TXT was stored in the QC-4000 directory,
so we must select that directory first. To do this:

e) From the Directories: List, Double click on the FOLDER
marked c:\

 

EXAMPLE:

Figure 11 - 15

 

f) Now scroll down until you see QC4000.

g) Double click on that item and a list of TXT files in the QC-4000
will appear.

 
EXAMPLE:

Figure 11 - 16

h) Double click on the file ASCITEST.TXT and the feature name
and X and Y values of the features selected will now be
present in the file. (See figure 16).
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Figure 11 - 17 Notepad Text File

Notice that the data is separated by Comma's. Remember that we chose
the comma as our DELIMITER in the Preference screen.

Let's take a look at the Delimiter.
A delimiter is used to separate the
date when outputting to a file.
Files are sent and received as
ASCII characters. For your
convenience, the QC-4000
Preference screen contains the

most commonly used delimiters. (i.e. Comma, Space and Tab). If we
were to look at a side by side view of a Report Printout and a Notepad
file, you would see that the comma makes the separation of each column
without empty spaces. The purpose of a delimiter is to save space within
a file. If none were present, files be filled with useless spaces.

When Custom is selected, an ASCII block will appear allowing you to
enter your own ASCII Character. Since comma, space and tab are
selectable items, you will not need to enter these as ASCII codes.

Note: When File is selected as your output, do not attempt to write to an
open file. The file must be closed for information to be sent.

For quick reference, the following page contains a list of some common
ASCII codes.
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ASCII CODES

  8
  9
10
11
12
13
14
15
16
17
18
19
20
21
22
23
24
25
26
27
28
29
30
31
32
33
34
35
36
37
38
39
40
41
42
43
44
45

backspace
horiz. tab
line feed
vert. tab
form feed
carr. ret.
so
si
dle
dcl
dc2
dc3
dc4
nak
syn
etb
can
em
sub
esc
fs
gs
rs
us
space
!
"
#
$
%
&
'
(
)
*
+
,
-

46
47
48
49
50
51
52
53
54
55
56
57
58
59
60
61
62
63
64
65
66
67
68
69
70
71
72
73
74
75
76
77
78
79
80
81
82
83

.
/
0
1
2
3
4
5
6
7
8
9
:
;
<
=
>
?
@
A
B
C
D
E
F
G
H
I
J
K
L
M
N
O
P
Q
R
S

84
85
86
87
88
89
90
91
92
93
94
95
96
97
98
99

100
101
102
103
104
105
106
107
108
109
110
111
112
113
114
115
116
117
118
119
120
121
122

T
U
V
W
X
Y
Z
[
\
]
^
_
`
a
b
c
d
e
f
g
h
i
j
k
l
m
n
o
p
q
r
s
t
u
v
w
x
y
z
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MENU EXPLANATIONS
FILE
New Form Allows you to create a new form.

Open Form Opens a previously create form.

Save Form Saves changes to an open form.

Save Form As Allows you to name and save a created form. Also
allows you to create a new form by editing a
previously created form.

Edit Header Add information such as company, part number etc.
to a form.

Preferences Allows the following customization:

Print Grid Lines Prints the form boundary lines.

Print Header Prints the header with each report.

Header On Each Page Prints header on each page of a report.

Print Column Headings Prints the column titles.

Delimiter Will put the checked item between each
field. (Coma, Space, Tab or Custom)

Custom ASCII When "Custom" (Delimiter) is selected,
another box will appear.  This allows you to
put custom ASCII commands between each
field. Example 13 will give a carriage return.
(Refer to ASCII chart on previous page.)

Exit Exits the form and returns to the QC-4000 after
asking you to "Save the Current Form".
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EDIT
Cut Cut a selected block of information from the form.

Copy Copy a selected block of information from the form

Paste Apply information that has been cut or copied to
another part of the form.

Delete Deletes the selected item or column information
from the form.

New Column Places a new column on the form.

Column Header Allows you to rename the selected header.

Font Size Change the font size of the form. (8,10,12)

• When a column is selected, the following menus will appear.

GENERAL
Feature Type Will place the type of feature in the selected block

of the form.

Units Will place the unit of measure in the selected
block.( inch, MM)

P/C Flag Will display the feature as being "Probed" or
"Constructed".

# of Pts Will include the number of points measured on
that feature.

Text Will allow user defined text to be added to the
report.

Tol Type Displays the type of feature tolerance. (i.e. Form,
True Position, Cartesian etc.)
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Datum If Datum is selected, a flyout menu will appear.
Zero - Will display the zero reference feature.
Skew Feature - Displays the feature used to create
a skew.

Pass/Fail Indicates a Pass/Fail tolerance condition.

Time Stamp Displays the Time at which the feature was printed.

Date Stamp Displays the date the feature was printed.

Position
Actual

ALL

X

Y

R

A

X/R

Y/A

Sa

Print all possible actual coordinates.

Print X actuals.

Print Y actuals

Force print Polar Radius actuals.

Force print Polar Angular actuals

Print the X value if in Cartesian mode and Radius if in Polar

Print the Y value if in Cartesian and Angle if in Polar.

Print the Start Angle of a Radius or Arc.

Nominals

ALL

X

Y

R

A

X/R

Y/A

Print all possible nominal values.

Print X nominal value.

Print Y nominal value.

Print Polar Radius nominal value.

Print Polar Angle nominal value.

Print the X nominal if in Cartesian mode and Radius if in Polar

Print the Y nominal if in Cartesian and Angle if in Polar.
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Tolerance

ALL Will print out all applied tolerances.

+X
 -X

Prints the X tolerance Value.
Prints the X tolerance Value.
Sample:  +.005/-.005, will appear as .005 next to +X or -X.

+Y
-Y

Prints the Y tolerance Value.
Prints the Y tolerance Value.
Sample:  +.005/-.005, will appear as .005 next to +Y or -Y.

Tol Dia Prints the tolerance diameter for a feature with True
Position tolerancing.

Concen Prints the Concentricity tolerance for a feature.

Limits

ALL Will print all applied limits.

+X
-X

Prints X tolerance Limits added to nominal.
Prints X tolerance Limits subtracted from the nominal.
Sample: If a feature with a nominal of 1.000 +.005/-.005
then the limit will be shown as (+X) 1.005 and (-X) .995.

+Y
 -Y

Prints Y tolerance Limits added to nominal.
Prints Y tolerance Limits subtracted from the nominal.
Sample: If a feature with a nominal of 1.000 +.005/-.005
then the limit will be shown as (+Y) 1.005 and (-Y) .995.

Deviation

ALL This will print the Deviation (Difference between actual and
nominal) of all toleranced features

X Prints the X deviation.

Y Print the Y deviation.
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Over/Under

ErrDia The deviation above or below the tolerance zone of a feature
that has true position applied to it.

Pass/Fail

ALL Provides Pass/ Fail indication for all toleranced features
X Provides Pass/Fail indicator for X values
Y Provides Pass/Fail indicator for Y values
TolDia Provides Pass/Fail indicator fro true position tolerancing.

Size
Actual

ALL Prints all actual size values.
r Prints Radius actual value.
d Prints Diameter actual value.
L Prints Length actual values.
x Prints the X actual value of a distance.
y Prints the Y actual value of a distance.
A Print actual values of Polar X and Y.
X/R Prints X value of a distance if in Cartesian and Radius of in polar
Y/A Prints Y value of a distance if in Cartesian and Angle if in polar.
< Prints Angle actual values.
h Prints the actual Height.
Al Prints the actual Arc length.
Sa Prints the actual start angle of an Arc.

Nominal

ALL Prints the nominal value of all toleranced features.
r Print Radius nominal values.
d Print Diameter nominal values.
L Print nominal value of a length.
x Print the X nominal of a distance.
y Print the Y nominal of a distance.
< Print the nominal value of an angle.
h Print the nominal value of a height.
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Tolerance

ALL Will print tolerance values for all features that have been
toleranced for size.

+r/-r Prints the positive or negative radius tolerance value.
Sample:  +.005/-.005, will appear as .005 next to +r or -r

+d/-d Prints the positive or negative dimension tolerance.
(See sample above).

+L/-L Prints the positive or negative length tolerance. (See above).

+x/-x Prints the positive or negative x tolerance values of a distance
(See sample above).

+y/-y Prints the positive or negative y tolerance values of a distance.
(See sample above).

+</-< Prints the positive or negative tolerance values of an angle.
(See sample above).

Limits

All Will print all applied limits

+r
-r

Prints the radius limits added to the nominal.
Print the radius limits subtracted from the nominal.
Sample: If a radius nominal is .500 +.005/-.005 then the
limits will be shown as (+r) .505,  (-r) .495

+d
-d

Prints the diameter limits added to the nominal.
Prints the diameter limits subtracted from the nominal.
(See sample above.)

+L
-L

Prints length limits added to the nominal.
Prints length limits subtracted from the nominal.
(See sample above.)
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+x
-x

Prints X tolerance Limits of a distance added to nominal.
Prints X tolerance Limits of a distance subtracted from
the nominal. (See sample above.)

+y
 -y

Prints X tolerance Limits of a distance added to nominal.
Prints X tolerance Limits of a distance subtracted from
the nominal. (See sample above.)

+<
 -<

Prints angle Limits added to nominal.
Prints angle Limits subtracted from the nominal.
(See sample above.)

+h
 -h

Prints height Limits added to nominal.
Prints height Limits subtracted from the nominal.
(See sample above.)

Deviation

ALL This will print the deviation (Difference from nominal to actual
of all toleranced features.

r Prints the deviation of a Radius.
d Prints the deviation of a Diameter.
L Prints deviation of a Length.
x Prints the X deviation of a distance.
y Prints the Y deviation of a distance.
< Prints the deviation of an Angle.
h Prints the deviation of a Height.

Pass/Fail

ALL Provides pass/fail indication for all size features that have been
toleranced

r Provides a pass/fail indication for a Radius.
d Provides a pass/fail indication for a Diameter.
L Provides a pass/fail indication for a Length.
x Provides a pass/fail indication for the X of a distance.
y Provides a pass/fail indication for the Y of a distance.
< Provides a pass/fail indication for an Angle.
h Provides a pass/fail indication for a Height.
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Other
Actual

ALL Provides all of the following:
+ T The + T form value
-T The - T form value
+T/-T The absolute value of the +T is added to the absolute valu

of the -T giving you a total size of form.

Runout The Actual Runout value
Paral The actual Parallelism value
Perp The actual Perpendicular value

Tol Zone

ALL Will print all of the tolerance zones.
Form Print the Form zone tolerance.
Runout Print the Runout zone tolerance.
Orientation Print the Orientation zone tolerance.
TolDia Print the Tol. Diameter zone tolerance.

Pass/Fail

ALL Prints PASS/FAIL indication for all zone type tolerances
Form Prints PASS/FAIL indication for Form zone tolerance.
Runout Prints PASS/FAIL indication for Runout zone tolerance.
Orientation Prints PASS/FAIL indication for Orientation zone tolerance.
TolDia Prints PASS/FAIL indication for Tol. Diameter zone tolerance
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# of Pts, 11-22
+T, 3-10
-T, 3-10

A
About Program, 2-5
Actual, 11-23, 11-25, 11-28
Add a Tool, 5-12
Allow Relations, 5-5, 6-2
An ellipsis, 2-4
Angle, 2-8, 3-4
Angle Construction, 4-26
Angle measurement, 4-21
Angle Tolerance of a Line, 11-7
Angle Tolerance, 8-17
Annotation, 5-3
Append, 11-16
Arc Measurement, 4-20
Arc, 2-8, 3-3, 4-31
ASCII CODES, 11-20
Auto Confirm, 2-9
Auto Construct, 5-4
Auto Focus, 10-2
Auto Number, 11-17
Auto Prog. from Features, 2-14, 7-18
Auto Program, 7-2, 7-4
Auto Repeat Mode, 6-3
Auto Zoom, 2-12, 5-11, 7-22
Average Point, 4-13
Axes, 9-2
Axis Board Test, 9-5
Axis Orientation, 4-6

B
Backward Annotation, 5-3
Browse button, 11-4

C
Calibration One, 3-6
Cartesian, 3-4
Cartesian Tolerance, 8-17, 11-7
Cautions about F.O. C.s, 10-17
CBF, 8-25
Center, 3-18
Center on Position Indicator, 2-12, 3-5
Change All, 3-14, 3-15
Change button (Measure Magic), 6-5
Change Button, 3-12
Changing a Distance, 3-17
Changing an Angle, 3-16
Changing Distances, 3-18

C
Changing Tangents, 3-19
Changing the feature name, 3-9
Check Mark, 2-4
Checking the Light Levels, 10-19
Circle, 2-8, 3-3
Circle Indicator, 5-10
Circle measurement, 4-16 t, 7-7
Circularity, 8-17
Clear Features, 7-15
Click, double-click, or drag, 1-3
Clicking, 3-5
Clipboard, 11-4
Close Program Name, 2-15
Closing a Window, 1-7
CNC I/O Test, 9-7
CNC, 10-2
Column Header, 11-8, 11-22
Command-equivalent functions., 7-9
Complimentary angle, 4-23
Concentricity, 8-17, 8-21
Connecting the Edge Box 10-19
Connecting the Edge Detector, 10-16
Connecting the Ref. Sensor, 10-17
Connecting the Screen Sensor, 10-17
Construct a Distance, 7-8
Constructing a feature, 4-25
Control-menu box, 1-5
Conventions, 4-1
Copy Selected Features, 2-7
Copy, 11-22
Count direction, 4-6
Create, 2-8
Create a Circle, 4-30
Create a Line, 4-29, 4-30
Create a Point, 4-29
Create an Arc, 4-31
Creating A Form, 11-6
Creating features, 4-28
Creating the SPC Chart, 10-37
Crosshair Indicator, 5-10
Crosshair, 2-9
Custom ASCII, 11-21
Customizing names, 3-26
Customizing, 5-1
Cut Selected Features, 2-7
Cut, 11-22

D
Date Stamp, 11-23
Datum Menu, 2-8
Datum, 4-9, 8-3, 11-23
DDE, 7-9, 8-37
Decimal Degrees, 5-8, 9-2
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Default Calibration, 2-10
Degrees Minutes Seconds, 5-8
Delay, 7-9
Delete A Step, 7-13
Delete a Tool, 5-12
Delete Selected Features, 2-7, 7-6
Delete, 11-22
Deleting Programs/
Deleting Sessions, 7-25
Delimiter, 11-19, 11-21
Demonstration slide, 4-6
Deselect All Features, 2-7
Deviation, 11-24, 11-27
Digital Readout, 3-1
Dimmed command name, 2-4
Display resolution, 9-2
Distance Measurement, 4-18
Distance to Line, 3-17
Distance Width Tolerance, 8-21
Distance, 2-8, 3-3
Dragging, 3-5
DRO, 2-11
Dynamic Data Exchange, 10-32

E
Edge Detection Operation, 10-14
Edge Detector, 10-1
Edge IO Test, 9-8
Edge, 2-9
Edit Program Step, 2-14
Edit (Tolerance), 8-23
Edit Button, 7-10
Edit Calibration, 2-10, 10-27
Edit Form, 11-4, 11-6
Edit Header, 11-11, 11-21
Edit menu, 2-7, 11-22
Edit program steps, 7-10
Editing a Program, 3-28
Editing Teach, 10-21
Editing User Programs, 7-10
Electronic Protractor, 10-1, 10-5
Ellipsis, 7-10
Enabling Reference Marks, 4-8
Encoder resolution, 9-2, 9-3
End Recording, 2-16, 7-8

E
Enlarging a window, 1-11
Entering a Point, 4-3
Establish a Ref. Frame, 4-9, 7-3
Establish a Reference, 7-7
Establish a ZERO Datum, 7-5
Excluded angle, 4-23
Exit to windows, 1-13, 2-6
Exit, 11-21
Export to ASCII File, 7-9

Export To DXF, 2-6, 7-19
Exporting to Excel, 8-35
External light source, 10-29

F
Farthest, 3-18
Feat.# box, 8-14
Feature column, 11-7
Feature default type, 5-5
Feature List, 2-11, 3-7, 4-10
Feature Name Display, 5-11
Feature Name, 3-9, 3-14
Feature Stamps, 3-20
Feature Type, 11-22
Feature Types, 8-13
Feature, 8-1
File menu, 11-21
File size, 2-5
Filtration Threshold, 5-7
Find Feature command, 8-25
Find Feature, 2-7, 8-12
Fixed run Program Mode, 7-2, 9-7
Font Size, 11-22
Foot switch button., 10-4
Foot switch, 10-1, 10-3
Footswitch setup, 9-8
Force Teach, 10-28
Form Disclaimer, 8-20
Form Information, 3-10
Form Tolerance, 8-25, 11-7
Forward Annotation, 5-3
Frame command, 8-3

G
General menu, 11-22
Grid, 5-11
Group Tolerancing, 8-25
Group Tolerance

Pause pass/fail, 8-26
Print pass/fail, 8-26

H
Header On Each Page, 11-21
Height, 2-8, 3-4
Heights, 5-7
Hidden, 3-13, 5-5
Hide Name, 3-13
How Edge Detection Works, 10-15

I
Ignore Errors, 7-15
Import From DXF, 2-6
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Importing Autocad DXF Files, 7-18
Included angle plus 180°, 4-23
Included angle, 4-23
Insert a Step, 7-12

K
Keyboard, 1-1

L
Language, 5-14
Length Tolerance, 11-7
Level, 2-9
Light control Quick- Sliders, 10-30
Light Control step, 10-31
Light Level, 10-20
Light Levels, 2-10
Limits, 11-24, 11-26
Line Editing, 7-10
Line measurement, 4-14
Line, 2-8, 3-3
Linear Error Compensation, 9-3, 9-4
LMC Tolerance, 8-17
Lock Calibration Data, 9-7
Lock Preferences, 9-6
Lock programs, 7-2
Lock QC4000 at Full Size, 9-7
Lock, 7-16
Locks Setup, 9-6
Locks, 5-14, 9-6
Logic Operators, 8-14
LSFB, 8-25

M
Machine 0,0, 10-8
Machine Zero, 2-8, 4-8, 7-3, 8-7, 9-8
Manual Execution Mode, 7-15
Maximize button, 1-5
Measure Magic

Probing Techniques, 4-34
Rules, 6-3
M Magic, 2-8, 3-3, 4-34, 6-1, 7-4

Measure menu, 2-8
Menu bar, 1-5, 2-4
Menu Conventions, 2-4
Minimize buttons, 1-5
MMC Tolerance, 8-17
Moving a window, 1-9
Multi-point measurements, 8-9

N
Name the program, 7-6
Nearest, 3-18
New Calibration, 2-10
New Column, 11-10, 11-9, 11-22
New Form., 11-6, 11-7, 11-21
New Session, 2-5, 7-4
NLEC, 10-1, 10-8
No Tolerance, 11-7
Nominal, 11-25
Nominals, 11-23
Non-Linear Error Correction, 9-6, 10-8
Normal, 3-12
Number of Steps, 2-5

O
Open Form, 11-21
Open Session, 2-5
Open, 2-13
Opening a window, 1-6
Optical Edge Detector, 10-14
Optimize Path, 2-15
Options, 10-1
Orientation Tolerance, 8-22, 11-7
Orientation, 5-9
Other menu, 11-28
Outlier Detection, 5-6
Output Device, 11-16
Over/Under, 11-25
Overwrite Always, 11-17

P
P/C Flag, 11-22
Palletize, 7-15
Parallelism, 8-17, 8-22
Part View, 2-11, 3-23
Part Zeros, 8-3
Pass/Fail, 11-10, 11-23, 11-25, 11-27, 11-
28
Paste, 11-22
Paste, 2-7
Pause pass/fail, 8-26
Pause Program Execution, 2-16
Pause, 7-12
Perpendicularity, 8-17, 8-22
Phantom, 3-13, 5-5
Point filtering tuning parameters, 5-6
Point Filtration, 5-6, 7-16, 9-6
Point measurement, 4-11
Point, 2-8, 3-3
Polar Coordinates, 8-2
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Polar, 3-4
Position Indicator, 3-23, 5-10
Position menu, 11-23
Position Tolerance

(See Tolerance of Location), 8-20
Position, 11-10
Post Form Feed, 11-5
Pre Form Feed, 11-5
Preference Menu, 5-1
Preferences, 2-6, 11-21
Preferences

Allow Relations, 5-5
Angle, 5-8
Circle Indicator, 5-10
Crosshair Indicator, 5-10
Feature default type, 5-5
Feature Name display, 5-11
Grid, 5-11
Heights, 5-7
Language, 5-14
Locks, 5-14
Measure, 5-3
Measure Magic, 5-5
Orientation, 5-9
Outlier Detection, 5-6
Part View, 5-8
Position Indicator, 5-10
Preselection, 5-4
Rectangle Indicator, 5-10
Results, 5-13
Right mouse button, 5-4
Safty Net, 5-4
Sound, 5-2

P
Preferences

Toolbox, 5-12
Zoom, 5-11

Print Column Headings, 11-21
Print Date/Time, 7-12
Print Grid Lines, 11-21
Print Header, 11-21
Print Part View, 2-6
Print pass/fail, 8-26
Print Selected Features, 2-6, 3-6
Print settings, 9-9
Print, 7-12
Print/Pause directive, 8-19
Printer, 11-4
Printing Features, 11-2
Probe Menu, 2-9
Probe Offset, 10-27
Program Menu, 2-13
Programming

Auto Gen. from features, 7-20
Delete Steps, 7-13
Import from DXF, 7-19

Run Program, 7-10, 7-21
Store Programs, 7-10

Program View window, 3-27
Program View, 2-11, 7-8

Q
Q axis, 10-1, 10-5
Q-CNC, 10-2
QC4000 SCREEN, 2-1
Quick- Sliders, 10-30
Quitting the qc-4000, 1-13

R
Radix, 9-2
Record a Program, 7-6
Record Into "Program Name, 2-13
Record Into, 7-12
Record New, 2-13
Record Zoom, 2-12, 7-22
Recording Icon, 7-7
Recording a program, 7-3, 7-4
Rectangle Indicator, 5-10
Reference Frame, 4-9
Reference Mark Calibration, 4-8
Reference Mark indicators, 4-7
Reference marks, 4-7
Reference Point, 8-3, 10-8
R
Reference sensor, 10-15
Refresh Part View, 2-13, 3-26
Regenerate Features, 2-15, 7-13
Report function, 11-3
Report Header, 2-6
Report Wizard Menu, 11-21
Report Wizard, 11-1
Report, 2-6
Repositioning a Window, 1-9
Restore button, 1-5
Restoring an Icon or Window, 1-12
Results Information, 3-10
Results Window, 2-11, 3-10
Results, 5-13
Reverse Axis, 4-6
Reverse Direction, 3-17
Roundness, 8-25
Run "Program Name, 2-14
Run DOS/Windows Program, 7-9
Run, 2-14
Runout Tolerance, 11-7
Runout, 8-17, 8-23

S
Save "Program Name, 2-13
Save As, 2-14
Save Form As, 11-21
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Save Form, 11-13, 11-21
Save Session As, 2-3, 2-5
Save Session, 2-5
Screen sensor, 10-15
Scroll bars, 1-6
Select All Features, 2-7
Selecting a measurement

(keyboard), 4-2
(mouse), 4-2

Selecting features, 3-8, 3-24
Self Teach, 7-2
Session, 8-1
Set Machine Zero, 4-8, 7-3, 8-8, 9-8
Setting NLEC Grid, 10-12
Setting the Q Axis, 10-5
Setting up NLEC, 10-10
Show Edge Detector, 5-10, 10-25
Show Feature Names, 2-13
Show Hidden Features, 2-13
Show Name, 3-13, 3-26, 5-5
Show Path, 2-15
Show Position Indicator, 2-13
Shrink the QC-4000 to an Icon, 1-10
Shutdown, 1-13, 2-6
Sigma Factor, 5-7
S
Singular mode, 6-2
Size menu, 11-25
Size Tolerance, 8-21
Sizing the windows, 1-8
Skew (On Two Circles), 4-27
Skew, 2-9, 3-4, 4-9, 7-5, 8-3
Skewing, 7-3
Software Fence, 9-8
SPC Demonstration, 10-33
SPC Link, 2-6, 10-36
SPC, 10-2, 10-32
SPC-Link commands, 10-33
Special Steps, 2-14, 7-12
Starting the QC-4000, 1-2
Statistical Process Control, 10-32
Status Bar, 2-2, 2-11, 3-1
Straightness, 8-17, 8-25
Substep, 3-28, 7-11
Supervisor Setup menu, 9-1
Supervisor Setup Screen, 9-1
Supervisor Setup, 2-6
System Settings, 7-8
Systems Settings, 7-14

T
Tangent Circle, 4-33
Targeting Points, 4-3
Teach to Master, 2-10
Teach, 2-10, 3-5, 10-20, 10-21
The Sensors, 10-15

Time (military or standard), 9-2
Time Stamp, 11-23
Times to Execute, 7-16
Title Bar, 1-5, 2-2
Tol Type, 11-22
Tol Zone, 11-28
Tolerance All, 8-25
Tolerance Button, 3-12
Tolerance for a Distance, 11-7
Tolerance name, 8-19
Tolerance of Location, 8-20
Tolerance Printout, 8-31
Tolerance report, 8-31
Tolerance Type, 8-20
Tolerance, 11-24, 11-26
Toleranced Features Only, 11-5
Tolerancing, 8-17
Toolbox Icons, 3-3
Toolbox Maker, 5-12
Toolbox, 2-11, 3-2
Total Path Length, 2-5
True Position Tolerance, 8-17, 11-7

U
Units, 2-8, 3-4, 11-22
Use As Recorded, 7-15
Use Machine Skew, 7-14
Use Machine Zero, 7-14
User Message, 2-1, 7-9, 7-124
User Programs, 7-2
Using the Control-menu box, 1-7

V
VED2, 10-2
View Menu, 2-12
View Settings, 9-9
Visible, 3-13

W
Warn On Overwrite, 11-17
What is Edge Detection, 10-14
Wildcard, 2-7
Window border, 1-6
Window corner, 1-6
Windows Menu, 2-11
Writing to an ASCII File, 11-4, 11-15

X
X-Bar & R Chart, 10-37

Z
Zero Datum, 8-6
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Zero, 2-9, 3-1, 3-4
Zeroing, 7-3
Zoom funtion, 3-25
Zoom In On Area, 2-12
Zoom in on Area, 3-5, 3-25
Zoom In, 2-12, 3-4
Zoom Out, 2-12, 3-4
Zoom to Fit, 2-12, 3-5, 7-22, 7-24
Zoom to Selected Features, 2-12, 3-5
Zoom, 5-11


